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GigaVUE Cloud Suite

Deployment Guide — Azure

This guide describes how to install, configure and deploy the GigaVUE Cloud solution on the
Microsoft® Azure cloud. Use this document for instructions on configuring the GigaVUE
Cloud components and setting up the traffic monitoring sessions for the Azure Cloud.

Refer to the following sections for details:

Overview of GigaVUE Cloud Suite for Azure

Introduction to the Supported Features on GigaVUE Cloud Suite for Azure
Licensing GigaVUE Cloud Suite for Azure

Get Started with GigaVUE Cloud Suite for Azure

Deployment Options for GigaVUE Cloud Suite for Azure
Deploy GigaVUE Cloud Suite for Azure

Configure Secure Tunnel

Create Prefiltering Policy Template

Configure Monitoring Session

Configure Precryption in UCT-V

Migrate Application Intelligence Session to Monitoring Session
Monitor Cloud Health

Administer GigaVUE Cloud Suite for Azure

GigaVUE-FM Version Compatibility Matrix

GigaVUE Cloud Suite Deployment Guide - Azure
Contents
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Overview of GigaVUE Cloud Suite
for Azure

GCigaVUE® Cloud Suite for Azure extends complete visibility to workloads running in Azure
and provides your security and observability tools with actionable network-level intelligence.
GigaVUE Cloud Suite for Azure resides in the VNets and aggregates flows from all compute
sites, including from native traffic mirroring nodes. Gigamon provides advanced traffic
processing to generate metadata of traffic flows beyond traditional logging. This helps
detect vulnerabilities or undesired activities and ensures effective and comprehensive cloud
security with continuous monitoring.

All the elements of this cloud suite reside entirely in the cloud; they acquire traffic from every
compute site through UCT-V (agent-like instances provisioned on each Virtual Machine).
Gigamon auto-scales to adapt dynamically to changes in your virtual machine.

GigaVUE Cloud Suite for Azure provides the following benefits:

Improves tool capacity: Virtual security and monitoring tasks are offloaded from tools to
improve effectiveness, reduce scaling and minimize costs.

Fully automates the infrastructure: Automatically identifies new and relocated workloads,
instantiates and scales visibility nodes, and configures new traffic policies as needed.

Simplifies operation: Centralizes orchestration and management with a single-pane-of-
glass visualization portal across any hybrid network.

Helps accelerate cloud migrations: Unifies on-premise and hybrid cloud environments
with a commmon deep observability pipeline, centralized control, and complete.

Overview of GigaVUE Cloud Suite for Azure 9
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GCigaVUE-FM

GigaVUE-FM fabric manager provides unified access, centralized administration, and high-
level visibility for all GigaVUE traffic visibility nodes in the enterprise or data center, allowing
a global perspective which is not possible from individual nodes.

In addition to centralized management and monitoring GigaVUE-FM helps you with
configuration of the physical and virtual traffic policies for the visibility fabric thereby
allowing administrators to map and direct network traffic to the tools and analytics
infrastructure.

You have the flexibility of installing GigaVUE-FM across various supported platforms.
Additionally, you can effectively manage deployments in any of the cloud platform as long
as there exists IP connectivity for seamless operation.

For more information on installing GigaVUE-FM on Azure, see Install GigaVUE-FM on Azure.

Overview of GigaVUE Cloud Suite for Azure
GigaVUE-FM

1



GigaVUE Cloud Suite for Azure - Deployment Guide

UCT-V

UCT-V (earlier known as G-vTAP Agent) is an agent that is installed in the VM instance. This
agent mirrors the selected traffic from the instances (virtual machines) to the GigaVUE V
Series Node. The UCT-V is offered as a Debian (.deb), Redhat Package Manager (.rpm)
package, ZIP and MSI .

Next generation UCT-V is a lightweight solution that acquires traffic from Virtual Machines
and in-turn improves the performance of the UCT-V mirroring capability. The solution has a
prefiltering capability at the tap level that reduces the traffic flow from the agent to GigaVUE
V Series Node and in-turn reduces the load on the GigaVUE V Series Node. Next generation
UCT-V gets activated only on Linux systems with a Kernel version above 5.4.

Prefiltering helps you reduce the costs significantly. It allows you to filter the traffic at UCT-Vs
before sending it to the V Series nodes. For prefiltering the traffic, GigaVUE-FM allows you to
create a prefiltering policy template and the template can be applied to a monitoring
session.

For more information on installing the UCT-V see, Install UCT-V to Monitor Traffic

Overview of GigaVUE Cloud Suite for Azure 12
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UCT-V Controller

UCT-V Controller (earlier known as G-vTAP Controller) manages multiple UCT-Vs and
orchestrates the flow of mirrored traffic to GigaVUE V Series nodes. GigaVUE-FM uses one or
more UCT-V Controllers to coommunicate with the UCT-Vs. A UCT-V Controller can only
manage UCT-Vs that has the same version. For example, the UCT-V Controller v6.6.00 can
only manage UCT-Vs v6.6.00. If you have UCT-V v6.5.00 still deployed in the Virtual Network,
you must configure both UCT-V Controller v6.5.00 and v6.6.00. While configuring the UCT-V
Controllers, you can also specify the tunnel type to be used for carrying the mirrored traffic
from the UCT-Vs to the GigaVUE V Series Nodes.

NoTE: A single UCT-V Controller can manage up to 1000 UCT-Vs.

Overview of GigaVUE Cloud Suite for Azure
UCT-V Controller
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GigaVUE V Series Node

GigaVUE® V Series Node is a visibility node that aggregates mirrored traffic. It applies filters,
manipulates the packets using GigaSMART applications, and distributes the optimized
traffic to cloud-based tools or backhaul to on premise device or tools.

For more information on installing and configuring a GigaVUE V Series Node, refer to
Configure GigaVUE Fabric Components in GigaVUE-FM

Overview of GigaVUE Cloud Suite for Azure 14
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GCigaVUE V Series Proxy

GigaVUE V Series Proxy is a optional component. If GigaVUE-FM cannot directly reach the
GigaVUE V Series Nodes (management interface) directly over the network, a Proxy should
be used. It can also be used if there is a large number of nodes connected to GigaVUE-FM or
if you wish to keep IP addresses of the nodes private. It manages multiple GigaVUE V Series
Nodes and orchestrates the flow of traffic from GigaVUE V Series Nodes to the monitoring
tools. GigaVUE-FM uses one or more GigaVUE V Series Proxies to commmunicate with the
GigaVUE V Series Nodes. A single GigaVUE V Series Proxy can be launched to provide the
GigaVUE-FM network communication to hundreds of GigaVUE V Series Nodes present in
private networks behind the Proxy.

For more information on installing and configuring a GigaVUE V Series Proxy, refer to
Configure GigaVUE Fabric Components in GigaVUE-FM

Overview of GigaVUE Cloud Suite for Azure 15
GigaVUE V Series Proxy



GigaVUE Cloud Suite for Azure - Deployment Guide

Monitoring Domain

Monitoring domain helps you establish connection in between GigaVUE-FM and Azure
platform. Once the connection is established, you can use GigaVUE-FM to launch the
GigaVUE V Series Nodes, GigaVUE V Series Proxy and UCT-V Controller.

For more information on creating a Monitoring Domain, see Create Monitoring Domain.

Overview of GigaVUE Cloud Suite for Azure
Monitoring Domain
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Monitoring Session

Monitoring sessions are the rules created in GigaVUE-FM to collect inventory data from all
target instances in your cloud environment. You can design your monitoring session to
include or exclude the instances you want to monitor. You can also choose to monitor
egress, ingress, or all traffic.

When a new target instance is added to your cloud environment, GigaVUE-FM automatically
detects and adds the instance to your monitoring session. Similarly, when an instance is
removed, it updates the monitoring sessions.

For more information on creating a monitoring session, see Configure Monitoring Session.

Overview of GigaVUE Cloud Suite for Azure 17
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Introduction to the Supported
Features on GigaVUE Cloud Suite
for Azure

GigaVUE Cloud Suite for Azure supports the following features:

e Precryption™

e Secure Tunnels

e Prefiltering

¢ Monitor Cloud Health

» Analytics for Virtual Resources

» Customer Orchestrated Source - Use Case

Introduction to the Supported Features on GigaVUE Cloud Suite for Azure
Monitoring Session
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Precryption™

License: Requires SecureVUE Plus license.

Gigamon Precryption™ technology! redefines security for virtual, cloud, and containerized
applications, delivering plaintext visibility of encrypted communications to the full security
stack, without the traditional cost and complexity of decryption.

This section explains about:

« How Gigamon Precryption Technology Works
«  Why Gigamon Precryption

« Key Features

«  Key Benefits

» Precryption Technology on Single Node

« Precryption Technology on Multi-Node

» Supported Platforms

« Prerequisites

IDisclaimer: The Precryption feature allows users to acquire traffic after it has been decrypted. This traffic can be acquired from
both virtual machine (VM) and container-based solutions, and is then sent to the V Series product for further processing. The
Precryption feature provides an option to use encrypted tunnels for communication between the acquisition (via UCT or G-
VTAP) of unencrypted traffic and the traffic processing (at the V Series) which will better safeguard the traffic while in transit.
However, if a user does not use the option for encrypted tunnels for communication, decrypted traffic will remain unencrypted
while in transit between the point of acquisition and processing.

Please note that this information is subject to change, and we encourage you to stay updated on any modifications or
improvements made to this feature.

By using this feature, you acknowledge and accept the current limitations and potential risks associated with the transmission
of decrypted traffic.

Introduction to the Supported Features on GigaVUE Cloud Suite for Azure 19
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How Gigamon Precryption Technology Works

Precryption technology leverages native Linux functionality to tap, or copy, communications
between the application and the encryption library, such as OpenSSL.

Precryption Tap Point

|
i
=P S ,
A 4 Encryption
e Library

&

In this way, Precryption captures network traffic in plaintext, either before it has been
encrypted, or after it has been decrypted. Precryption functionality doesn't interfere with the
actual encryption of the message nor its transmission across the network. There's no proxy,
no retransmissions, no break-and-inspect. Instead, this plaintext copy is forwarded to the
Gigamon Deep Observability Pipeline for further optimization, transformation, replication,
and delivery to tools.

App

Precryption technology is built on GigaVUE® Universal Cloud Tap (UCT) and works across
hybrid and multi-cloud environments, including on-prem and virtual platforms. As a bonus,
UCT with Precryption technology runs independent of the application, and doesn't have to
be baked into the application development lifecycle.

Introduction to the Supported Features on GigaVUE Cloud Suite for Azure 20
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Why Gigamon Precryption

GigaVUE Universal Cloud Tap with Precryption technology is a lightweight, friction-free
solution that eliminates blind spots present in modern hybrid cloud infrastructure, providing
East-West visibility into virtual, cloud, and container platforms. It delivers unobscured
visibility into all encryption types including TLS 1.3, without managing and maintaining
decryption keys. IT organizations can now manage compliance, keep private
communications private, architect the necessary foundation for Zero Trust, and boost
security tool effectiveness by a factor of 5x or more.

Introduction to the Supported Features on GigaVUE Cloud Suite for Azure 21
Precryption™



GigaVUE Cloud Suite for Azure - Deployment Guide

Key Features

The following are the key features of this technology:
» Plaintext visibility into communications with modern encryption (TLS 1.3, mTLS, and TL
1.2 with Perfect Forward Secrecy).
« Plaintext visibility into communications with legacy encryption (TLS 1.2 and earlier).
« Nonintrusive traffic access without agents running inside container workloads.

« Elimination of expensive resource consumption associated with traditional traffic
decryption.

« Elimination of key management required by traditional traffic decryption.

« Zero performance impact based on cipher type, strength, or version.

« Support across hybrid and multi-cloud environments, including on-prem, virtual, and
container platforms.

« Keep private communications private across the network with plaintext threat activity
delivered to security tools.

= Integration with Gigamon Deep Observability Pipeline for the full suite of optimization
transformation, and brokering capabilities.

Introduction to the Supported Features on GigaVUE Cloud Suite for Azure
Precryption™
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Key Benefits

The following are the key benefits of this technology:

» Eliminate blind spots for encrypted East-West (lateral) and North-South
communications, including traffic that may not cross firewalls.

=« Monitor application commmunications with an independent approach that enhances
development team velocity.

» Extend security tools’ visibility to all communications, regardless of encryption type.
« Achieve maximum traffic tapping efficiency across virtual environments.

» Leverage a 5-7x performance boost for security tools by consuming unencrypted data.

= Support a Zero Trust architecture founded on deep observability.

« Maintain privacy and compliance adherence associated with decrypted traffic
management.

Introduction to the Supported Features on GigaVUE Cloud Suite for Azure
Precryption™
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How Gigamon Precryption Technology Works

This section explains about how Precryption technology works on single node and multiple
node in the following sections:

« Precryption Technology on Single Node
« Precryption Technology on Multi-Node

Precryption Technology on Single Node

1. When any application needs to encrypt a message, it uses an encryption library, such
as OpenSSL, to perform the actual encryption.

2. GigaVUE Universal Cloud Tap (UCT), enabled with Precryption technology, gets a copy
of this message before it's encrypted on the network.

3. The encrypted message is sent to the receiving application, with unmodified
encryption. No proxy, no re- encryption, no retransmissions.

4. GigaVUE UCT creates packet headers as needed, encapsulates in a tunnel, and
forwards to GigaVUE V Series in the deep observability pipeline. Gigamon further
optimizes, transforms, and delivers data to tools, without need for further decryption

App 1 App 2
{Container) [{Container)

Encryption
Library

- > Tool A
Gigamon
—
Deep Observability Pipeline

> | ToolB
Access Broker Transforrn Enrich —_—

3 Tool C

5.
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Precryption Technology on Multi-Node

1. When any application needs to encrypt a message, it uses an encryption library, such
as OpenSSL, to perform the actual encryption.

2. GigaVUE Universal Cloud Tap (UCT), enabled with Precryption, gets a copy of this
message before it's encrypted on the network.

3. Optionally, GigaVUE UCT enabled with Precryption can also acquire a copy of the
message from the server end, after the decryption.

4. GigaVUE UCT creates packet headers as needed, encapsulates in a tunnel, and
forwards to V Series in the deep observability pipeline where it is further enriched,
transformed, and delivered to tools, without further decryption.

App1 App 2
(Container) (Container)

Encryption " Decryption
Library N Library

Gigamon
Deep Observability Pipeline

Access Broker Transform Enrich

b h -’

Tool A

[ Toas

Introduction to the Supported Features on GigaVUE Cloud Suite for Azure
Precryption™
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Supported Platforms

VM environments: Precryption™ is supported on the following VM platforms where UCT-V
is supported:

Platform Type Platform
Public Cloud « Azure
« Azure

o GCP (via Third Party Orchestration)

Private Cloud « OpenStack
« VMware ESXi (via Third Party Orchestration only)
« VMware NSX-T (via Third Party Orchestration only)

Container environments: Precryption™ is supported on the following container platforms
where UCT-C is supported:

Platform Type Platform
Public Cloud « EKS
« AKS
Private Cloud « OpenShift
« Native Kubernetes (VMware)

Introduction to the Supported Features on GigaVUE Cloud Suite for Azure
Precryption™
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Prerequisites

Deployment Prerequisites

« OpenSSL version 1.0.2, version 1.1.0, version 1.1.1, and version 3.x

« For GigaVUE-FM, to capture the statistics, you must add the port 5671 in the security
group

» Port 9900 should be enabled in security group settings on the UCT-V controller to
receive the statistics information from UCT-V agent

«» For UCT-C, you must add the port 42042 and port 5671 in the security group

License Prerequisite

« Precryption™ requires SecureVUE Plus license.

Supported Kernel Version

Precryption is supported for Kernel Version 5.4 and above for all Linux and Ubuntu
Operating Systems. For the Kernel versions below 5.4, refer to the following table:

Kernel Version Operating System

4.18.0-193.el8.x86_64% RHEL release 8.2 (Ootpa)
4.18.0-240.el8.x86_64 RHEL release 8.3 (Ootpa)
4.18.0-305.76.1.el8_4.x86_64 | RHEL release 8.4 (Ootpa)

4.18.0-348.12.2.el8_5x86_64 | RHEL release 85 (Ootpa)

4.18.0-372.9.1.el8.x86_64% RHEL release 8.6 (Ootpa)
4.18.0-423.e18.x86_64 RHEL release 8.7 Beta (Ootpa)
4.18.0-477.15.1.el8_8.x86_64 | RHEL release 8.8 (Ootpa)
5.3.0-1024-kvm ubuntul9.10

418.0-305.3.1 Rocky Linux 8.4

4.18.0-348 Rocky Linux 8.5

4.18.0-372.9.1 Rocky Linux 8.6

4.18.0-425.10.1 Rocky Linux 8.7

4.18.0-477.10.1 Rocky Linux 8.8
4.18.0-80.e18.x86_64% centos 8.2

418.0-24011el8_3x86_64 | centos 8.3

418.0-305.31.el8_4x86_64 | centos 8.4

4.18.0-408.el8.x86_64 centos 8.5

Introduction to the Supported Features on GigaVUE Cloud Suite for Azure
Precryption™
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Note

» See the Configure Precryption in UCT-V section for details on how to enable Precryption™
in VM environments.

e See the Configure in UCT-C section for details on how to enable Precryption™ in
container environments.

* See how Secure Tunnels feature can enable secure delivery of precrypted data.

Introduction to the Supported Features on GigaVUE Cloud Suite for Azure 28
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Secure Tunnels

Secure Tunnel securely transfers the cloud captured packets on UCT-V and UCT-C to a
GigaVUE V Series Node or Tool (only in case of UCT-C). The data from UCT-V and UCT-C are
encapsulated in PCAPNng format, and the encrypted data is sent over a TLS connection to a
GigaVUE V Series Node.

Secure Tunnel can also transfer the cloud captured packets from a GigaVUE V Series Node
to another GigaVUE V Series Node.

In case of GigaVUE V Series Node to GigaVUE V Series node, the traffic from the GigaVUE V

Series Node 1is encapped using PCAPNg format and transported to GigaVUE V Series Node
2 where the traffic is decapped. The secure tunnels between V Series Node to V Series Node
have multiple uses cases.

The GigaVUE V Series Node decapsulates and processes the packet per the configuration.
The decapsulated packet can be sent to the application such as De-duplication, Application
Intelligence, Load balancer and to the tool. The Load Balancer on this node can send the
packets to multiple V series Nodes, in this case the packets can be encapsulated again and
sent over a secure tunnel.

Secure Tunnel Use Case

Tool in remote Virtual Private Cloud (VPC) — Single V Series Node

* VS1toVS2:Single
TCP/TLS

tunnel connection
UCT-C or

Sy * VS2to Tool :
\ Could be multiple
tools / tunnels

Secure Tunnel
Decapsulation

. Application

Applicati

‘;': 'FCI;:" Secure Tunnel Se;“’“T‘{"“E' or Filter . T“""I:'ﬁ Tool
ncryption ecryption s ncapsulation

Tunnel Map
Decapsulation

V Series Node (VS1) V Series Node (VS2)

VPC-1 VPC-2

Legend
—eeeep Secure Tunnel (TCP/TLS PCAPng)

—- VXLAN or L2GRE Packet % B
Supported Platforms
Secure tunnel is supported on:
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» OpenStack

« Azure

= AWS

« VMware NSX-T (only for Third Party Orchestration)

« VMware ESXi (only for Third Party Orchestration)

= Nutanix (only for Third Party Orchestration)

« Google Cloud Platform (only for Third Party Orchestration)

For information about how to configure secure tunnels, refer to the section Configure
Secure Tunnel.

Introduction to the Supported Features on GigaVUE Cloud Suite for Azure
Secure Tunnels
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Prefiltering

Prefiltering allows you to filter the traffic at UCT-Vs before sending it to the GigaVUE V Series
Nodes. For prefiltering the traffic, GigaVUE-FM allows you to create a prefiltering policy
template and the policy template can be applied to a monitoring session.

You can define a policy template with rules and filter values. A policy template once created
can be applied to multiple monitoring sessions. However a monitoring session can use only
one template.

Each monitoring session can have a maximum of 16 rules.

You can also edit a specific policy template with required rules and filter values for a
particular monitoring session while editing a monitoring session. However, the customized
changes are not saved in the template.

Some of the points that must be remembered for prefiltering in Next Generation UCT-Vs are:

» Prefiltering is supported only in Next Generation UCT-Vs. It is not supported for classic
mirroring mechanism.

« Prefiltering is supported for both Linux and Windows UCT-Vs.

« Forsingle monitoring session only one prefiltering policy is applicable. All the agents in
that monitoring sessions are configured with respective prefiltering policy .

« For multiple monitoring session using the same agent to acquire the traffic, if a
monitoring session uses a prefilter and the other monitoring session does not use a
prefilter, then the prefiltering policy cannot be applied. The policy is set to PassAll and
prefiltering is not performed.

«  When multiple monitoring sessions utilize a single agent to capture traffic, and one
session uses a prefilter while the other does not, then the prefiltering policy is not
applied. In this scenario, the policy defaults to PassAll, resulting in the omission of any
prefiltering.

For more information on configuring a prefilter, refer to Prefiltering
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Monitor Cloud Health

GigaVUE-FM allows you to monitor the traffic and configuration health status of the
monitoring session and its individual components. This section provides detailed
information on how to view the traffic and configuration health status of the monitoring

session and its individual components. For more information, seeConfiguration Health
Monitoring
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Analytics for Virtual Resources

Analytics in GigaVUE-FM is a standalone service that provides data visualization capabilities.
Using Analytics! you can create visual elements such as charts that are embedded as
visualizations. The visualizations are grouped together in dashboards. You can also create
search objects using Analytics. Dashboards, Visualizations and Search Objects are called
Analytics objects. Refer to Analytics topic in GigaVVUE Fabric Management Guide for more
detailed information on Analytics.

Rules and Notes:

¢ You cannot edit or delete these default dashboards. However, you can clone the
dashboards and visualizations. Refer to the Clone Dashboard section in GigaVUE-FM
Installation and Upgrade Guidefor more details.

¢ Use the Time Filter option to select the required time interval for which you need to view
the visualization.

lAnalytics uses the OpenSearch front-end application to visualize and analyze the data in the OpenSearch database of GigaVUE-FM.
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Virtual Inventory Statistics and Cloud Applications Dashboard

Analytics dashboards allow users to monitor the physical and virtual environment and
detect anomalous behavior and plan accordingly. Refer to the Analytics section in GigaVUE
Fabric Management Guide for details on how to create a new dashboard, clone a
dashboard, create a new visualization, and other information about the Discover page and

Reports page.

To access the dashboards:

1. Goto Ll . Analytics -> Dashboards.
2. Click on the required dashboard to view the visualizations.

The following table lists the various virtual dashboards:

Dashboard Displays Visualizations | Displays
Inventory Status | Statistical details of the virtual V Series Node Number of healthy and
(Virtual) inventory Status by Platform | unhealthy V Series Nodes
based on the platform and the health for each of the supported
status. cloud platforms.
You can view the following metric Monitoring Session | Number of healthy and
details at the top of the dashboard: Status by Platform | unhealthy monitoring
« Number of Monitoring Sessions sessions for each of the
« Number of V Series Nodes supported cloud
« Number of Connections platforms
. Number of GCB Nodes Connection Status Number of healthy and
. ) . by Platform unhealthy connections
You can filter the visualizations based
. . for each of the supported
on the following control filters:
cloud platforms
o Platform
GCB Node Status Number of healthy and
- Health Status by Platform unhealthy GCB nodes for
each of the supported
cloud platforms
V Series Node Displays the Statistics of the V V Series Node Line chart that
Statistics Series node such as the Maximum ; displays maximum
CPU U Ti
CPU usage, trend of the sage fren CPU usage trend of
receiving and transmitting the V Series node in
packets of the V Series node. 5 minutes interval,
for the past one
You can filter the visualizations hour.
based on the following control
filters: NOTE: The maximum
CPU Usage trend refers
+ Platform to the CPU usage for
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Dashboard Displays Visualizations | Displays
« Connection service cores only. Small
e V Series Node form factor V Series
nodes do not have
service cores, therefore
the CPU usage is
reported as O.
V Series Node with | Line chart that
Most CPU Usage displays Maximum
For Past 5 minutes
CPU usage of the V
Series node for the
past 5 minutes.
NOTE: You cannot use
the time based filter
options to filter and
visualize the data.
V Series Node Rx Receiving trend of the V
Trend Series node in 5 minutes
interval, for the past one
hour.
V Series Network Total packets
’”terfacefs with received by each of
Most Rx for Past 5 .
ine the V Series network
interface for the past
5 minutes.
NOTE: You cannot use
the time based filter
options to filter and
visualize the data.
V Series Node Displays the reception of
Tunnel Rx packet at the Tunnel RX.
Packets/Errors This is the input to V
Series Node, Grouping by
tunnel identifier
comprising {monDomain,
conn, VSN, tunnelName},
before aggregation.
V Series Node TX is for output tunnels
Tunnel Tx from GigaVUE V Series
Packets/Errors Node. V Series Node
Tunnel Tx Packets/Errors
Dedup Displays visualizations related to | Dedup Packets Statistics of the total
Detected/Dedup
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Dashboard

Displays

Dedup application.

You can filter the visualizations
based on the following control
filters:

¢ Platform
e« Connection
e V Series Node

Visualizations

Packets Overload

Displays

dedup packets received
(ipV4Dup, ipVeDup and
nonlPDup) against the
dedup application
overload.

Dedup Packets
Detected/Dedup
Packets Overload
Percentage

Percentage of the dedup
packets received against
the dedup application
overload.

Total Traffic In/Out
Dedup

Total incoming traffic
against total outgoing
traffic

Tunnel (Virtual)

Displays visualizations related to
the tunneled traffic in both
bytes as well as the number of
packets.

You can select the following
control filters, based on which
the visualizations will get
updated:

« Monitoring session: Select the
required monitoring session. The
cloud platform, monitoring domain
and connection within the
monitoring domain that is used by
the V Series node are shown in
square brackets, commma-separated,
after the name, to distinguish the
whole path to it.

e V Series node: Management IP of
the V Series node. Choose the
required V Series node from the
drop-down.

e Tunnel: Select any of the tunnels
shown in the Tunnel drop-down.
The direction for each tunnel is
shown with the prefix in or out.

The following statistics are
displayed for the tunnel:

o Received Bytes
o Transmitted Bytes

e Received Packets

Tunnel Bytes

Displays received
tunnel traffic vs
transmitted tunnel
traffic, in bytes.

o Forinput tunnel,

transmitted traffic is
displayed as zero.

e For output tunnel,
received traffic is
displayed as zero.
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Dashboard

Displays

e Transmitted Packets

e Received Errored Packets

e Received Dropped Packets

e Transmitted Errored Packets

e Transmitted Dropped Packets

Visualizations

Displays

Tunnel Packets

Displays packet-level
statistics for input and
output tunnels that are
part of a monitoring
session.

App (Virtual)

Displays Byte and packet level
statistics for the applications for
the chosen monitoring session
on the selected V Series node.

You can select the following
control filters, based on which
the visualizations will get
updated:

« Monitoring session
e V Series node

o Application: Select the required
application. By default, the
visualizations displayed includes all
the applications.

By default, the following
statistics are displayed:

e Received Bytes

e Transmitted Bytes

o Received Packets

« Transmitted Packets
o Errored Packets

e Dropped Packets

App Bytes

Displays received traffic
Vs transmitted traffic, in
Bytes.
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Dashboard Displays Visualizations | Displays
App Packets Displays received traffic
vs transmitted traffic, as
the number of packets.
End Point Displays Byte and packet level Endpoint Bytes Displays received traffic
(Virtual) statistics for the un-tunneled vs transmitted traffic, in

traffic deployed on the V Series
nodes.

The following statistics that are
shown for Endpoint (Virtual):

o Received Bytes

e Transmitted Bytes

o Received Packets

o Transmitted Packets

o Received Errored Packets

o Received Dropped Packets

o Transmitted Errored Packets

e Transmitted Dropped Packets

The endpoint drop-down shows
<V Series Node Management IP
address : Network Interface> for
each endpoint.

You can select the following
control filters, based on which
the visualizations will get
updated:

» Monitoring session
e V Series node

« Endpoint: Management IP of the V
Series node followed by the
Network Interface (NIC)

Bytes.

Endpoint Packets

Displays received traffic
Vs transmitted traffic, as
the number of packets.

NoTE: The Tunnel (Virtual), App (Virtual) and Endpoint (Virtual) dashboards do not
show data from the previous releases if the Monitoring Session [Platform : Domain :
Connection] dashboard filter is applied. This is because, this filter relies on the new
attributes in the OpenSearch database, which are available only from software
version 5.14.00 and beyond.
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Customer Orchestrated Source - Use Case

Customer Orchestrated Source is a traffic acquisition method that allows to tunnel traffic
directly to the GigaVUE V Series Nodes. In cases where UCT-V or VPC Mirroring cannot be
configured due to firewall or other restrictions, you can use this method and tunnel the
traffic to GigaVUE V Series Node, where the traffic is processed.

When using Customer Orchestrated Source, you can directly configure tunnels or raw
endpoints in the monitoring session, where you can use other applications like Slicing,
Masking, Application Metadata, Application Filtering, etc., to process the tunneled traffic.
Refer to Create Ingress and Egress Tunnels and Create Raw Endpoint for more detailed
information on how to configure Tunnels and Raw End Points in the Monitoring Session.

You can configure an Ingress tunnel in the Monitoring Session with the GigaVUE V Series
Node IP address as the destination IP address, then the traffic is directly tunneled to that
GigaVUE V Series Node.

Introduction to the Supported Features on GigaVUE Cloud Suite for Azure
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Licensing GigaVUE Cloud Suite
for Azure

You can license the GigaVUE Cloud Suite for Azure (Azure Government or Azure Cloud)
using the following method in Azure Market Place or Azure Government Market Place:

¢ Volume Based License (VBL)

For purchasing licenses with the Volume-Based License (VBL) option, contact our Sales.
Refer to Contact Sales. For instructions on how to generate and apply license refer to the
GCigaVUE Administration Guide and the GigaVUE Licensing Guide.
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Volume Based License (VBL)

All the GigaVUE V Series Nodes connected to GigaVUE-FM periodically report statistics on
the amount of traffic that flows through the V Series Nodes. The statistics provide
information on the actual data volume that flows through the V Series Nodes. All licensed
applications, when running on the node, generate usage statistics.

Licensing for GigaVUE Cloud Suite is volume-based. In the Volume-Based Licensing (VBL)
scheme, a license entitles specific applications on your V Series Nodes to use a specified
amount of total data volume over the term of the license. The distribution of the license to
individual nodes becomes irrelevant for Gigamon accounting purpose. GigaVUE-FM tracks
the total amount of data processed by the various licensed applications and provides
visibility on the actual amount of data, each licensed application is using on each node, and
tracks the overuse, if any.

Volume-based licenses are available as monthly subscription licenses with a service period
of one month. Service period is the period of time for which the total usage or overage is
tracked. There is a grace period for each license that is encoded in the license file. The
license effectively provides data allowance for this additional time after the official end time
of the license.

For purchasing licenses with the Volume-Based License (VBL) option, contact our Sales.
Refer to Contact Sales.
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Base Bundles

In volume-based licensing scheme, licenses are offered as bundles. The following three base

bundle types are available:

e CoreVUE
e NetVUE
e SecureVUEPIlus

The bundles are available as SKUs!. The number in the SKU indicates the total volume
allowance of the SKU for that base bundle. For example, VBL-250T-BN-CORE has a daily
volume allowance of 250 terabytes for CoreVUE bundle.

Bundle Replacement Policy

Refer to the following notes:

* You can always upgrade to a higher bundle but you cannot move to a lower version.

* You cannot have two different base bundles at the same time however, you can have
multiple base bundles of the same type.

» Once upgraded to a higher bundle, the existing lower bundles will be automatically
deactivated.

1Stock Keeping Unit. Refer to the What is a License SKU? section in the FAQs for Licenses chapter.
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Add-on Packages

GigaVUE-FM allows you to add additional packages called add-on packages to the base
bundles. These add-on packages allow you to add additional applications to your base
bundles. Add-on packages have their own start/end date and volume specifications.

Rules for add-on packages:

* Add-on packages can only to be added when there is an active base bundle available in
GigaVUE-FM.

» The base bundle limits the total volume usage of the add-on package.

e |f your add-on package has volume allowance less than the base bundle, then your add-
on package can only handle volume allocated for add-on package.

* When the life term of an add-on package extends beyond the base bundle, then when
the base bundle expires, the volume allowance of the add-on package will be reduced to
zero until a new base bundle is added.

For more information about SKUs refer to the respective Data Sheets as follows:

GigaVUE Data Sheets

GigaVUE Cloud Suite for VMware Data Sheet

GigaVUE Cloud Suite for AWS Data Sheet

GigaVUE Cloud Suite for Azure Data Sheet

GigaVUE Cloud Suite for OpenStack

GigaVUE Cloud Suite for Nutanix

GigaVUE Cloud Suite for Kubernetes
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How GigaVUE-FM Tracks Volume-Based License Usage

GigaVUE-FM tracks the license usage for each V Series node as follows:

« When you create and deploy a monitoring session, GigaVUE-FM allows you to use only
those applications that are licensed at that point (applicable only for ACTIVE licenses,
licenses in grace period are not included).

« When a license goes into grace period, you will be notified with an audit log.

« When a license expires (and has not been renewed yet), the monitoring sessions using
the corresponding license will not be undeployed.

For releases prior to 6.4:

e The monitoring sessions using the corresponding license will be undeployed (but not
deleted from the database).

e When a license is later renewed or newly imported, any undeployed monitoring
sessions are redeployed.

NoTE: When the license expires, GigaVUE-FM displays a notification on the screen.
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Manage and Activate Volume-based Licenses

To manage active Volume-based License:

1. On the left navigation pane, click .
2. Go to System > Licenses. From the top navigation bar, select the VBL Active from the

FM/Cloud drop-down.

This page lists the following information about the active Volume-based Licenses:

Field Description

SKUs Unigque identifier associated with the license
Bundles Bundle to which the license belongs to

Volume Total daily allowance volume

Starts License start date

Ends License end date

Type Type of license (Commercial, Trial, Lab and other

license types).

Activation ID

Activation ID

Entitlement ID

Entitlement ID

NOTE: The License Type and Activation ID are displayed by default in the
VBL Active page. To display the Entitlement ID field, click on the column setting
configuration option to enable the Entitlement ID field.

The expired licenses are displayed in the VBL Inactive page, which can be found under

the FM/Cloud drop-down in the top navigation bar. This page lists the following

information about the inactive Volume-based Licenses:

Field Description

SKUs Unique identifier associated with the license.
Bundles Bundle to which the license belongs to.
Ends License end date

Grace Period

Number of days the license is in grace period

Deactivation Date

Date the license got deactivated.

Revocation Code

License revocation code.

Status

License status.

Licensing GigaVUE Cloud Suite for Azure
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NOTE: The License Type, Activation ID and Entitlement ID fields are not
displayed by default in the VBL Inactive page. To display these fields, click
on the column setting configuration option and enable these fields.

Use the following buttons to manage your VBL.

Button Description

Activate Licenses

GigaVUE Licensing Guide.

Use this button to activate a Volume-based
License. For more information, refer to the topic
Activate Volume-based Licenses of the

Email Volume Usage

to the email recipients.

Use this button to send the volume usage details

Filter Use this button to narrow down the list of active
Volume-based Licenses that are displayed on the
VBL active page.

Export Use this button to export the details in the VBL
active page to a CSV or XLSX file.

Deactivate Use this button to deactivate the licenses. You

period or that have expired.

can only deactivate licenses that are in grace

For more detailed information on dashboards and reports generation for Volume-based

Licensing refer to the following table:

For details about:

Reference section

How to generate Volume-based
License reports

Generate VBL Usage Reports

GigaVUE
Administration
Guide

Volume-based Licensed report details

Volume Based License Usage
Report

GigaVUE
Administration
Guide

Fabric health analytics dashboards for
Volume-based Licenses usage

Dashboards for Volume Based
Licenses Usage

GigaVUE-FM User
Guide

Activate Volume-based Licenses

To activate Volume-based licenses:

1. On the left navigation pane, click .
2. Go to System > Licenses. From the top navigation bar, select the VBL Active from the

FM/Cloud drop-down.
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3. Click Activate Licenses. The Activate License page appears. Perform the following
steps:

a. Download the fabric inventory file that contains information about GigaVUE-FM.
Click Next. Refer to the What is a Fabric Inventory File? section for more details.

b. Navigate to the Licensing Portal. Upload the Fabric Inventory file in the portal.
Once the fabric inventory file is uploaded, select the required license and click
Activate. A license key is provided. Record the license key or keys.

c. Return to GigaVUE-FM and add the additional licenses.
Default Trial Licenses

After you install GigaVUE-FM, a default free 1TB of CoreVUE trial volume-based license (VBL)
is provided one-time for 30 days (from the date of installation).

FM/Cloud  NodeLicenses~ (i@ VolumeUsage~  Expiry  Settings

Lt Find Gearch... q (&Export - ) (CardRMA Replace Licenses Filter

< Packet Errors and ...
10 floating licenses have expired are going to expire soon. To continue using these products, please renew your licenses. x

Port Discovery

Node Details [  sku | Feature | Type | Description | StartDate | EndDate | Activation|D | Seats/Volume | Status [©)
IP Resol
esolver o BL-1T-BN-CORE-TRIAI erspan Trial 1T-AdvancedTu..  May 13, 2021 Jun 12, 2021 4eBcbSad-7ebd.. 1024 GB daily Expired
Backup/Restore
| @  VBL-1T-BN-CORE-TRIAL geneve,slicingm...  Trial 1T-BaseApps May 13, 2021 Jun 12,2021 4eBcbSad-7ebd.. 1024 GB daily Expired
mages
Certificates @  VBL-1T-BN-CORE-TRIAL header-stripping...  Trial 1T-HeaderStripp..  May 13, 2021 Jun 12,2021 4eBcbSad-7ebd.. 1024 GB daily Expired
Event Notifications ] SMT-HCO-GEN1-DD1-SW-TM dedup Internal HC2-GEN1-Ded..  May 14,2021 May 14, 2022 a5d70642-95¢b... 5 of 8 available Grace Period
L
fcenses =] SMT-HCO-GEN1-APF-SW-TM apf Internal HC2-GENL-APF..  May 21,2021 Never e782018-1b0f-.. 6 of 8 available Active
Logs
) SMT-HCO-GEN1-ASF-SW-TM asf Internal HC2-GENL-ASF..  May 21,2021 Never 24618ae4-ddb6... 1 of 2 available Active
Storage Managen...
> Tasks [ SMT-HCO-GEN1-HS1-SW-TM header-stripping...  Internal HC2-GENL-HSL.. ~May 21,2021 Never 8d035388-013.. 7 of 8 available Active
Reports [ SMT-HCO-GEN1-NF1-SW-TM netflow Internal HC2-GENL-Net..  May 21,2021 Never 11d3f4dd-90c6.. 7 of 8 available Active
> Authentication O SMT-HCO0-GEN1-SSL-SW-TM ssl-decrypt Internal HC2-GEN1-SSL..  May 21,2021 Never 30f7e2c0-aea5-.. 0 of 3 available Active
High Availability )
[ SMT-HC3-GEN2-5GC-SW-TM 5G-Correlation n..  Commercial HC3-GEN2-5GC..  Apr 22,2021 Apr 22,2022 760ceb6a-c919.. 1 of 4 available Expired
Tags
[]  SMT-HC3-GEN2-GTPMAX-SW-TM apfiflowrule-gtp .. Internal HC3-GEN2-GTP..  Apr 22,2021 Apr 22,2022 7228d9a9-30ac... 4 of 4 available Expired

This license includes the following applications:

» ERSPAN

¢ Geneve

» Slicing

» Masking

e Trailer

e Tunneling

e |oad Balancing
« Enhanced Load Balancing
* Flowmap

e Header-stripping
* Add header
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NOTE: There is no grace period for the trial license. If you do not have any other
Volume-based licenses installed, then after 30 days, on expiry of the trial license, any

deployed monitoring sessions will be undeployed from the existing GigaVUE V Series
Nodes.

To deactivate the trial VBL refer to Delete Default Trial Licenses section for details.

Delete Default Trial Licenses

GigaVUE-FM allows you to deactivate the default trial licenses from this page. To deactivate
the license:

1.  On the left navigation pane, cIick.

2. Go to System > Licenses >Floating. Click Activated.

3. Click Deactivate > Default Trial VBL.

The VBL trial licenses is deactivated and is no longer listed in the Activated page. However,
you can view these deactivated licenses from the Deactivated page.

Points to Note for GigaVUE Cloud
Suite for Azure

IMPORTANT: If you are using a Cloud Solution Provider (CSP) in Azure, we require your

CSP tenant ID and company name to be included in our Azure publishing portal. Please
contact Gigamon Sales.

» When tool is deployed outside Azure, ensure there is connectivity between GigaVUE V
Series Node tool interface and the tool. You can create connectivity by configuring a
Network Address Translation (NAT) gateway.

e When GigaVUE-FM and GigaVUE V Series Nodes are deployed in different cloud
platforms, then the GigaVUE-FM public IP address must be added to the Data
Notification Interface as the Target Address in the Event Notifications page. Refer to
Configuration Settings section for configuration details.

Points to Note for GigaVUE Cloud Suite for Azure
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Get Started with GigaVUE Cloud
Suite for Azure

This chapter describes how to plan and start the GigaVUE Cloud Suite for Azure deployment
on the Microsoft® Azure cloud.

Refer to the following sections for details:

» License Information

«» Before You Begin

= Install GigaVUE-FM on Azure
« Permissions and Privileges

Get Started with GigaVUE Cloud Suite for Azure 49
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Before You Begin

You must create an account and configure a VNet as per your requirements. This section
describes the requirements for launching the GigaVUE-FM VM.

« Prerequisites

« VPN Connectivity

«» Obtain GigaVUE-FM Image

« Enable Subscription for GigaVUE Cloud Suite for Azure

Get Started with GigaVUE Cloud Suite for Azure
Before You Begin

50



GigaVUE Cloud Suite for Azure - Deployment Guide

Prerequisites

To enable the flow of traffic between the components and the monitoring tools, you must
create the following requirements:

« Resource Group

« Virtual Network

= Subnets for VNet

=« Network Interfaces (NICs) for VMs

« Network Security Groups

« Virtual Network Peering

« Access control (IAM)

« Default Login Credentials

» Recommended Instance Types

Resource Group
The resource group is a container that holds all the resources for a solution.

To create a resource group in Azure, refer to Create a resource group topic in the Azure
Documentation.

Virtual Network

Azure Virtual Network (VNet) is the fundamental building block for your private network in
Azure. VNet enables many types of Azure resources, such as Azure Virtual Machines (VM), to
securely communicate with each other, the internet, and on-premises networks.

You can only configure the GigaVUE fabric components in a Centralized VNet only. In case of
a shared VNet, you must select a VNet as your Centralized VNet for GigaVUE fabric
configuration.

To create a virtual network in Azure, refer to Create a virtual network topic in the Azure
Documentation.

Subnets for VNet

The following table lists the two recommended subnets that your VNet must have to
configure the GigaVUE Cloud Suite Cloud components in Azure.

You can add subnets when creating a VNet or add subnets on an existing VNet. Refer to Add
a subnet topic in the Azure Documentation for detailed information.
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Subnet Description

Management Subnet that the GigaVUE-FM uses to communicate with the
Subnet GigaVUE V Series Nodes and Proxy.
Data Subnet A data subnet can accept incoming mirrored traffic from agents to

the GigaVUE V Series Nodes or be used to egress traffic to a tool
from the GigaVUE V Series Nodes. There can be multiple data
subnets.

= Ingressis VXLAN from agents

= Egressis either VXLAN tunnel to tools or to GigaVUE HC Series
tunnel port, or raw packets through a NAT when using
NetFlow.

NOTE: If you are using a single subnet, then the Management
subnet will also be used as a Data Subnet.

Tool Subnet A tool subnet can accept egress traffic to a tool from the GigaVUE V
Series Nodes. There can be only one tool subnet.

» Egressis either VXLAN tunnel to tools or to GigaVUE HC Series
tunnel port, or raw packets through a NAT when using
NetFlow.

Network Interfaces (NICs) for VMs

When using UCT-V as the traffic acquisition method, for the UCT-Vs to mirror the traffic from
the VMSs, you must configure one or more Network Interfaces (NICs) on the VMs.

» Single NIC—If there is only one interface configured on the VM with the UCT-V, the
UCT-V sends the mirrored traffic out using the same interface.

« Multiple NICs—If there are two or more interfaces configured on the VM with the UCT-
V, the UCT-V monitors any number of interfaces but has an option to send the mirrored
traffic out using any one of the interfaces or using a separate, non-monitored interface.

Network Security Groups

A network security group defines the virtual firewall rules for your VM to control inbound

and outbound traffic. When you launch GigaVUE-FM, GigaVUE V Series Proxy, GigaVUE V
Series Nodes, and UCT-V Controllers in your VNet, you add rules that control the inbound
traffic to VMs, and a separate set of rules that control the outbound traffic.

To create a network security group and add in Azure, refer to Create a network security
group topic in the Azure Documentation.

It is recommended to create a separate security group for each component using the rules
and port numbers.

Get Started with GigaVUE Cloud Suite for Azure 52
Before You Begin


https://docs.microsoft.com/en-us/azure/virtual-network/manage-network-security-group#create-a-network-security-group
https://docs.microsoft.com/en-us/azure/virtual-network/manage-network-security-group#create-a-network-security-group

GigaVUE Cloud Suite for Azure - Deployment Guide

In your Azure portal, select a network security group from the list. In the Settings section
select the Inbound and Outbound security rules to the following rules.

Following are the Network Firewall Requirements.

The following table lists the Network Firewall / Security Group requirements for GigaVUE
Cloud Suite.

NoTE: When using dual stack network, the below mentioned ports must be opened

for both IPv4 and IPve6.

Direction Protocol Port CIDR Purpose
GigaVUE-FM
Inbound TCP 443 Administrator Allows GigaVUE-FM to create
Subnet Management connection.
Inbound TCP 22 Administrator Allows CLI access for user-
Subnet initiated management and
diagnostics.
Inbound TCP 443 UCT-V Allows GigaVUE-FM to receive
(This is the port Controller IP registration requests from
used for Third UCT-V Controller.
Party
Orchestration)
Inbound TCP 443 GigaVUE V Allows GigaVUE-FM to receive
(This is the port Series Node IP | registration requests from
used for Third GigaVUE V Series Node, when
Party GigaVUE V Series Proxy is not
Orchestration) used.
Inbound TCP 443 GigaVUE V Allows GigaVUE-FM to receive
(This is the port Series Proxy IP | registration requests from
used for Third GigaVUE V Series Proxy.
Party
Orchestration)
Inbound TCP 5671 GigaVUE V Allows GigaVUE-FM to receive
Series Node IP | traffic health updates from
GigaVUE V Series Nodes.
Inbound TCP 5671 UCT-V or Allows GigaVUE-FM to receive
Subnet IP statistics from Next Generation
UCT-V.
Inbound UbDP 2056 GigaVUE V Allows GigaVUE-FM to receive
Series Node |P Application Intelligence and
Application Visualization
reports from GigaVUE V Series
Node.
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Direction Protocol Port CIDR Purpose
Outbound TCP 9900 GigaVUE-FM IP | Allows GigaVUE-FM to
communicate control plane
and data plane traffic with
UCT-V Controller
Outbound TCP 8890 GigaVUE V Allows GigaVUE-FM to
(optional) Series Proxy IP | communicate control plane
and data plane traffic to
GigaVUE V Series Proxy
Outbound TCP 8889 GigaVUE V Allows GigaVUE-FM to
Series Node |P communicate control plane
and data plane traffic to
GigaVUE V Series Node
Outbound TCP 443 GigaVUE-FM IP | Allows GigaVUE-FM to reach
Address the Public Cloud Platform APIs.
Outbound TCP 8443 UCT-C Allows GigaVUE-FM to
Controller IP communicate with UCT-C
Address Controller
UCT-V Controller
Inbound TCP 9900 GigaVUE-FM IP | Allows UCT-V Controller to
communicate with
GigaVUE-FM
Inbound TCP 8891 UCT-V or Allows UCT-V Controller to
(This is the port Subnet IP receive the registration
used for Third requests from UCT-V.
Party
Orchestration)
Inbound TCP 22 Administrator Allows CLI access for user-
Subnet initiated management and
diagnostics, specifically when
using third party orchestration.
Outbound TCP 443 GigaVUE-FM IP | Allows UCT-V Controller to
(This is the port send the registration requests
used for Third to GigaVUE-FM
Party
Orchestration)
Outbound TCP 9901 UCT-V Allows UCT-V Controller to
Controller IP communicate with UCT-Vs.
Outbound TCP 5671 GigaVUE-FM IP | Allows UCT-V Controller to
send traffic health updates to
GigaVUE-FM.
UCT-V
Inbound TCP 9901 UCT-V Allows UCT-V to receive

Controller IP

stateful coommunication from
UCT-V Controller
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Direction Protocol Port CIDR Purpose
Outbound TCP 8891 UCT-V or Allows UCT-V to communicate
(This is the port Subnet IP with UCT-V Controller for
used for Third registration and Heartbeat
Party
Orchestration)
Outbound « UDP (VXLAN) VXLAN (default | UCT-V or Allows UCT-V to
. |IP Protocol 4789) Subnet IP (VXLAN/L2GRE) tunnel traffic
(L2GRE) to V Series nodes
Outbound TCP 1443 UCT-V subnet Allows UCT-V to securely
transfer the traffic to GigaVUE
V Series Node
Outbound TCP 9900 UCT-V Allows UCT-V to send traffic
Controller IP health updates to UCT-V
Controller.
GigaVUE V Series Proxy (optional)
Inbound TCP 8890 GigaVUE-FM IP | Allows GigaVUE-FM to
communicate with GigaVUE V
Series Proxy
Inbound TCP 8891 GigaVUE V Allows GigaVUE V Series Proxy
(This is the port Series Node IP | to receive registration requests
used for Third and heartbeat messages from
Party GigaVUE V Series Node.
Orchestration)
Inbound TCP 22 Administrator Allows CLI access for user-
Subnet initiated management and
diagnostics, specifically when
using third party orchestration.
Outbound TCP 443 GigaVUE-FM IP | Allows GigaVUE V Series Proxy
to communicate the
registration requests to
GigaVUE-FM
Outbound TCP 8889 GigaVUE V Allows GigaVUE V Series Proxy
Series Node IP | to communicate with
GigaVUE V Series Node
GigaVUE V Series Node
Inbound TCP 8889 GigaVUE-FM IP | Allows GigaVUE V Series Node
to communicate with
GigaVUE-FM
Inbound TCP 8889 GigaVUE V Allows GigaVUE V Series Node
Series Proxy IP | to communicate with
GigaVUE V Series Proxy.
Inbound « UDP (VXLAN) « VXLAN UCT-V or Allows GigaVUE V Series Node
. |P Protocol (default Subnet IP to (VXLAN/L2GRE) tunnel
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Direction Protocol Port CIDR Purpose
(L2GRE) 4789) traffic to UCT-V.
. L2GRE
Inbound UDPGRE 4754 Ingress Tunnel | Allows GigaVUE V Series Node
to communicate and tunnel
traffic from UDPGRE Tunnel
Inbound TCP 22 Administrator Allows CLI access for user
Subnet initiated management and
diagnostics, specifically when
using third party orchestration.
Outbound TCP 5671 GigaVUE-FM IP | Allows GigaVUE V Series Node
to send traffic health updates
to GigaVUE-FM
Outbound « UDP (VXLAN) VXLAN (default | Tool IP Allows GigaVUE V Series Node
. |IP Protocol 4789) to communicate and tunnel
(L2GRE) traffic to the tool
Outbound UbDP 2056 GigaVUE-FM IP | Allows GigaVUE V Series Node
to send Application
Intelligence, Application
Visualization reports to
GigaVUE-FM
Outbound UbDP 2055 Tool IP Allows GigaVUE V Series Node
to send NetFlow traffic to
external tool.
Outbound UDP 514 Tool IP Allows GigaVUE V Series Node
to send Application Metadata
Intelligence log messages to
external tool.
Outbound ICMP . echorequest | Tool IP Allows GigaVUE V Series Node
(optional) « echo reply to send health check tunnel
destination traffic
Outbound TCP 8891 GigaVUE V Allows GigaVUE V Series Node
(This is the port Series Proxy IP | to send registration requests
used for Third and heartbeat messages to
Party GigaVUE V Series Proxy when
Orchestration) GigaVUE V Series Proxy is used.
Outbound TCP 443 GigaVUE-FM IP | Allows GigaVUE V Series Node
(This is the port Address to send registration requests
used for Third and heartbeat messages to
Party GigaVUE-FM when GigaVUE V
Orchestration) Series Proxy is not used.
Bidirectional TCP N443 GigaVUE V Allows to securely transfer the
Series Node traffic in between GigaVUE V
subnet Series Nodes.

Universal Cloud Tap - Container deployed inside Kubernetes worker node

Outbound

TCP

42042

Any IP address

Allows UCT-C to send statistics
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Direction Protocol Purpose

to UCT-C Controller.
UCT-C Controller deployed inside Kubernetes worker node
Inbound TCP 8443 Any IP address | Allows UCT-C Controller to
(configurable) communicate with GigaVUE-
FM
Outbound TCP 5671 Any IP address | Allows UCT-C controller to
send statistics to GigaVUE-FM.
Outbound TCP VXLAN (default | Any IP address | Allows UCT-C Controller to
4789) communicate and tunnel
traffic to the tool
Outbound TCP 443 Any IP address | Allows UCT-C Controller to
communicate with GigaVUE-
FM

Virtual Network Peering

Virtual network peering enables you to seamlessly connect two or more Virtual Networks in
Azure. Virtual Network Peering is only applicable when multiple Virtual Networks are used in
a design. Refer to Virtual Network Peering topic in Azure documentation for more details.

Access control (IAM)

You must have full resource access to the control the GigaVUE Cloud Suite cloud
components. Refer to Check access for a user topic in the Azure documentation for more
details.

Default Login Credentials

You can login to the GigaVUE V Series Node, GigaVUE V Series Proxy, and UCT-V Controller
by using the default credentials.

Product Login credentials

GigaVUE V You can login to the GigaVUE V Series Node by using ssh. The default
Series Node username and password is not configured.

GigaVUE V Series | You can login to the GigaVUE V Series Node by using ssh. The default username and
proxy password is not configured.

UCT-V Controller | You can login to the GigaVUE V Series Node by using ssh. The default username and
password is not configured.
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Recommended Instance Types

NoTE: Additional instance types are also supported. Refer to Support, Sales, or
Professional Services for deployment optimization.

Product Instance Type vCPU

GigaVUE V Standard_D4s_v4 4 vCPU 16 GB
series Node | g3nqard_D8S_V4 8vCPU 32GB
GigaVUE V Standard_Bls 1vCPU 1GB
Series Proxy

UCT-V Standard_Bls 1vCPU 1GB
Controller
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VPN Connectivity

GigaVUE-FM requires Internet access to integrate with the public APl endpoints to integrate
with the GigaVUE Cloud Suite Cloud platform. If there is no Internet access, refer to
Configure Proxy Server.
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Obtain GigaVUE-FM Image

The image for the GigaVUE Cloud Suite Cloud is available in both the Azure Public Cloud
and in the Azure Government portal.

GigaVUE Cloud Suite Cloud Suite in Azure Public Cloud

GigaVUE Cloud Suite Cloud is available in the Azure Marketplace with the Volume Based
License options.

GigaVUE Cloud Suite Cloud Suite in Azure Government

Azure Government is an isolated Azure region that contains specific regulatory and
compliance requirements of the US government agencies.

To monitor the VMs that contain all categories of Controlled Unclassified Information (CUI)
data and sensitive government data in the Azure Government (US) Region, the Azure
Government solution provides the same robust features in Azure Government as in the
Azure public cloud.
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Install and Upgrade GigaVUE-FM

You can install and upgrade the GigaVUE-FM fabric manager (GigaVUE-FM) on cloud

platforms or on-premises.

You have the flexibility of installing GigaVUE-FM across various supported platforms.
Additionally, you can effectively manage deployments in any of the cloud platform as long

as there exists IP connectivity for seamless operation.
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Cloud

» Azure - To install GigaVUE-FM inside your Azure environment, you can launch the
GigaVUE-FM instance in your VNet.
o Installation: Refer to Install GigaVUE-FM on Azure.
o Upgrade: Refer to Upgrade GigaVUE-FM in Azure topic in GigaVUE-FM Installation

and Upgrade Guide.

» GigaVUE-FM can also be installed in any of the cloud platform. Refer to GigaVUE-FM
Installation and Upgrade Guide for more detailed information on how to install
GigaVUE-FM in public, private or hybrid cloud platforms.

o Upgrade: Refer toUpgrade GigaVUE-FM topic in GigaVUE-FM Installation and
Upgrade Guide.
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On-premise

To install and upgrade GigaVUE-FM in your enterprise data center, refer to GigaVUE-FM
Installation and Upgrade Guide available in the Gigamon Documentation Library.

o Installation: Refer to GigaVUE-FM Installation and Upgrade Guide.

o Upgrade: Refer toUpgrade GigaVUE-FM topic in GigaVUE-FM Installation and
Upgrade Guide.
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Enable Subscription for GigaVUE Cloud Suite for
Azure

For GigaVUE-FM to be able to launch the fabric images, you must accept the terms of the
end user license agreements (EULAS) and enable programmatic access. This can be done in
the Azure portal or through Azure Portal Cloud Shell. Refer to the following topics for more

detailed information:

e Enable Subscription using CLI
e Enable Subscription using Azure Portal

NoTE: For accepting EULA, you need to have Owner role on the Subscription.
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Enable Subscription using CLI
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1. BYOL FM: The following example shows how to accept EULA for BYOL FM using Azure
Portal Cloud Shell

az vm image terms accept --urn gigamon-inc:gigamon-gigavue-cloud-suite:gfm-azure:<GigaVUE-FM

version>
{
"accepted": true,
"id": "<Enter Subscription ID>",
"licenseTextLink": "<Provide License text file link>",
"marketplaceTermsLink": "<Provide Market Place Terms text file link>",
"name": "gfm-azure",
"plan": "gfm-azure",
"privacyPolicylLink": "https://www.gigamon.com/privacy-policy.html",
"product": "gigamon-gigavue-cloud-suite",
"publisher": "gigamon-inc",
"retrieveDatetime": "2023-05-02T720:09:36.134759272",
"signature":

"SZL3CYR5MMU5QC5FEBIDHLMOYE7DD4CBSMLOVRMCKAAUDSCKLGARIWPALULYWCFWCENMFF77RCXMACM2B24WV3PGEFW
W7UL4VMI3BVI",

"systemData": {
"createdAt": "2023-05-02T720:09:38.101210+00:00",
"createdBy": "6447eb55-9d09-481b-89bc-52e96bb52823",
"createdByType": "ManagedIdentity",
"lastModifiedAt": "2023-05-02T20:09:38.101210+00:00",
"lastModifiedBy": "6447eb55-9d09-481b-89bc-52e96bb52823",
"lastModifiedByType": "ManagedIdentity"

s

"type": "Microsoft.MarketplaceOrdering/offertypes"

}
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2. Fabric Images (need to accept on all 3): The following examples show how to accept
EULA for different fabric components using Azure Portal Cloud Shell

For UCT-V Controller

az vm image terms accept --urn gigamon-inc:gigamon-gigavue-cloud-suite:uctv-cntlr:<UCT-V
Controller version>

{
"accepted": true,

...............

For GigaVUE V Series Node

az vm image terms accept --urn gigamon-inc:gigamon-gigavue-cloud-suite:vseries-node:<GigaVUE
V Series Node Version>

{

...............

For GigaVUE V Series Proxy

az vm image terms accept --urn gigamon-inc:gigamon-gigavue-cloud-suite:vseries-
proxy:<GigaVUE V Series Proxy version>

{
"accepted": true,

.................
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Enable Subscription using Azure Portal

Enable the subscription for GigaVUE-FM and its fabric components like GigaVUE V Series
Node, UCT-V Controller, and GigaVUE V Series Proxy. The following steps provide detailed
information on how to accept the terms using Azure Portal.

1.
2.

Go to Market Place, search Gigamon.

Select Gigamon GigaVUE Cloud Suite for Azure from the search results. Select the
required image from the Plan drop-down menu.

Click the "Want to deploy programmatically? Get started" link.
Review the terms of service and the subscription name and then click Enable.
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Install GigaVUE-FM on Azure

The GigaVUE-FM can be launched from the Azure VM dashboard or Azure Marketplace.
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Install GigaVUE-FM Using Azure VM Dasboard

Go to Azure VM Dashboard > Virtual Machines, click Create to create an Azure Virtual
Machine. Refer to Create a Linux virtual machine in the Azure topics in Azure
Documentation for more information. Enter the details as mentioned in Table 1: GigaVUE-

FM Installation Steps.
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Install GigaVUE-FM Using Azure Market Place

Go to Azure Market Place, search for Gigamon. The latest version of Gigamon GigaVUE Cloud
Suite for Azure appears. Open the latest version of GigaVUE-FM. Review and accept the
terms for Gigamon GigaVUE Cloud Suite for Azure. Refer to Enable Subscription for GigaVUE
Cloud Suite for Azure for more detailed information on how to enable the subscription and
accept the terms of use. Refer to Create a Linux virtual machine in the Azure topics in Azure
Documentation for more information. Enter the details as mentioned in Table 1: GigaVUE-

FM Installation Steps.

The following table describes the important fields.

Table 1: GigaVUE-FM Installation Steps

Field Description

Basics

Subscription

Select your subscription.

Resource Group

Select an existing resource group or create a new resource group. For more
information, refer to Create a resource group topic in the Azure Documentation.

Virtual machine name

Enter a name for the VM.

Region Select a region for Azure VM.

Image Select the latest GigaVUE-FM images.
NOTE: You cannot select multiple images for a VM. Refer to Configure GigaVUE
Fabric Components in Azure - Integrated Mode for more details on configuring
GigaVUE V Series Node, GigaVUE V Series Proxy, and UCT-V Controller in Azure.

Size The recommended instance types are as follows:

« GigaVUE-FM - Standard_D4s_v3
« UCT-V Controller - Standard_BIms
« V Series Node - Standard_D4s_v4
« V Series Proxy - Standard_Blms

Authentication Type

We support only SSH public key authentication type
« SSH public key
o Enter the administrator username for the VM.
o Enter the SSH public key pair name.

NOTE: The username "gigamon" is reserved for internal use. Do not create a user
with the name "gigamon"

Disks
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Field Description

Disk Size

The required disk size for GigaVUE-FM is 2 x 40GB.

Networking

Virtual Network

Select an existing VNet or create a new VNet. For more information, refer to Create
a virtual network topic in the Azure Documentation.

On selecting an existing VNet, the Subnet and the Public IP values are auto-
populated.

Configure network
security group

Select an existing network security group or create a new network security group.
For more information, refer to Network Security Groups. Configure the Network
Security Group to allow GigaVUE-FM to communicate with the rest of the
components.

NoTE: Verify the summary before proceeding to create. It will take several minutes
for the VM to initialize. After the initialization is completed, you can verify the VM
through the Web interface.

After the deployment, navigate to the VM overview page, copy the Public IP address, and
paste it in a new web browser tab.
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Permissions and Privileges

When you first connect GigaVUE-FM to Azure, you need the appropriate authentication for
Azure to verify your identity and check if you have permission to access the resources that
you are requesting. This is used for GigaVUE-FM to integrate with Azure APIs and to

automate the fabric deployment and management.
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Prerequisite

Have pre-defined custom roles or create new custom roles, that can be attached to the
resource group or subscription level. Refer to Custom Roles topic for more detailed
information on how to create custom roles.

Custom Roles

The ‘built-in’ roles provided by Microsoft are open to all resources. You can create a custom
role if required. For more information, refer to Azure custom roles topic in the Azure
Documentation.

You can use the following command to create custom roles in CLI:

az role definition create --role-definition <Custom Role>.Jjson

The following examples provides the minimum permissions that are required for GigaVUE-
FM to deploy the fabric components and/or inventory the UCT-V. The permissions can be
applied at the resource group level or subscription level:

Example 1: Create Custom Role for GigaVUE-FM to deploy visibility fabric components
and inventory UCT-V

“name”: “GigaVue-FM-Service-Role”
"roleName": "CustomRoleFabricDeploymentAndInventory",
"description”: "The minimum requirements for FM to deploy Fabric Components and inventory UCT-

"assignableScopes": [
"/subscriptions/<SubscriptionID>/resourceGroups/<resourceGroup name>"
1,
"permissions": [
{
"actions": [

"Microsoft.Compute/virtualMachines/read",
"Microsoft.Compute/virtualMachines/write",
"Microsoft.Compute/virtualMachines/delete",
"Microsoft.Compute/virtualMachines/start/action”,
"Microsoft.Compute/virtualMachines/powerOff/action",
"Microsoft.Compute/virtualMachines/restart/action",
"Microsoft.Compute/virtualMachines/instanceView/read",
"Microsoft.Compute/locations/vmSizes/read",
"Microsoft.Compute/images/read",
"Microsoft.Compute/disks/read”,
"Microsoft.Compute/disks/write",
"Microsoft.Compute/disks/delete",
"Microsoft.Network/networkInterfaces/read",
"Microsoft.Network/networkInterfaces/write",
"Microsoft.Network/virtualNetworks/subnets/join/action”,
"Microsoft.Network/virtualNetworks/subnets/read",
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"Microsoft.Network/networkInterfaces/join/action",
"Microsoft.Network/networkInterfaces/delete",
"Microsoft.Network/publicIPAddresses/read",
"Microsoft.Network/publicIPAddresses/write",
"Microsoft.Network/publicIPAddresses/delete",
"Microsoft.Network/publicIPAddresses/join/action",
"Microsoft.Network/virtualNetworks/read",
"Microsoft.Network/virtualNetworks/virtualMachines/read",
"Microsoft.Network/networkSecurityGroups/read",
"Microsoft.Network/networkSecurityGroups/join/action",
"Microsoft.Network/publicIPAddresses/read",
"Microsoft.Network/publicIPAddresses/write",
"Microsoft.Network/publicIPAddresses/delete",
"Microsoft.Network/publicIPAddresses/join/action",
"Microsoft.Resources/subscriptions/locations/read",
"Microsoft.Resources/subscriptions/resourceGroups/read"”,
"Microsoft.Resources/subscriptions/resourcegroups/resources/read"

1,

"notActions": [],

"dataActions": [],

"notDataActions": []

Example 2: Create Custom Role for GigaVUE-FM to only inventory UCT-V

“name”: “GigaVue-FM-Service-Role”
"roleName": "CustomRoleInventoryUCT-V ",
"description”: "Minimum requirements for FM to inventory UCT-V",
"/subscriptions/<Subscription ID>/resourceGroups/<resourceGroup name>"
1,
"permissions”: [
{
"actions": [
"Microsoft.Compute/virtualMachines/read",
"Microsoft.Compute/virtualMachines/instanceView/read",
"Microsoft.Compute/images/read",
"Microsoft.Compute/disks/read”,
"Microsoft.Network/networkInterfaces/read",
"Microsoft.Network/virtualNetworks/subnets/read",
"Microsoft.Network/publicIPAddresses/read",
"Microsoft.Network/virtualNetworks/read",
"Microsoft.Network/virtualNetworks/virtualMachines/read",
"Microsoft.Network/networkSecurityGroups/read",
"Microsoft.Network/publicIPAddresses/read",
"Microsoft.Resources/subscriptions/locations/read",
"Microsoft.Resources/subscriptions/resourceGroups/read”,
"Microsoft.Resources/subscriptions/resourcegroups/resources/read"
1,
"notActions": [],
"dataActions": [],
"notDataActions": []
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You can use the following snippet in the above JSON file to assign your custom role at either
resource group level or subscription level

For Resource group level:

"assignableScopes": [
"/subscriptions/<Subscription ID>/resourceGroups/<resourceGroup name>"

1,

For Subscription level:

"assignableScopes": [
"/subscriptions/<Subscription ID>/"

1B

To add a role assignment, refer to Steps to assign an Azure role.

GigaVUE-FM supports two types of authentications with Azure. Refer to the following
sections for more detailed information on how to enable each type of authentication for
GigaVUE-FM and how to assign the above created custom roles for GigaVUE-FM:

¢ Managed ldentity (recommended)
e Application ID with client secret
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Managed Identity (recommended)

Managed Identity (MSI) is a feature of Microsoft Entra ID. When you enable MSIl on an Azure
service, Azure automatically creates an identity for the service VM in the Microsoft Entra
tenant used by your Azure subscription.

Managed Identity (MSI) is only available when GigaVUE-FM is launched inside Azure. If
GigaVUE-FM is launched in one VNet and the GigaVUE V Series Nodes are deployed in a
different VNet, then Virtual Network Peering must be configured. Refer to the Virtual
Network Peering for more details on how to configure Virtual Network Peering.

There are 2 steps to have MS| work:

1. Enable MSI on the VM running in GigaVUE-FM. It can be done in using Azure portal or
CLL
a. Azure Portal: Refer to Configure managed identities using the Azure portal in the
Azure documentation for detailed instructions
b. Azure CLI:

e Forresource group level: az vm identity assign -g <Resource group where FM is
deployed> -n <GigaVUE-FM name> -scope <resource group id>

e For subscription level: az vm identity assign -g <Resource group where FM is
deployed> -n <GigaVUE-FM name> -scope <subscription id>

For more information, refer to Configure managed identities for Azure resources
using Azure CLI topic in the Azure Documentation.

2. Assign permissions to this VM on all the resources where you need GigaVUE-FM to
manage.

After enabling MSI, you can assign custom roles to GigaVUE-FM at a resource group level or
subscription level:

Assign a Custom Role using CLI

1. Assign a custom role at resource group level where you will deploy the fabric:

az vm identity assign -g <Resource group where FM is deployed> -role
<Custom Role> -n <GigaVUE-FM name> --scope <resource group id>

2. Assign a custom role at the subscription level to view the complete account details:

az vm identity assign -g <Resource group where FM is deployed> -role
<Custom Role> -n <GigaVUE-FM name> --scope <subscription id>

If you want to update the Role, you can edit the JSON file, and then update the Role in Azure
using the following CLI command:

az role definition update --role-definition <Custom Role>.Jjson
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You can run these commands in the Azure Portal in a cloud shell (icon in the upper right of
the portal as seen here): .

Assign a Custom Role using Azure Portal

You can assign roles to GigaVUE-FM using Azure Portal for Resource Group Level or

Subscription Level. Refer to Assign Azure roles topic in Azure Documentation for detailed
information.
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Application ID with client secret

GigaVUE-FM supports application id with client secret authentication. When using
GigaVUE-FM to connect to Azure, it uses a service principal. A service principal is an account
for a non-human such as an application to connect to Azure. When GigaVUE-FM is launched
outside Azure, Application ID with client secret is preferred.

To create a service principal in Azure, refer to the following topics in the Azure
Documentation:

« Create an Azure service principal with the Azure CLI

» Create an Azure service principal with Azure PowerShell

« Create an Azure service principal with Azure Portal

GigaVUE-FM must be able to access the URLs listed in the Allow the Azure portal
URLs on your firewall or proxy server in order to connect to Azure.
Following are the required endpoints for Azure GovCloud:

» authentication_endpoint = https://login.microsoftonline.us/
» azure_endpoint = https://management.usgovcloudapi.net/

After creating service principal in Azure, you can add custom roles. Refer to Assign a Custom
Role using CLI or Assign a Custom Role using Azure Portal for detailed information on how
to assign roles.

The key fields required for GigaVUE-FM to connect to Azure are Subscription ID, Tenant ID,
Application ID, and Application Secret.

* When creating the service principal using the Azure CLI, the output of that command will
display the "appld" and "password" fields. These two are the Application ID and
Application Secret fields that are required for GigaVUE-FM to connect to Azure. Copy
them.

* Now, using the Azure CLI again, do an ‘account show’' command and copy the
Subscription ID and the Tenant ID of your subscription.

The Subscription ID, Tenant ID, Application ID, and Application Secret will be used when
creating credentials in GigaVUE-FM. Refer to Create Azure Credentials for step-by-step
instructions.

DISCLAIMER: These are general guidelines for enabling a deployment in Azure. Since the
Azure interface is subject to change and is outside Gigamon'’s purview, please see Azure
documentation for instructions on using Azure.

Get Started with GigaVUE Cloud Suite for Azure 79
Permissions and Privileges



https://docs.microsoft.com/en-us/cli/azure/create-an-azure-service-principal-azure-cli
https://docs.microsoft.com/en-us/powershell/azure/azurerm/create-azure-service-principal-azureps?view=azurermps-6.13.0
https://docs.microsoft.com/en-us/azure/purview/create-service-principal-azure
https://docs.microsoft.com/en-us/azure/azure-portal/azure-portal-safelist-urls?tabs=public-cloud
https://docs.microsoft.com/en-us/azure/azure-portal/azure-portal-safelist-urls?tabs=public-cloud

GigaVUE Cloud Suite for Azure - Deployment Guide

Deployment Options for
GigaVUE Cloud Suite for Azure

This section provides a detailed information on the multiple ways in which GigaVUE Cloud
Suite for Azure can be configured to provide visibility for physical and virtual traffic. There are
three different ways in which GigaVUE Cloud Suite for Azure can be configured based on the
traffic acquisition method and the method in which you want to deploy fabric components.
Refer to the Before You Begin section for prerequisites that are required to be configured.
For more detailed information and the work flow refer the following topics:

¢ Deploy GigaVUE Fabric Components using Azure

e Deploy GigaVUE Fabric Components using GigaVUE-FM
e Traffic Acquisition Method as UCT-V
e Traffic Acquisition Method as Customer Orchestrated Source

Deploy GigaVUE Fabric Components using Azure

GigaVUE-FM allows you to use Azure as an orchestrator to deploy GigaVUE fabric
components and then use GigaVUE-FM to configure the advanced features supported by
these nodes. Refer the following table for the step-by-step instructions.

Step No | Task Refer the following topics
1 Obtain GigaVUE-FM Image Obtain GigaVUE-FM Image
2 Install GigaVUE-FM on Azure Install GigaVUE-FM on Azure
3 Check and provide permissions and privileges Permissions and Privileges
4 Install UCT-V For Linux: Linux UCT-V Installation
NoTeE: When using Azure as your orchestration For nglows: Windows UCT-V
Installation
system you can only use UCT-V.
5 Create Azure Credentials to monitor workloads across Create Azure Credentials
multiple Azure subscriptions
6 Create a Monitoring Domain Create Monitoring Domain
NoTE: Ensure that the Use FM to Launch Fabric
toggle button is disabled.
7 Configure Role-Based Access for Third Party Configure Role-Based Access for Third
Orchestration in GigaVUE-FM Party Orchestration
8 Configure GigaVUE Fabric Components Configure GigaVUE Fabric
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Step No | Task Refer the following topics
NoTE: Select UCT-V as the Traffic Acquisition Method. f/lcz)rgsonents In Azure - Integrated
9 Create Monitoring session Configure Monitoring Session
10 Add Applications to the Monitoring Session Add Applications to Monitoring
Session
n Deploy Monitoring Session Deploy Monitoring Session
12 View Monitoring Session Statistics View Monitoring Session Statistics

Deploy GigaVUE Fabric Components using
GigaVUE-FM

You can deploy GigaVUE fabric components using GigaVUE-FM using one of the following

two traffic acquisition methods:
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Traffic Acquisition Method as UCT-V

Follow instruction in the below table, if you wish to use UCT-V as your traffic acquisition

method. When using UCT-V the traffic from the Virtual Machines are acquired using the

UCT-V and it is sent to the GigaVUE V Series Nodes.

Step No | Task Refer the following topics
1 Obtain GigaVUE-FM Image Obtain GigaVUE-FM Image
2 Install GigaVUE-FM on Azure Install GigaVUE-FM on Azure
3 Check and provide permissions and privileges Permissions and Privileges
4 Install UCT-V For Linux: Linux UCT-V Installation
For Windows: Windows UCT-V
Installation
5 Create Azure Credentials to monitor workloads across Create Azure Credentials
multiple Azure subscriptions
6 Create a Monitoring Domain Create Monitoring Domain
NoTE: Ensure that the Use FM to Launch Fabric
toggle button is enabled.
7 Configure GigaVUE Fabric Components Configure GigaVUE Fabric
] T Components in GigaVUE-FM
NoTE: Select UCT-V as the Traffic Acquisition Method.
Create Monitoring session Configure Monitoring Session
Add Applications to the Monitoring Session Add Applications to Monitoring
Session
10 Deploy Monitoring Session Deploy Monitoring Session
n View Monitoring Session Statistics View Monitoring Session Statistics
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Traffic Acquisition Method as Customer Orchestrated Source

Follow instruction in the below table if you wish to use Customer Orchestrated Source as

your traffic acquisition method. In this case you can use tunnels as a source where the traffic
is directly tunneled to V Series nodes without deploying UCT-V or UCT-V controllers.

Step No | Task Refer the following topics
1 Obtain GigaVUE-FM Image Obtain GigaVUE-FM Image
2 Install GigaVUE-FM on Azure Install GigaVUE-FM on Azure
3 Check and provide permissions and privileges Permissions and Privileges
2 Create a Monitoring Domain Create Monitoring Domain
NoTE: Ensure that the Use FM to Launch Fabric
toggle button is enabled.
3 Configure GigaVUE Fabric Components Configure GigaVUE Fabric
Components in GigaVUE-FM
NoOTE: Select Customer Orchestrated Source as the
Traffic Acquisition Method.
4 Create Monitoring session Configure Monitoring Session
Create Ingress and Egress Tunnel Endpoints Create Ingress and Egress Tunnels
6 Add Applications to the Monitoring Session Add Applications to Monitoring
Session
Deploy Monitoring Session Deploy Monitoring Session
View Monitoring Session Statistics View Monitoring Session Statistics
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Deploy GigaVUE Cloud Suite for
Azure

This chapter describes how to connect, launch, and deploy the fabric components of
GigaVUE Cloud Suite for Azure.

Refer to the following topics for details:

Create Azure Credentials

Install UCT-V to Monitor Traffic

Install Custom Certificate

Adding Certificate Authority

Create Monitoring Domain

Configure GigaVUE Fabric Components in GigaVUE-FM
Configure Role-Based Access for Third Party Orchestration
Disable GigaVUE-FM Orchestration in Monitoring Domain
Upgrade GigaVUE Fabric Components in GigaVUE-FM for Azure

Refer Deploying GigaVUE Cloud Suite for Azure using V Series with Hybrid architecture for
more detailed information.
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Create Azure Credentials

You can monitor workloads across multiple Azure subscriptions within one monitoring
domain. All the deployed GigaVUE fabric components are shared among many Azure
subscriptions to reduce the cost since each Azure subscription used to have a set of
GigaVUE fabric components.

» After launching GigaVUE-FM in Azure, the Managed Identity authentication
credential is automatically added to the Azure Credential page as the default
credential.

* You can only add the Application ID with Client Secret authentication credentials
to the Azure Credential page.

To create Azure credentials:

1. Go to Inventory > VIRTUAL > Azure, and then click Settings > Credential. The Azure
Credential page appears.

2. Inthe Azure Credential page, click Add. The Configure Credentialwizard appears.

Ll Configure Credential Save Cancel
%l Name* Credential Name

Authentication Type Application ID with Client Secret
=

Tenant ID* Tenant ID

Application ID* Application ID

Application Secret* Application Secret

Azure Environment | Azure Enviroment. |

AZURE_US_GOVERNMENT

Deploy GigaVUE Cloud Suite for Azure
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3. Enter or select the appropriate information for the Azure credential as described in the

following table.

Field Description

Name An alias used to identify the Azure credential.
Authentication Application ID with Client Secret: Connection with Azure with a service principal.
Type Enter the values for the following fields.
o Tenant ID—a unique identifier of the Microsoft Entra ID instance.
o Application ID—a unique identifier of an application in Azure platform.
o Application Secret—a password or key to request tokens.
Refer to Application ID with client secret for more detailed information on how to
create service principal and assign custom roles.
Azure Select an Azure environment where your workloads are located. For example,
Environment Azure_US_Government.

4. Click Save. You can view the list of available credentials in the Azure Credential page.
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Install UCT-V to Monitor Traffic

A UCT-V is the primary Gigamon monitoring module that is installed in your Virtual
Machines (VMs). This agent mirrors the selected traffic from the VMs, encapsulates it using
VXLAN tunneling, and forwards it to the GigaVUE Cloud Suite® V Series node.

NoTE: The UCT-V installation is applicable only when the UCT-V is your traffic
acquisition method.

A UCT-V consists of a source interface and a destination interface. The network packets
collected from the source interface are sent to the destination interface. From the
destination interface, the packets traverse through VXLAN tunnel interface to the GigaVUE V
Series node.

A source interface can be configured with one or more Network Interface Cards (NICs).
While configuring a source interface, you can specify the direction of the traffic to be
monitored in the VM. The direction of the traffic can be egress, ingress, or both.

Refer to the following sections for more information:

e Linux UCT-V Installation
 Windows Agent Installation
¢ Create Images with the Agent Installed
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Supported Operating Systems for UCT-V
Supported Operating System for UCT-V! is v6.4.00, 6.5.00, 6.6.00

Supported Operating Systems for G-vTAP Agents are v1.8-3, v1.8-4, v1.8-5, v1.8-7, v6.1.00, v6.2.00,

v6.3.00

The below table lists the validated and the supported versions of the Operating Systems for UCT-V.

Operating System

Supported Versions

Validated Versions

Ubuntu/Debian

Versions 18-04 and above are

Versions 16.04 and 20.04

supported.
CentOS Versions 7.5 and above. Versions 7.9 and 8.2
Fedora Versions 7.5 and above. Versions 7.5
RHEL Versions 7.5 and above. Versions 8.8 and 9.2

Windows Server

Versions 2012 through 2022

Versions 2022

Windows Client

Versions 10 and 11

Versions 10 and 11

Amazon Linux

Versions 1and 2 (For version 2, package
iproute-tc must be installed first)

NA

Rocky OS

Versions 8.4 and above

Versions 8.5 and 8.8

GigaVUE-FM version 6.6 supports UCT-V version 6.6 as well as (n-2) versions. It is always

recommended to use the latest version of UCT-V with GigaVUE-FM, for better compatibility.

TFrom Software version 6.4.00, G-VTAP Agent is renamed to UCT-V.
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Linux UCT-V Installation

Refer to the following sections for the Linux agent installation:

¢ Single NIC Configuration
» Dual NIC Configuration
e Install UCT-V

Single NIC Configuration

A single NIC/VNIC acts both as the source and the destination interface. A UCT-V with a
single NIC/VNIC configuration lets you monitor the ingress or egress traffic from the
NIC/VNIC. The monitored traffic is sent out using the same NIC/vNIC.

For example, assume that there is only one interface ethO in the monitoring VM. In the UCT-
V configuration, you can configure ethO as the source and the destination interface, and
specify both egress and ingress traffic to be selected for monitoring purpose. The egress and
ingress traffic from ethO is mirrored and sent out using the same interface.

NoTE: Using a single NIC/VNIC as the source and the destination interface may cause
increased latency in sending the traffic out from the VM.

Example of the UCT-V config file for a single NIC/VNIC configuration:

Grant permission to monitor ingress and egress traffic at iface

# ethoO mirror-src-ingress mirror-src-egress mirror-dst

Dual NIC Configuration

A UCT-V lets you configure two NICs/VNICs. One NIC/VNIC can be configured as the source
interface and another NIC/VNIC can be configured as the destination interface.

For example, assume that there is ethO and ethl in the monitoring VM. In the UCT-V
configuration, ethO can be configured as the source interface and egress traffic can be
selected for monitoring purpose. The ethl interface can be configured as the destination
interface. So, the mirrored traffic from ethO is sent to ethl. From ethl, the traffic is sent to the
GigaVUE V Series Node.

Example of the UCT-V config file for a dual NIC/vNIC configuration:

Grant permission to monitor ingress and egress traffic at iface

# 'eth0' to monitor and 'ethl' to transmit the mirrored packets.
# eth0 mirror-src-ingress mirror-src-egress
# ethl mirror-dst

Deploy GigaVUE Cloud Suite for Azure 89
Install UCT-V to Monitor Traffic



GigaVUE Cloud Suite for Azure - Deployment Guide

Install UCT-V

You must have sudo/root access to edit the UCT-V configuration file.

For dual or multiple NIC/ENI configuration, you may need to modify the network
configuration files to make sure that the extra NIC/ENI will initialize at boot time.

NoTE: Before installing UCT-V .deb or .rpm packages on your Linux VMs, you must
install packages like Python3 and Python modules (netifaces, urllib3, and requests).

You can install the UCT-Vs either from Debian or RPM packages.

Refer to the following topics for details:

 Install UCT-V from Ubuntu/Debian Package
e Install UCT-V from RPM package
e |nstall UCT-V from Red Hat Enterprise Linux and CentOS with Selinux Enabled

Install UCT-V from Ubuntu/Debian Package

To install from a Debian package:
1. Download the UCT-V 6.6.00 Debian (.deb) package from the Gigamon Customer
Portal. For assistance contact Contact Technical Support.

2. Copy this package to your instance. Install the package with root privileges, for
example:

$ ls gigamon-gigavue uctv_6.6.00_amd64.deb
$ sudo dpkg -i gigamon-gigavue uctv_6.6.00_amd64.deb
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3. Once the UCT-V package is installed, modify the file /fetc/uctv/uctv.conf to configure

and register the source and destination interfaces. The following examples registers

ethO as the mirror source for both ingress and egress traffic and ethl as the destination

for this traffic:

NoOTE: Any changes to the UCT-V config file made after the initial setup require
an UCT-V restart and an inventory refresh or sync from GigaVUE-FM to pick up
the new changes and re-initiate the traffic mirroring. When you have an active,
successful monitoring session deployed, modifying the UCT-V config file results
in traffic loss until GigaVUE-FM does a periodic sync on its own every 15 minutes.

Example 1—Configuration example to monitor ingress and egress traffic at interface
ethO and use the same interface to send out the mirrored packets

# ethoO mirror-src-ingress mirror-src-egress mirror-dst

Example 2—Configuration example to monitor ingress and egress traffic at interface
ethO and use the interface ethl to send out the mirrored packets

# ethoO mirror-src-ingress mirror-src-egress

# ethl mirror-dst

Example 3—Configuration example to monitor ingress and egress traffic at interface
ethO and eth 1; use the interface ethl to send out the mirrored packets

# ethoO mirror-src-ingress mirror-src-egress
# ethl mirror-src-ingress mirror-src-egress mirror-dst

. Save thefile.

. To enable the third-party orchestration, a configuration file /fetc/gigamon-cloud.conf
needs to be created with the following contents:

Registration:

groupName: <Monitoring Domain Name>

subGroupName: <Connection Name>

user: <Username>

password: <Password>

remoteIP: <IP address of the UCT-V Controller 1>,
<IP address of the UCT-V Controller 2>

remotePort: 8891

E » User and Password must be configured in the User Management page.
Refer to Configure Role-Based Access for Third Party Orchestration for more
detailed information. Enter the UserName and Password created in the Add
Users Section.

6. Reboot the instance.
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The UCT-V status will be displayed as running. Check the status using the following
command:
$ sudo /etc/init.d/uctv status

UCT-V is running

Install UCT-V from RPM package
To install from an RPM (rpm) package on a Redhat, CentOS, or other RPM-based system:

1. Download the UCT-V 6.6.00 RPM (.rom) package from the Gigamon Customer Portal.
For assistance contact Contact Technical Support.
2. Copy this package to your instance. Install the package with root privileges, for
example:
$ ls gigamon-gigavue uctv_6.6.00_x86 64.rpm
$ sudo rpm -i gigamon-gigavue uctv_6.6.00_x86_ 64.rpm
3. Modify the file /etc/uctv/uctv.conf to configure and register the source and
destination interfaces.The following example registers the ethO as the mirror source for
both ingress and egress traffic and registers ethl as the destination for this traffic as
follows:

NoTE: Any changes to the UCT-V config file made after the initial setup require
an agent restart and an inventory refresh or sync from GigaVUE-FM to pick up
the new changes and re-initiate the traffic mirroring. When you have an active,
successful monitoring session deployed, modifying the UCT-V config file results
in traffic loss until GigaVUE-FM does a periodic sync on its own every 15 minutes.

Example 1—Configuration example to monitor ingress and egress traffic at interface
ethO and use the same interface to send out the mirrored packets

# ethoO mirror-src-ingress mirror-src-egress mirror-dst

Example 2—Configuration example to monitor ingress and egress traffic at interface
ethO and use the interface ethl to send out the mirrored packets

# ethoO mirror-src-ingress mirror-src-egress

# ethl mirror-dst

Example 3—Configuration example to monitor ingress and egress traffic at interface
ethO and eth 1; use the interface ethl to send out the mirrored packets

# ethoO mirror-src-ingress mirror-src-egress
# ethl mirror-src-ingress mirror-src-egress mirror-dst

4. Save the file.
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5. To enable the third-party orchestration, a configuration file /fetc/gigamon-cloud.conf

e.

needs to be created with the following contents:

Registration:

groupName: <Monitoring Domain Name>

subGroupName: <Connection Name>

user: <Username>

password: <Password>

remoteIP: <IP address of the UCT-V Controller 1>,
<IP address of the UCT-V Controller 2>

remotePort: 8891

E » User and Password must be configured in the User Management page.
Refer to Configure Role-Based Access for Third Party Orchestration for more
detailed information. Enter the UserName and Password created in the Add
Users Section.

Reboot the instance.

Check the status with the following command:

$ sudo service uctv status

UCT-V is running

Install UCT-V from Red Hat Enterprise Linux and CentOS with Selinux Enabled

Prerequisite:

You must ensure that port 9901 is allowed in the Firewall. This port is required for the
communication between UCT-V and UCT-V Controller.

To install, follow these steps:

1.

Launch the RHEL/CentOS agent AMI image.

2. Download the following packages from the Gigamon Customer Portal. For assistance
contact Contact Technical Support.
e gigamon-gigavue_uctv_6.6.00_Xx86_64.rpm
3. Copy the downloaded UCT-V package files and strongSwan TAR file to UCT-V.
4. Install UCT-V package:
sudo rpm -ivh gigamon-gigavue uctv_6.6.00_x86 64.rpm
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5. Edit uctv.conf file to configure the required interface as source/destination for mirror:

NOTE: Any changes to the UCT-V config file made after the initial setup require
an UCT-V restart and an inventory refresh or sync from GigaVUE-FM to pick up
the new changes and re-initiate the traffic mirroring. When you have an active,
successful monitoring session deployed, modifying the UCT-V config file results
in traffic loss until GigaVUE-FM does a periodic sync on its own every 15 minutes.

# ethO mirror-src-ingress mirror-src-egress mirror-dst
# sudo /etc/init.d/uctv restart

6. Reboot the instance.
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Windows UCT-V Installation

Windows UCT-V allows you to select the network interfaces by subnet/CIDR and modify the
corresponding monitoring permissions in the configuration file. This gives you more
granular control over what traffic is monitored and mirrored.

VXLAN is the only supported tunnel type for Windows UCT-V.
Windows UCT-V Installation Using MSI Package

To install the Windows UCT-V using the MSI file:

1. Download the Windows UCT-V 6.6.00 MSI| package from the Gigamon Customer
Portal. For assistance contact Contact Technical Support.

2. Install the downloaded MSI package as Administratorand the UCT-V service starts
automatically.
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3. Once the UCT-V package is installed, modify the file C:\ProgrambData\uctv\gigamon-
cloud.conf to configure and register the source and destination interfaces.

NoTE: Any changes to the UCT-V config file made after the initial setup require
an UCT-V restart and an inventory refresh or sync from GigaVUE-FM to pick up
the new changes and re-initiate the traffic mirroring. When you have an active,
successful monitoring session deployed, modifying the UCT-V config file results
in traffic loss until GigaVUE-FM does a periodic sync on its own every 15 minutes.

E Following are the rules to modify the UCT-V configuration file:
» Interface is selected by matching its CIDR address with config entries.
* For the VMs with single interface (.conf file modification is optional):

° if neither mirror-src permissions is granted to the interface, both mirror-
src-ingress and mirror-src-egress are granted to it.

° mirror-dst is always granted implicitly to the interface.

e For the VMs with multiple interfaces:

° mirror-dst needs to be granted explicitly in the config file. Only the first
matched interface is selected for mirror-dst, all other matched interfaces
are ignored.

° if none interfaces is granted any mirror-src permission, all interfaces will
be granted mirror-src-ingress and mirror-src-egress.

Example 1—Configuration example to monitor ingress and egress traffic at interface
192.168.1.0/24 and use the same interface to send out the mirrored packets.

192.168.1.0/24 mirror-src-ingress mirror-src-egress mirror-dst

Example 2—Configuration example to monitor ingress and egress traffic at interface
192.168.1.0/24 and use the interface 192.168.2.0/24 to send out the mirrored packets.

192.168.1.0/24 mirror-src-ingress mirror-src-egress
192.168.2.0/24 mirror-dst
4. Save thefile.
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5. If you wish to deploy UCT-V using third party orchestration, a configuration file
C:\ProgramData\uctv\gigamon-cloud.conf must be created with the following
contents:

Registration:

groupName: <Monitoring Domain Name>

subGroupName: <Connection Name>

user: <username>

password: <password>

remoteIP: <IP address of the UCT-V Controller 1>,
<IP address of the UCT-V Controller 2>

remotePort: 8891

E » When creating C:\ProgramData\uctv\gigamon-cloud.conf file, ensure that
the file name extension is .conf. To view the file name extension in Windows,
follow the steps given below:

a. Goto File Explorer and open the File Location.
b. On the top navigation bar, click View.
c. In the View tab, enable the File name extensions check box.

» User and Password must be configured in the User Management page.
Refer to Configure Role-Based Access for Third Party Orchestration for more
detailed information. Enter the UserName and Password created in the Add
Users Section.

6. Torestart the Windows UCT-V, perform one of the following actions:
e Restart the VM.
e Run 'sc stop uctv' and 'sc start uctv' from the command prompt.
e Restart the UCT-V from the Windows Task Manager.

You can check the status of the UCT-V in the Service tab of the Windows Task Manager.
Windows UCT-V Installation Using ZIP Package

To install the Windows UCT-V using the ZIP package:
1. Download the Windows UCT-V 6.6.00 ZIP package from the Gigamon Customer
Portal. For assistance contact Contact Technical Support.
2. Extract the contents of the .zip file into a convenient location.
3. Run ‘install.bat’ as an Administratorand the UCT-V service starts automatically.
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4. Once the UCT-V package is installed, modify the file C:\ProgrambData\Uct-v\uctv.conf
to configure and register the source and destination interfaces.

NoTE: Any changes to the UCT-V config file made after the initial setup require
an UCT-V restart and an inventory refresh or sync from GigaVUE-FM to pick up
the new changes and re-initiate the traffic mirroring. When you have an active,
successful monitoring session deployed, modifying the UCT-V config file results
in traffic loss until GigaVUE-FM does a periodic sync on its own every 15 minutes.

E Following are the rules to modify the UCT-V configuration file:
» Interface is selected by matching its CIDR address with config entries.
* For the VMs with single interface (.conf file modification is optional):

° if neither mirror-src permissions is granted to the interface, both mirror-
src-ingress and mirror-src-egress are granted to it.

° mirror-dst is always granted implicitly to the interface.

e For the VMs with multiple interfaces:

° mirror-dst needs to be granted explicitly in the config file. Only the first
matched interface is selected for mirror-dst, all other matched interfaces
are ignored.

° if none interfaces is granted any mirror-src permission, all interfaces will
be granted mirror-src-ingress and mirror-src-egress.

Example 1—Configuration example to monitor ingress and egress traffic at interface
192.168.1.0/24 and use the same interface to send out the mirrored packets.

192.168.1.0/24 mirror-src-ingress mirror-src-egress mirror-dst

Example 2—Configuration example to monitor ingress and egress traffic at interface
192.168.1.0/24 and use the interface 192.168.2.0/24 to send out the mirrored packets.

192.168.1.0/24 mirror-src-ingress mirror-src-egress
192.168.2.0/24 mirror-dst
5. Save the file.
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6. If you wish to deploy UCT-V using third party orchestration, a configuration file
C:\ProgramData\uctv\gigamon-cloud.conf must be created with the following
contents:

Registration:

groupName: <Monitoring Domain Name>

subGroupName: <Connection Name>

user: <username>

password: <password>

remoteIP: <IP address of UCT-V Controller 1, IP address of UCT-V
Controller 2>

remotePort: 8891

E » When creating C:\ProgramData\uctv\gigamon-cloud.conf file, ensure that
the file name extension is .conf. To view the file name extension in Windows,
follow the steps given below:

a. Goto File Explorer and open the File Location.
b. On the top navigation bar, click View.
c. In the View tab, enable the File name extensions check box.

» User and Password must be configured in the User Management page.
Refer to Configure Role-Based Access for Third Party Orchestration for more
detailed information. Enter the UserName and Password created in the Add
Users Section.

7. To restart the Windows UCT-V, perform one of the following actions:
e Restart the VM.
e Run 'sc stop uctv' and 'sc start uctv' from the command prompt.
e Restart the UCT-V from the Windows Task Manager.

You can check the status of the UCT-V in the Service tab of the Windows Task Manager.

NOTE: You must edit the Windows Firewall settings to grant access to the uctv
process. To do this, access the Windows Firewall settings and find “uctvd” in the list of
apps and features. Select it to grant access. Be sure to select both Private and Public
check boxes. If “uctvd” does not appear in the list, click Add another app... Browse
your program files for the uctv application (uctvd.exe) and then click Add.
(Disclaimer: These are general guidelines for changing Windows Firewall settings.
See Microsoft Windows help for official instructions on Windows functionality.)
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Create Images with the Agent Installed

If you want to avoid downloading and installing the UCT-Vs every time there is a new VM to
be monitored, you can save the UCT-V running on a VM as a private image. When a new VM
is launched that contains the UCT-V, GigaVUE-FM automatically detects the new VM and
updates the number of monitoring VMs in the monitoring session.

To save the UCT-V as an image, refer to Capture VM to managed image topic in the
Microsoft Azure Documentation.
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Uninstall UCT-V

This section describes how to uninstall UCT-V for Windows UCT-V and Linux UCT-V
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Uninstall Linux UCT-V

The following steps provide instructions on how to uninstall Linux UCT-V
Stop the UCT-V service using the following commands:

For Ubuntu/Debian Package:

sudo service uctv stop

For RPM package or Red Hat Enterprise Linux and CentOS with Selinux Enabled:

sudo systemctl stop uctv
Uninstall the UCT-V using the following:

For Ubuntu/Debian Package:
sudo dpkg -r uctv

For RPM package:

sudo rpm -e uctv

For Red Hat Enterprise Linux and CentOS with Selinux Enabled:

sudo rpm -e uctv
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Uninstall Windows UCT-V

To uninstall Windows UCT-V:

1. On your windows, go to Task Manager > Services. Search for uctv.
2. Right click uctv and select Stop.
3. Go to Control Panel search for uctv and uninstall.

Deploy GigaVUE Cloud Suite for Azure 103
Uninstall UCT-V



GigaVUE Cloud Suite for Azure - Deployment Guide

Upgrade UCT-V

To upgrade UCT-V, delete the existing UCT-V and installing the new version of UCT-V.

» Before upgrading UCT-V, ensure that the UCT-V is in the ON state on the UCT-V
page.

» Before deleting the UCT-V, take a back up copy of /etc/uctv/uctv.conf
configuration file. Follow this step to avoid reconfiguring the source and
destination interfaces.

1. Uninstall the existing UCT-V. Refer to Uninstall UCT-V for more detailed information on
how to uninstall UCT-V.

2. Install the latest version or the new UCT-V. Refer to the following topics for more
detailed information on how to install a new UCT-V:

e Linux UCT-V Installation
e Windows UCT-V Installation
3. Restart the UCT-V service.

e Linux platform:
$ sudo service uctv restart

» Windows platform: Restart from the Task Manager.
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Install Custom Certificate

GigaVUE V Series Node, GigaVUE V Series Proxy, and UCT-V Controllers have default self-
signed certificates installed. The communication between GigaVUE-FM and the fabric
components happens in a secure way using these default self-signed certificates, however
you can also add custom certificates like SSL/TLS certificate to avoid the trust issues that
occurs when the GigaVUE V Series Nodes, GigaVUE V Series Proxy, or UCT-V Controllers run
through the security scanners.

You can upload the custom certificate in two ways:

» Upload Custom Certificates using GigaVUE-FM
» Upload Custom Certificate using Third Party Orchestration
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Upload Custom Certificates using GigaVUE-FM

To upload the custom certificate using GigaVUE-FM follow the steps given below:
1. Go to Inventory > Security > Custom SSL Certificate. The Custom Certificate
Configuration page appears.

2. On the Custom Certificate Configuration page, click Add. The New Custom Certificate
page appears.

3. Enter or select the appropriate information as shown in the following table.

Field Action

Certificate Name | Enter the custom certificate name.

Certificate Click on the Upload Button to upload the certificate.

Private Key Click on the Upload Button to upload the private key associated with the certificate.
4. Click Save.

You must also add root or the leaf CA certificate in the Trust Store. For more detailed
information on how to add root CA Certificate, refer to Trust Store topic in GigaVUE
Administration Guide.

The certificates uploaded here can be linked to the respective GigaVUE V Series Node,
GigaVUE V Series Proxy, and UCT-V Controller in the Fabric Launch Configuration Page.
Refer to Configure GigaVUE Fabric Components in GigaVUE-FM topic in the respective
cloud guides for more detailed information.
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Upload Custom Certificate using Third Party Orchestration

You can also upload custom certificates to GigaVUE V Series Nodes, GigaVUE V Series Proxy,
and UCT-V Controller using your own cloud platform at the time of deploying the fabric
components. Refer to the following topics on more detailed information on how to upload
custom certificates using third party orchestration in the respective platforms:

For integrated mode:

» Configure GigaVUE Fabric Components in AWS
» Configure GigaVUE Fabric Components in Azure - Integrated Mode
» Configure GigaVUE Fabric Components in OpenStack

For generic mode:

» Configure GigaVUE Fabric Components in AWS

e Configure GigaVUE Fabric Components in Azure

e Configure GigaVUE Fabric Components in GCP

e Configure GigaVUE Fabric Components in Nutanix

e Configure GigaVUE Fabric Components in OpenStack
e Configure GigaVUE V Series Nodes using VMware ESXi
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Adding Certificate Authority

This section describes how to add Certificate Authority in GigaVUE-FM.

CA List

The Certificate Authority (CA) List page allows you to add the root CA for the devices.

To upload the CA using GigaVUE-FM follow the steps given below:

—

appears.

Go to Inventory > Resources > Security > CA List.
2. Click Add, to add a new Custom Authority. The Add Certificate Authority page

3. Enter or select the following information.

Field Action

Alias Alias name of the CA.
File Upload Choose the certificate from the desired location.
4. Click Save.
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Create Monitoring Domain

You must establish a connection between GigaVUE-FM and your Azure environment before
you can perform the configuration steps. Creating a monitoring domain in GigaVUE-FM
allows you to establish a connection between your Azure environment and GigaVUE-FM.
After establishing a connection, you will be able to use GigaVUE-FM to specify a launch
configuration for the UCT-V Controllers, GigaVUE V Series Proxy, and GigaVUE V Series
Nodes in the specified VNet and Resource Groups. GigaVUE-FM connects to Azure using
either an Application ID with the client secret or the MSI method of authentication. After the
connection establishment, GigaVUE-FM launches the UCT-V Controller, GigaVUE V Series
Proxy, and GigaVUE V Series 2 Node.

To create an Azure monitoring domain in GigaVUE-FM:

1. Go to Inventory > VIRTUAL > Azure, and then click Monitoring Domain. The
Monitoring Domain page appears.

2. In the Monitoring Domain page, click New. The Azure Monitoring Domain
Configuration wizard appears.
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Monitoring Domain Configuration

Monitoring Domain* Enter a monitoring domain name
Use V Series 2 @ Yes
Traffic Acquisition ey
Method* i
Traffic Acquisition 1450
Tunnel MTU*
Use FM to Launch
Yes
Fabric © ©
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3. Enter or select the appropriate information for the monitoring domain as described in
the following table.

Field Description

Monitoring An alias used to identify the monitoring domain.
Domain

Traffic Select a Tapping method. The available options are:
Acquisition

= UCT-V: If you select UCT-V as the tapping method, the traffic is acquired from
the UCT-Vs installed on your standard VMs in the Resource Group or in the
Scale Sets. Then the acquired traffic is forwarded to the GigaVUE V Series
nodes. You must configure the UCT-V Controller to monitor the UCT-Vs.

Method

= Customer Orchestrated Source: If you use select Customer Orchestrated
Source as the tapping method, you can select the tunnel as a source where
the traffic is directly tunneled to GigaVUE V Series nodes without deploying
UCT-Vs or UCT-V Controllers.

NOTE: Select the Traffic Acquisition Method as Customer Orchestrated Source
if you wish to use Observability Gateway (AMX) application.

Traffic The Maximum Transmission Unit (MTU) is the maximum size of each packet that the
Acquisition tunnel endpoint can carry from the UCT-V to the GigaVUE V Series node.

Tunnel MTU The default value is 1450.

When using IPv4 tunnels, the maximum MTU value is 1450. The UCT-V tunnel MTU
should be 50 bytes less than the UCT-V destination interface MTU size.

When using IPv6 tunnels, the maximum MTU value is 1430. The UCT-V tunnel MTU
should be 70 bytes less than the UCT-V destination interface MTU size.

Use FM to Select Yes to Configure GigaVUE Fabric Components in GigaVUE-FM or select No to
Launch Fabric Configure GigaVUE Fabric Components in Azure.

Enable IPv6 Enable this option to create IPv6 tunnels between UCT-V and the GigaVUE V Series
Preference Nodes.

(This appears
only when Use
FM to Launch
Fabric is
disabled and
Traffic
Acquisition
Method is UCT-
V)

Connections
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Field Description

Connections
Name* Enter a connection name
Credential* Credential Name...
Subscription ID* Subscription ID...
Region* Region Name...
Resource Groups* Discovered (O Regex@®

Resource Groups...

L+

have Managed Service Identity as the Credential.

multiple Application ID with Client Secret (Service Principal) accounts.

o Each connection can have only one Subscription ID.

E « A Monitoring Domain can have multiple connections, however only one connection can

e The connections in a monitoring domain can be a combination of multiple Application
ID with Client Secret (Service Principal) accounts, or one Managed Service Identity and

Name An alias used to identify the connection.

refer to Create Azure Credentials.

Credential Select an Azure credential. For detailed information on how to create credentials,

Subscription ID | A unique alphanumeric string that identifies your Azure subscription.

Region Azure region for the monitoring domain. For example, West India.
Resource Select the Resource Groups of the corresponding VMs to monitor.
Groups

Method.

NoTE: This field is only available if you select UCT-V as the Traffic Acquisition

4. Click Save and the Azure Fabric Launch Configuration wizard appears.

Node 1. You cannot perform any other actions on the existing configuration for
GigaVUE V Series Node 1 as the features are deprecated from GigaVUE-FM

NOTE: You can only view and delete the existing configuration for GigaVUE V Series
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Manage Monitoring Domain

You can view the details of the monitoring domain that are created in the list view. The list
view details can be viewed based on:

e Monitoring Domain
e Connections Domain
e Connections Domain
» UCT-Vs

You can also filter the monitoring domain based on a specified criterion. In the monitoring
domain page there are two filter options as follows:

« Right filter - Click the Filter button on the right to filter the monitoring domain based
on a specific criterion.

« Left filter - Click the = tofilter the monitoring domain based on the domain and
connections. You can click + to create a new monitoring domain. This filter once
applied also works even when the tabs are swapped.

To edit or delete a specific monitoring domain, select the monitoring domain, click the
ellipses ™.

When you click a monitoring domain, you can view details of it in a split view of the window.
In the split view window, you can view the details such as Configuration, Launch
Configuration and V Series configuration.

Monitoring Domain

The list view shows the following information in the monitoring domain page:
« Monitoring Domain
« Connections
« Tunnel MTU
« Acquisition Method
« Centralized connection
= Management Network

NoTE: Click the to select the columns that should appear in the list view.

Use the following buttons to manage your Monitoring Domain:
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Button Description

New Use to create new connection

Actions You can select a monitoring domain and then perform the following options:

« Edit Monitoring Domain- Select a monitoring domain and then click Edit
Monitoring domain to update the configuration.

« Delete Domain - You can select a monitoring domain or multiple monitoring
domains to delete them.

« Edit Fabric-You can select one fabric or multiple fabrics of the same
monitoring domain to edit a fabric. You cannot choose different fabrics of
multiple monitoring domains at the same time and edit their fabrics

« Deploy Fabric - -You can select a monitoring domain to deploy a fabric, you
cannot choose multiple monitoring domains at the same time to deploy
fabrics. This option is only enabled when there is No FABRIC (launch
configuration) for that specific monitoring domain and GigaVUE-FM
orchestration is enabled.. You must create a fabric in the monitoring domain, if
the option is disabled

. Upgrade Fabric-You can select a monitoring domain or multiple monitoring
domains to upgrade the fabric. You can upgrade the V Series nodes using this
option.

« Delete Fabric- You can delete all the fabrics associated with the monitoring
domain of the selected Fabric.

. Edit SSL Configuration - You can use this option to add Certificate Authority
and the SSL Keys.

Filter Filters the monitoring domain based on the list view options that are configured:
« Tunnel MTU

« Acquisition Method

« Centralised Connection

. Management Subnet

You can view the filters applied on the top of the monitoring domain page as a
button. You can remove the filters by closing the button.

Connections Domain
To view the connection related details for a monitoring domain, click the Connections tab.

The list view shows the following details:

« Connections

= Monitoring Domain
« Status

« Fabric Nodes

« User Name

« Region
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Fabric

To view the fabric related details for a monitoring domain, click the Fabric tab.

The list view shows the following details:

Connections

Monitoring Domain

Fabric Nodes

Type

Management |P

Version

Status - Click to view the upgrade status for a monitoring domain.
Security groups

UCT-Vs

To view all the UCT-Vs associated with the available monitoring domains click the UCT-Vs

tab.

The list view shows the following details:

Monitoring Domain
IP address
Registration time
Last hearbeat time
Agent mode
Status

Refer toConfigure Azure Settings, for more detailed information on Settings
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Configure GigaVUE Fabric Components in
GigaVUE-FM

After configuring the Monitoring Domain, you will be navigated to the Azure Fabric Launch
Configuration page.

In the same Azure Fabric Launch Configuration page, you can configure all the GigaVUE
fabric components.

Enter or select the required information as described in the following table.

Fields Description

Connections A connection that you created in the monitoring domain page. Refer to Create Monitoring
Domain for more information.

Centralized Alias of the centralized VNet in which the UCT-V Controllers, GigaVUE V Series Proxies,
Virtual Network and the GigaVUE V Series Nodes are launched.

Authentication Select SSH Public Key as the Authentication Type to connect with the Centralized VNet.
Type

SSH Public Key The SSH public key for the GigaVUE fabric components.

Resource Group The Resource Groups created in Azure for communication between the controllers, nodes,
and GigaVUE-FM.

Security Groups The security group created for the GigaVUE fabric components.

Enable Custom Enable this option to validate the custom certificate during SSL Communication.
Certificates GigaVUE-FM validates the Custom certificate with the trust store. If the certificate is not
available in Trust Store, communication does not happen, and an handshake error occurs.

NoTE: If the certificate expires after the successful deployment of the fabric
components, then the fabric components moves to failed state.

Certificate Select the custom certificate from the drop-down menu. You can also upload the custom
certificate for GigaVUE V Series Nodes, GigaVUE V Series Proxy, and UCT-V Controllers. For
more detailed information, refer to Install Custom Certificate.

Prefer IPv6 Enables IPv6 to deploy all the Fabric Components, and the tunnel between hypervisor to
GigaVUE V Series Node using IPv6 address. If the IPv6 address is unavailable, it uses an
IPv4 address.

NoOTE: This option can be enabled only when deploying a new GigaVUE V Series Node. If
you wish to enable this option after deploying the GigaVUE V Series Node, then you
must delete the existing GigaVUE V Series Node and deploy it again with this option
enabled.

Click Yes to configure V Series Proxy for the monitoring domain. Refer to Configure GigaVUE V Series Proxy
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E To deploy GigaVUE fabric images (GigaVUE V Series Nodes, UCT-V Controller, and
GigaVUE V Series Proxies) in GigaVUE-FM, you must accept the terms of the GigaVUE

fabric images from the Azure marketplace using the Azure CLI or PowerShell. Refer to
Prerequisites for more detailed information.

Refer to the following topics for details:

e Configure UCT-V Controllers
e Configure GigaVUE V Series Proxy
e Configure GigaVUE V Series Node
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Configure UCT-V Controller

A UCT-V Controller manages multiple UCT-Vs and orchestrates the flow of mirrored traffic to
GigaVUE V Series nodes.

NoTE: A single UCT-V Controller can manage up to 1000 UCT-Vs. The recommended
minimum instance type is Standard_Bls for UCT-V Controller.

A UCT-V Controller can only manage UCT-Vs that has the same version.

To configure the UCT-V Controllers:

NOTE: You cannot configure UCT-V Controller for Customer Orchestrated Source as
the traffic acquisition method.

In the Azure Fabric Launch Configuration page, Enter or select the appropriate values for
the UCT-V Controller as described in the following table.

Controller Version(s) Add
b 4
Image 1.8-6
Size Standard_B1...
Number of Instances 1
IP Address Type Private Public
Management Subnet
Subnet mgmt
Additional Subnets
Tags
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Fields Description

Controller The UCT-V Controller version you configure must always be the same as the UCT-Vs'
Version(s) version number deployed in the VM machines.

If there are multiple versions of UCT-Vs deployed in the VM machines, then you must

configure multiple versions of UCT-V Controllers that matches the version numbers of the
UCT-Vs.

NoOTE: If there is a version mismatch between UCT-V Controllers and UCT-Vs, GigaVUE-
FM cannot detect the agents in the instances.

To add UCT-V Controllers:
a. Under Controller Versions, click Add.

b. From the Image drop-down list, select a UCT-V Controller image that matches
with the version number of UCT-Vs installed in the instances.

c. From the Size drop-down list, select a size for the UCT-V Controller. The default
size is Standard_Bls.

d. In Number of Instances, specify the number of UCT-V Controllers to launch. The
minimum number you can specify is 1.

Management IP Address Type: Select one of the following IP address types:

Subnet = Select Private if you want to assign an IP address that is not reachable over

Internet. You can use private IP address for commmunication between the UCT-V
Controller instances and GigaVUE-FM instances in the same network.

= Select Public if you want the IP address to be assigned from Azure’s pool of public
IP address. The public IP address gets changed every time the instance is stopped

and restarted. On selecting Public IP address type, you must select all the required
Public IPs.

NoTe: Do not configure floating IPv4 for an IPv6-only management /data subnet.
Floating IPv4 is not applicable for IPv6-only subnet.

Subnet: Select a Subnet for UCT-V Controller. The subnet that is used for communication
between the UCT-V Controllers and the UCT-Vs, as well as to communicate with
GigaVUE-FM.

Every fabriccomponent (both controllers and the nodes) need a way to talk to each other
and GigaVUE-FM. So, they should share at least one management plane/subnet.

NOTE: Some instance types are supported in Azure platform. Refer to Microsoft Azure
documentation to learn on supported instance types.

Agent Tunnel The type of tunnel used for sending the traffic fromm UCT-Vs to GigaVUE V Series Nodes.
Type
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Fields Description

Agent Tunnel CA | The Certificate Authority (CA) that should be used in the UCT-V Controller for connecting

the tunnel.
Additional (Optional) If there are UCT-Vs on subnets that are not IP routable from the management
Subnet(s) subnet, additional subnets must be specified so that the UCT-V Controller can

communicate with all the UCT-Vs.

Click Add to specify additional data subnets, if needed. Also, make sure that you specify a
list of security groups for each additional subnet.

Tag(s) (Optional) The key name and value that helps to identify the UCT-V Controller instances in
your Azure environment. For example, you might have UCT-V Controllers deployed in
many regions. To distinguish these UCT-V Controllers based on the regions, you can
provide a name that is easy to identify such as us-west-2-uctv-controllers. To add a tag:

a. Click Add.
b. Inthe Key field, enter the key. For example, enter Name.

c. Inthe Value field, enter the key value. For example, us-west-2-uctv-controllers.
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Configure GigaVUE V Series Proxy

GigaVUE V Series Proxy can manage multiple GigaVUE V Series Nodes and orchestrates the
flow of traffic from GigaVUE V Series nodes to the monitoring tools. GigaVUE-FM uses one or
more GigaVUE V Series Proxies to communicate with the GigaVUE V Series nodes.

NoTE: A single GigaVUE V Series Proxy can manage up to 100 GigaVUE V Series
Nodes. The recommended minimum instance type is Standard_BIs for V Series Proxy.

To configure the GigaVUE V Series Proxy:

1. In the Azure Fabric Launch Configuration page, Select Yes to Configure a V Series
Proxy and the GigaVUE V Series Proxy fields appears.

2. Enter or select the appropriate values for the V Series Proxy. Refer to the UCT-V
Controller field descriptions for detailed information.
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Configure GigaVUE V Series Node

GigaVUE V Series node is a visibility node that aggregates mirrored traffic from multiple
UCT-Vs. It applies filters, manipulates the packets using GigaSMART applications, and
distributes the optimized traffic to cloud-based tools or backhaul to GigaVUE Cloud Suite for
Azure using the standard VXLAN tunnels.

To launch a GigaVUE V Series node:

In the Azure Fabric Launch Configuration page, enter or select the appropriate values for
the GigaVUE V Series Node.

Image
Size g
Disk Size (GB) >=30
IP Address Type Private Public
Management Subnet Subnet mgmt
Data Subnets
V Series Node
TOOI Subnet Tool Subnet o
Subnet 1 dataout
Security B w I m X
Groups
Tags
Fields Description
Image From the Image drop-down list, select a GigaVUE V Series Node image.
Size From the Size down-down list, select a size for the GigaVUE V Series Node. The default

size for GigaVUE V Series Node configuration is Standard_D4s_v4.

Disk Size (GB) The size of the storage disk. The default disk size is 30GB.

NoTe: When using Application Metadata Exporter, the minimum recommended Disk
Size is 80GB.

IP Address Type Select one of the following IP address types:
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Fields Description

= Select Private if you want to assign an IP address that is not reachable over
Internet. You can use private IP address for communication between the GigaVUE
V Series Node instances and GigaVUE-FM instances in the same network.

= Select Public if you want the IP address to be assigned from Azure's pool of public
IP address. On selecting Public IP address type, you must select the number of
Public IPs defined in the Maximum Instance.

NoTE: Do not configure floating IPv4 for an IPv6-only management /data subnet.
Floating IPv4 is not applicable for IPv6-only subnet.

Management Subnet: Select a management subnet for GigaVUE V Series. The subnet that is used for
Subnet communication between the UCT-Vs and the GigaVUE V Series Nodes, as well as to
communicate with GigaVUE-FM.

Every fabric component (both controllers and the nodes) need a way to talk to each other
and GigaVUE-FM. So, they should share at least one management plane/subnet.

Data Subnet(s) The subnet that receives the mirrored VXLAN tunnel traffic from the UCT-Vs.

Select a Subnet and the respective Security Groups. Click Add to add additional data
subnets.

NoTE: Using the Tool Subnet checkbox you can indicate the subnets to be used by
theGigaVUE V Series Node to egress the aggregated/manipulated traffic to the tools.

Tag(s) (Optional) The key name and value that helps to identify the GigaVUE V Series Node
instances in your Azure environment. For example, you might have GigaVUE V Series
Nodes deployed in many regions. To distinguish these GigaVUE V Series Nodes based on
the regions, you can provide a name that is easy to identify. To add a tag:

a. Click Add.
b. Inthe Key field, enter the key. For example, enter Name.

c. Inthe Value field, enter the key value.

Min Instances The minimum number of GigaVUE V Series Nodes to be launched in the Azure
connection.

The minimum number of instances that can be entered is 1.

NoTe: Nodes will be launched when a monitoring session is deployed if GigaVUE-FM
discovers some targets to monitor. The minimum amount will be launched at that time.
The GigaVUE-FM will delete the nodes if they are idle for over 15 minutes.

Max Instances The maximum number of GigaVUE V Series Nodes that can be launched in the Azure
connection. When the number of instances per V Series node exceeds the max instances
specified in this field, increase the number in the Max Instances to Launch. When
additional V Series nodes are launched, GigaVUE-FM re-balances the instances assigned
to the nodes. This can result in a brief interruption of traffic.

Click Save to complete the Azure Fabric Launch Configuration.
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A monitoring domain is created, and you can view the monitoring domain and fabric
component details by clicking on a monitoring domain name in theMonitoring Domain

page.
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Configure Role-Based Access for Third Party
Orchestration

Before deploying the fabric components using a third party orchestrator, we must create
users, roles and the respective user groups in GigaVUE-FM. The Username and the Password
provided in the User Management page will be used in the registration data that can be
used to deploy the fabric components in your orchestrator.

Refer to following topics for more detailed information on how to add users, create roles and
user groups:

e Users
* Role
e User Groups
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Users

You can also configure user's role and user groups to control the access privileges of the user
in GigaVUE-FM.

Add Users

This section provides the steps for adding users. You can add users only if you are a user with
fm_super_admin role or a user with either read/write access to the FM security
Management category.

To add users perform the following steps:

1.  On the left navigation pane, cIick and select Authentication > GigaVUE-FM User
Management > Users. The User page is displayed.

User Management User Groups Authentication

il .
L Al (@ Admin useris default and cannot be removed. New User Actions v Export W

SETTINGS
%» Username Name Email Roles Tags

Resources Member of Groups )
> System

Reports ® admin System Administrator fm_super_admin All = All All Super Admin Group

> Tasks
fm_user All: All All User Group
v Authenticat...

| cigavu.
Device ...
High Availa...

Tags

Figure1 FM Users Page

2. Click New User. In the Add User wizard that appears perform the following steps.
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Add User
@ All form elements are required unless indicated as optional. =

Name
Username
Password

Confirm password

Email

User Group

Figure 2 Create User

@ Your new password must contain:

«~ At least 8 characters and up to a maximumn of 64 characters in length

+ At least one numerical character
./ At least one uppercase character

« At least one lowercase character

~* At least one special character from JE#SHALS()+

a. Inthe Add User pop-up box, enter the following details:

o Name: Actual name of the user

o Username: User name configured in GigaVUE-FM

o Email: Email ID of the user

o Password/Confirm Password: Password for the user.

o User Group: User group

Cancel Ok

NoTE: GigaVUE-FM will prompt for your password.

b. Click Ok to save the configuration.

The new user is added to the summary list view.

The username and password created in this section will used in the registration data, used

for deploying the fabric components.
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Role

A user role defines permission for users to perform any task or operation in GigaVUE-FM or
on the managed device. You can associate a role with user.

Create Roles
This section describes the steps for creating roles and assigning user(s) to those roles.

GigaVUE-FM has the following default roles:

« fm_super_admin — Allows a user to do everything in GigaVUE-FM fabric manager,
including adding or modifying users and configuring all AAA settings in the RADIUS,
TACACS+, and LDAP tabs. Can change password for all users.

« fm_admin — Allows a user to do everything in GigaVUE-FM fabric manager except add
or modify users and change AAA settings. Can only change own password.

« fm_user — Allows a user to view everything in GigaVUE-FM fabric manager, including
AAA settings, but cannot make any changes.

NoTE: If you are a user with read-only access you will be restricted from
performing any configurations on the screen. The menus and action
buttons in the Ul pages will be disabled appropriately.

To create a role

1.  On the left navigation pane, cIick and select Authentication> GigaVUE-FM User
Management >Roles.

2. Click New Role.
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User Management Users User Groups Authentication
.t Find New Role (@ Allform elements are mandatory unless indicated as optional. X Cancel Apply
%) SETTINGS
> System
Role Name
Reports
> Tasks
v Authentication
q Description
I GigaVUE-FM User Mana... P
Device Authentication Se... 4
High Availability
Tags
SUPPORT Select Permission Resources Permissions - Description =
API Reference
5 Infrastructure Management Select a permission -~ Manage physical and cloud infrastr...
App Protobook
About > Traffic Control Management Select a permission v Manage inline resources,Define an...
End User License Agreement
> FM Security Management Select a permission v Secure FM environment. User can ...
Contact Support
D 5 System Management Select a permission v Control system administration activ...
> Forwardlist Management Select a permission ~ Manage the forwardlist configurati...
FM Instance: GigaVUE-FM Last Updated At May 9, 2023 15:03:36

3. Inthe New Role page, select or enter the following details:

* Role Name: Name of the role.

» Description: Description of the role.

» Select Permission: For Third Party Orchestration from the Resources, select
Write from the Permissions drop-down menu.

4. Click Apply to save the configuration.
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User Groups

A user group consists of a set of roles and set of tags associated with users in that group.
When a user is created they can be associated with one or more groups.

Create User Groups in GigaVUE-FM

The following user groups are available by default in GigaVUE-FM. You will not be able to
edit or change these groups in the system.

User Group

Tag Key and Tag Value

Permission

Super Admin Tag Key = All Group with privileges of fm_super_adminrole.
Group Tag Value = All
Admin Group Tag Key= All Group with privileges of fm_admin role.
Tag Value = All
View only user Tag Key = All Group with privileges of fm_user role.
Tag Value = All

To create a custom user group:

1. On the left navigation pane, cIick , and then select Authentication> GigaVUE-
FMUser Management >User Groups.

2. Click New Group. In the Wizard that appears, perform the following steps. Click Next
to progress forward and click Back to navigate backward and change the details.

User Management

E

Find

SETTINGS

5

> System

Reports

> Tasks
v Authentication
| GigaVUE-FM User Mana...
Device Authentication Se..
High Availability
Tags
SUPPORT
AP Reference
App Protobook
About
End User License Agreement

Contact Support

B

New User Group

Roles

fm_super_admin

fm_admin

fm_user

Goto page of 1

Assign Roles Assign Tags Assign Users

Description

Allows a user to do everything in GigaVUE-FM, including add..

Allows a user to do everything in GigaVUE-FM except adding...

Allows a user to view everything in GigaVUE-FM, including A...

3. In the Group Info tab, enter the following details:
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e Group Name
o Description
4. In the Assign Roles tab, select the required role.
In the Assign Tags tab, select the required tag key and tag value.

6. Inthe Assign Users tab, select the required users. Click Apply to save the
configuration. Click Skip and Apply to skip this step and proceed without adding
users.

The new user group is added to the summary list view.

Click on the ellipses to perform the following operations:

o Modify Users: Edit the details of the users.
o Edit: Edit an existing group.
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Configure GigaVUE Fabric Components in Azure -
Integrated Mode

This section provides step-by-step information on how to register GigaVUE fabric
components using Azure Portal or a configuration file. For more detailed information on

different modes available in third party orchestration, refer to Modes of Deployments section
in GigaVUE Cloud Suite Deployment Guide - Third Party Orchestration.
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Overview of Third-Party Orchestration

You can use your own Azure Orchestrator to deploy the GigaVUE fabric components instead
of using GigaVUE-FM to deploy your fabric components.

The third-party orchestration feature allows you to deploy GigaVUE fabric components using
your own Azure orchestration system. These fabric components register themselves with
GigaVUE-FM using the information provided by the user. Once the nodes are registered
with GigaVUE-FM, you can configure monitoring sessions and related services in GigaVUE-
FM.

You can either manually deploy the fabric components using a configuration file, or you can
use the Azure portal to launch the instances and deploy the fabric components using
Custom data. Using the Custom data provided by you, the fabric components register
themselves with the GigaVUE-FM. Based on the group name and the subgroup name
details provided in the Custom data, GigaVUE-FM groups these fabric nodes under their
respective monitoring domain and connection name. The health status of the registered
nodes is determined by the heartbeat messages sent from the respective nodes.

You can also upload custom certificates to GigaVUE V Series Nodes, GigaVUE V Series Proxy,
and UCT-V Controller using your own cloud platform when deploying the fabric
components. Refer to Install Custom Certificate for more detailed information.
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Prerequisites

This section describes the prerequisites the need to be configured when deploying the
fabric components using third party orchestration in Azure.

GigaVUE V Series Node must have a minimum of two Networks Interfaces (NIC) attached to
it, a management NIC and a data NIC with Accelerated Networking enabled.

When creating a virtual machine for GigaVUE V Series Node using CLI, Management NIC
and Data NIC can be attached at the time of the virtual machine creation. However, if you
are using Azure GUI to create the virtual machine for GigaVUE V Series Node, then the data
NIC can only be attached after creating the virtual machine. Refer to the following topics for
more detailed information on how to create GigaVUE V Series Node with Management and
Data NIC using CLI or Azure GUI:

e Create GigaVUE V Series Node with Management and Data NIC Attached using CLI

e Create GigaVUE V Series Node with Management and Data NIC Attached using Azure
GUI

E NOTE:

* Accelerated Networking must be enabled in the Data NIC only when deploying
GigaVUE V Series Nodes using Third Party Orchestration.

¢ Accelerated Networking is not required for Management NIC.

Create GigaVUE V Series Node with Management and Data NIC Attached
using CLI

Create management NIC:

az network nic create -g <resource group> --vnet-name <VNet Name> --subnet
<Subnet name> -n <Mangement NIC Name>

Create data NIC with Accelerated Networking enabled:

az network nic create -g <resource group> --vnet-name <VNet> --subnet <Subnet> -
n <Data NIC> --accelerated-networking true

Create GigaVUE V Series Node virtual machine using the above NICS:

az vm create --resource-group <Resource group> --size <Standard D4s_v4/Standard
D8S V4> --name <GigaVUE V Series Node> --admin-username gigamon --generate-ssh-
keys --image gigamon-inc:gigamon-gigavue-cloud-suite:vseries-node:6.6.00 --plan-
name vseries-node --plan-product gigamon-gigavue-cloud-suite --plan-publisher
gigamon-inc --nics <Management NIC and Data NIC>
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Create GigaVUE V Series Node with Management and Data NIC Attached
using Azure GUI

Enable Management NIC when creating the GigaVUE V Series Node virtual machine. Refer
to Create virtual machine topic in Azure Documentation for more detailed information on
how to create a virtual machine. Follow the steps given below to attach the data NIC:

1. Select the GigaVUE V Series Node virtual machine from the Resources Page.
2. Stop the Virtual Machine using the Stop button.

3. Navigate to Setting > Networking from the left navigation pane. The Networking
page appears.

4. In the Networking page, click Attach network interface. Select an existing network
interface for Data NIC and click OK.

5. To enable accelerated networking, refer to Manage Accelerated Networking through
the portal.

6. Start the Virtual Machine.

Keep in mind the following when deploying the fabric components using third party
orchestration in integrated mode:

e Create Roles and Users in GigaVUE-FM. Refer to Configure Role-Based Access for Third
Party Orchestration for more detailed information on how to create users and assign roles
to the users.

* When configuring UCT-V Controller, select UCT-V as the Traffic Acquisition Method.
* When you select Customer Orchestrated Source as your Traffic Acquisition Method, UCT-
V and UCT-V Controller registration are not applicable.

 When you deploy the fabric components using third party orchestration, you cannot
delete the monitoring domain without unregistering the GigaVUE V Series Nodes or UCT-
V Controllers.

¢ Deployment of UCT-V Controller, GigaVUE V Series Node, and GigaVUE V Series Proxy
through a third-party orchestrator is supported only on Linux platform.

¢ Deployment of UCT-V through a third-party orchestrator is supported on Linux and
Windows platforms. Refer to Linux Agent Installation and Windows UCT-V Installation for
detailed information.

Recommended Instance Type

The following table lists the recommmended instance type for deploying the fabric
components:

NoTE: Additional instance types are also supported. Refer to Support, Sales, or
Professional Services for deployment optimization.
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Product Instance Type vCPU RAM
GigaVUE V Standard_D4s_v4 4 vCPU 16 GB
series Node | g3nqard_D8S_V4 8 vCPU 32GB
GigaVUE V Standard_Bls 1vCPU 1GB
Series Proxy
UCT-V Standard_Bls 1vCPU 1GB
Controller

Keep in mind the following when upgrading the GigaVUE-FM to 6.1.00 or higher version

(when using third party orchestration to deploy fabric components):

When upgrading GigaVUE-FM to any version higher than 6.0.00 and if the GigaVUE V Series
Nodes version deployed in that GigaVUE-FM are lower than or equal to 6.0.00, then for the
seamless flow of traffic, GigaVUE-FM automatically creates Users and Roles in GigaVUE-FM

with the required permission. The username would be orchestration and the password

would be orchestration123A! for the user created in GigaVUE-FM. Ensure there is no existing

user in GigaVUE-FM, with the username orchestration.

It is recommended to change the password in the Users page, once the upgrade is
complete. Refer to Configure Role-Based Access for Third Party Orchestration for detailed
steps on how to change password in the user page.

Deploy GigaVUE Cloud Suite for Azure
Configure GigaVUE Fabric Components in Azure - Integrated Mode

136


../../../../../../../Content/GV-Cloud-third-party/Configure_RBAC.htm

GigaVUE Cloud Suite for Azure - Deployment Guide

Disable GigaVUE-FM Orchestration in Monitoring Domain

To register fabric nodes under Azure monitoring domain:
1. Create a monitoring domain in GigaVUE-FM. Refer to Create Monitoring Domain sfor
detailed instructions.

2. In the Monitoring Domain Configuration page, select No for the Use FM to Launch
Fabric field as you are going to configure the fabric components in Azure Orchestrator.

@) Azure > Monitoring Domain

|l Azure Monitoring Domain Configuration Cancel
< Use V Series 2 @ ves
- Configure HTTP Proxy » No
— Monitoring Domain Enter a monitoring domain name
Authentication Type Managed Identities
Region Name Region Name.
Traffic Acquisition Method UcTv

Virtual Networks Virtual Networks...

Resource Groups Resource Groups...
Traffic Acquisition Tunnel MTU 1450

Use FM to Launch Fabric » No

3. After creating your monitoring domain, you can deploy your fabric components
through Azure Portal.

In your Azure Portal, you can configure the following GigaVUE fabric components:

e Configure UCT-V Controller in Azure
e Configure UCT-V in Azure
e Configure GigaVUE V Series Node and GigaVUE V Series Proxy in Azure

Refer Deploying GigaVUE Cloud Suite for Azure using Customer Orchestration for more
detailed information.
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Configure UCT-V Controller in Azure

You can configure more than one UCT-V Controller in a monitoring domain.

To register UCT-V Controller in Azure Portal, use any one of the following methods.

e Register UCT-V Controller during Virtual Machine Launch
e Register UCT-V Controller after Virtual Machine Launch

Register UCT-V Controller during Virtual Machine Launch

In your Azure portal, to launch the UCT-V Controller init virtual machine and register UCT-V
Controller using custom data, follow the steps given below:
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1. In the Virtual machines page of the Azure Portal, select Create then Virtual machine.
Then Create a Virtual Machine Page appears. For detailed information, refer to Create

virtual machine topic in Azure Documentation.

On the Advanced tab, enter the Custom Data as text in the following format and
deploy the virtual machine. Enter the monitoring domain name and the connection

name of the monitoring domain created earlier as the groupName and the

subGroupName in the Custom Data. The UCT-V Controller uses this custom data to

generate config file (/fetc/gigamon-cloud.conf) used to register with GigaVUE-FM. You

can also install custom certificates to GigaVUE V Series Node or Proxy, refer to the

below table for details:

Field User Data

User data

without #cloud-config

custom write_files:

certificate - path: /etc/gigamon-cloud.conf

owner: root:root

permissions: '0644'

content: |

Registration:

groupName: <Monitoring Domain Name>
subGroupName: <Connection Name>
user: <Username>
password: <Password>
remoteIP: <IP address of the GigaVUE-FM>
sourceIP: <IP address of UCT-V Controller> (Optional Field)
remotePort: 443

User data with

custom #cloud-config
certificate write_files:
- path: /etc/cntlr-cert.conf
owner: root:root
permissions: "@644"
content: |
————— BEGIN CERTIFICATE-----
<certificate content>

- path: /etc/cntlr-key.conf
owner: root:root
permissions: "400"
content: |
————— BEGIN PRIVATE KEY-----
<private key content>
————— END PRIVATE KEY-----
- path: /etc/gigamon-cloud.conf
owner: root:root
permissions: '0644'
content: |
Registration:
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Field User Data

groupName: <Monitoring Domain Name>
subGroupName: <Connection Name>

user: <Username>

password: <Password>

remoteIP: <IP address of the GigaVUE-FM>

sourceIP: <IP address of UCT-V Controller> (Optional Field)

remotePort: 443

NoTE: User and Password must be configured in the User Management
page. Refer to Configure Role-Based Access for Third Party Orchestration
for more detailed information. Enter the Userame and Password created
in the Add Users Section.

The UCT-V Controller deployed in your Azure portal appears on the Monitoring Domain page

of GigaVUE-FM.
] Monitoring Domain | Connection

[1 Mp1

pulhigvpc

| Fabric | Management IP

G-vTapController

Gigamon-VSeriesProxy-1 HILLILLE

Gigamon-VSeriesNode-1 ITE NI 1 EY

Register UCT-V Controller after Virtual Machine Launch

Fabric Version | Status

(©) Connected

17-304 ©) Ok
210 ) ok
220 ©) ok

To register UCT-V Controller after launching a Virtual Machine using a configuration file,

follow the steps given below:
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1. Log in to the UCT-V Controller.

2. Create a local configuration file (/fetc/gigamon-cloud.conf) and enter the following
custom data.

Registration:
groupName: <Monitoring Domain Name>
subGroupName: <Connection Name>
user: <Username>
password: <Password>
remoteIP: <IP address of the GigaVUE-FM>
sourceIP: <IP address of UCT-V Controller> (Optional Field)
remotePort: 443

NoTE: User and Password must be configured in the User Management
page. Refer to Configure Role-Based Access for Third Party Orchestration
for more detailed information. Enter the UserName and Password created
in the Add Users Section.

3. Restart the UCT-V Controller service.
$ sudo service uctv-cntlr restart

Assign Static IP address for UCT-V Controller

By default, the UCT-V Controller gets assigned an IP address using DHCP. If you wish to
assign a static IP address, follow the steps below:

1. Navigate to /etc/netplan/ directory.
2. Create a new .yaml file. (Other than the default 50-cloud-init.yaml file)
3. Update the file as shown in the following sample:

network:

version: 2
renderer: networkd

ethernets:
ens3:
addresses:
- <IP address>
gateway: <IP address>
ens4:
addresses:
- <IP address>
gateway: <IP address>
ens5:

addresses:
- <IP address>
gateway: <IP address>

4. Save the file.

5. Restart theUCT-V Controller service.
$ sudo service uctv-cntlr restart

Deploy GigaVUE Cloud Suite for Azure
Configure GigaVUE Fabric Components in Azure - Integrated Mode

141


../../../../../../../Content/GV-Cloud-third-party/Configure_RBAC.htm

GigaVUE Cloud Suite for Azure - Deployment Guide

The deployed UCT-V Controller registers with the GigaVUE-FM. After successful registration,
the UCT-V Controller sends heartbeat messages to GigaVUE-FM every 30 seconds. If one
heartbeat is missing, the fabric component status appears as 'Unhealthy'. If more than five
heartbeats fail to reach GigaVUE-FM, GigaVUE-FM tries to reach the UCT-V Controller and if
that fails as well then GigaVUE-FM unregisters the UCT-V Controller and it will be removed
from GigaVUE-FM.
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Configure UCT-V in Azure

UCT-V should be registered via the registered UCT-V Controller and commmunicates through
PORT 8891.

NoTE: Deployment of UCT-Vs through third-party orchestrator is supported on both
Linux and Windows platforms. Refer to Linux UCT-V Installation andWindows UCT-V
Installation for detailed information.

To register UCT-V in Azure Portal, use any one of the following methods.

e Register UCT-V during Virtual Machine Launch
» Register UCT-V after Virtual Machine Launch

Register UCT-V during Virtual Machine Launch

NoTE: Registering UCT-V during Virtual Machine Launch is not applicable for
Windows Agents. You can register your Windows Agents after launching the Virtual
machine, using a configuration file.

In your Azure portal, to launch the UCT-V init virtual machine and register the UCT-V using
custom data, follow the steps given below:

1. In the Virtual machines page of the Azure Portal, select Create then Virtual machine.
Then Create a Virtual Machine Page appears. For detailed information, refer to Create
virtual machine topic in Azure Documentation.

2. On the Advanced tab, enter the Custom Data as text in the following format and
deploy the virtual machine. The UCT-V uses this custom data to generate config file
(/letc/gigamon-cloud.conf) used to register with GigaVUE-FM.

#cloud-config
write_files:
- path: /etc/gigamon-cloud.conf
owner: root:root
permissions: '0644'
content: |
Registration:
groupName: <Monitoring Domain Name>
subGroupName: <Connection Name>
user: <Username>
password: <Password>
remoteIP: <IP address of the UCT-V Controller 1, <IP address of the UCT-V Controller

2>
sourceIP: <IP address of UCT-V> (Optional Field)
remotePort: 8891
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» User and Password must be configured in the User Management page.

e If you are using multiple interface in UCT-V and UCT-V Controller is not connected

to the primary interface, then add the following to the above registration data:
localInterface:<Interface to which UCT-V Controller is connected>

information. Enter the UserName and Password created in the Add Users Section.

Register UCT-V after Virtual Machine Launch

NOTE: You can configure more than one UCT-V Controller for a UCT-V, so that if one
UCT-V Controller goes down, the UCT-V registration will happen through another
Controller that is active.

To register UCT-V after launching a Virtual Machine using a configuration file, follow the
steps given below:

1. Install the UCT-V in the Linux or Windows platform. For detailed instructions, refer to
Linux UCT-V Installation and Windows UCT-V Installation.

2. Login to the UCT-V. Refer to Default Login Credentials for UCT-V Controller default
login credentials.
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3. Create a local configuration file and enter the following custom data.

B /etc/gigamon-cloud.conf is the local configuration file in Linux platform.

« C:\ProgrambData\uctv\gigamon-cloud.conf is the local configuration file in
Windows platform.

* When creating C:\\ProgramData\uctv\gigamon-cloud.conf file, ensure that
the file name extension is .conf. To view the file name extension in Windows,
follow the steps given below:

a. Goto File Explorer and open the File Location.
b. On the top navigation bar, click View.
c. Inthe View tab, enable the File name extensions check box.

Registration:
groupName: <Monitoring Domain Name>
subGroupName: <Connection Name>
user: <Username>
password: <Password>
remoteIP: <IP address of the UCT-V Controller 1>,
<IP address of the UCT-V Controller 2>
sourceIP: <IP address of UCT-V> (Optional Field)
remotePort: 8891

E » User and Password must be configured in the User Management page.
Refer to Configure Role-Based Access for Third Party Orchestration for more
detailed information. Enter the UserName and Password created in the Add
Users Section.

» If you are using multiple interface in UCT-V and UCT-V Controller is not
connected to the primary interface, then add the following to the above

registration data:
localInterface:<Interface to which UCT-V Controller is connected>

4. Restart the UCT-V service.

e Linux platform:
$ sudo service uctv restart

* Windows platform: Restart from the Task Manager.

The deployed UCT-V registers with the GigaVUE-FM through the UCT-V Controller. After
successful registration, the UCT-V sends heartbeat messages to GigaVUE-FM every 30
seconds. If one heartbeat is missing, UCT-V status appears as 'Unhealthy'. If more than five
heartbeats fail to reach GigaVUE-FM, GigaVUE-FM tries to reach the UCT-V and if that fails as
well then GigaVUE-FM unregisters the UCT-V and it will be removed from GigaVUE-FM.
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Configure GigaVUE V Series Node and GigaVUE V Series Proxy in
Azure

E » |t is not mandatory to register GigaVUE V Series Nodes via GigaVUE V Series
however, if there is a large number of nodes connected to GigaVUE-FM or if the
user does not wish to reveal the |P addresses of the nodes, then you can register
your nodes using GigaVUE V Series Proxy. In this case, GigaVUE-FM communicates
with GigaVUE V Series Proxy to manage the GigaVUE V Series Nodes.

» When deploying GigaVUE V Series Node using GigaVUE V Series Proxy, deploy the
GigaVUE V Series Proxy first and provide the IP address of the proxy as the Remote
IP of the GigaVUE V Series Node.

To register GigaVUE V Series Node and GigaVUE V Series Proxy in Azure Portal, use any one
of the following methods.

e Register GigaVUE V Series Node and GigaVUE V Series Proxy during Virtual Machine
Launch

e Register GigaVUE V Series Node and GigaVUE V Series Proxy after Virtual Machine
Launch

Register GigaVUE V Series Node and GigaVUE V Series Proxy during Virtual Machine
Launch

To register GigaVUE V Series Node and GigaVUE V Series Proxy using the custom data in
Azure Portal, follow the steps given below:

1. In the Virtual machines page of the Azure Portal, select Create then Virtual machine.
Then Create a Virtual Machine Page appears. For detailed information, refer to Create
virtual machine topic in Azure Documentation.
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2. On the Advanced tab, enter the Custom Data as text in the following format and
deploy the virtual machine. Enter the monitoring domain name and the connection
name of the monitoring domain created earlier as the groupName and the

subGroupName in the Custom Data. he GigaVUE V Series Node and GigaVUE V Series
Proxy uses this custom data to generate config file (/fetc/gigamon-cloud.conf) used to
register with GigaVUE-FM. You can also install custom certificates to GigaVUE V Series

Node or Proxy, refer to the below table for details:

Field User Data

owner: root:root
permissions: "@644"
content: |
————— BEGIN CERTIFICATE-----
<certificate content>
————— END CERTIFICATE-----
- path: /etc/cntlr-key.conf
owner: root:root
permissions: "400"
content: |
————— BEGIN PRIVATE KEY-----
<private key content>
----- END PRIVATE KEY-----
- path: /etc/gigamon-cloud.conf
owner: root:root
permissions: '0644'
content: |
Registration:
groupName: <Monitoring Domain Name>
subGroupName: <Connection Name>
user: <Username>
password: <Password>

Proxy>
remotePort: 443

User data
without #cloud-config
custom write_files:
certificate - path: /etc/gigamon-cloud.conf
owner: root:root
permissions: '0644'
content: |
Registration:
groupName: <Monitoring Domain Name>
subGroupName: <Connection Name>
user: <Username>
password: <Password>
remoteIP: <IP address of the GigaVUE-FM> or <IP address of the Proxy>
remotePort: 443
User data
with #cloud-config
custom write_files:
certificate - path: /etc/cntlr-cert.conf

remoteIP: <IP address of the GigaVUE-FM> or <IP address of the

Deploy GigaVUE Cloud Suite for Azure
Configure GigaVUE Fabric Components in Azure - Integrated Mode

147



GigaVUE Cloud Suite for Azure - Deployment Guide

E e You can register your GigaVUE V Series Node directly with GigaVUE-FM or
you can use GigaVUE V Series Proxy to register your GigaVUE V Series Node
with GigaVUE-FM. If you wish to register GigaVUE V Series Node directly,
enter the remotePort Value as 443 and the remoteIpr as <IP address of the
GigaVUE-FM> or if you wish to deploy GigaVUE V Series Node using GigaVUE
V Series Proxy then, enter the remotePort Value as 8891 and remote1p as <IP
address of the Proxy>.

» User and Password must be configured in the User Management page.
Refer to Configure Role-Based Access for Third Party Orchestration for more
detailed information. Enter the UserName and Password created in the Add
Users Section.

Register GigaVUE V Series Node and GigaVUE V Series Proxy after Virtual Machine
Launch

To register GigaVUE V Series Proxy after launching the virtual machine using a configuration
file, follow the steps given below:

1. Log in to the GigaVUE V Series Node or Proxy. Refer to Default Login Credentials for
UCT-V Controller default login credentials.

2. Create a local configuration file (/fetc/gigamon-cloud.conf) and enter the following
custom data.

Registration:
groupName: <Monitoring Domain Name>
subGroupName: <Connection Name>
user: <Username>
password: <Password>
remoteIP: <IP address of the GigaVUE-FM> or <IP address of the Proxy>
remotePort: 443

E * You can register your GigaVUE V Series Node directly with GigaVUE-FM or
you can use V Series proxy to register your GigaVUE V Series with
GigaVUE-FM. If you wish to register GigaVUE V Series Node directly, enter the
remotePort Value as 443 and the remoteIpr as <IP address of the GigaVUE-FM> or
if you wish to deploy GigaVUE V Series Node using GigaVUE V Series Proxy
then, enter the remotePort Value as 8891 and remoteIP as <IP address of the
Proxy>.

» User and Password must be configured in the User Management page.
Refer to Configure Role-Based Access for Third Party Orchestration for more
detailed information. Enter the UserName and Password created in the Add
Users Section.
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3. Restart the GigaVUE V Series Proxy service.
» GigaVUE V Series Node:

$ sudo service vseries-node restart

e GigaVUE V Series Proxy:

$ sudo service vps restart

The deployed GigaVUE V Series Node or Proxy registers with the GigaVUE-FM. After
successful registration, the GigaVUE V Series Node or Proxy sends heartbeat messages to
GigaVUE-FM every 30 seconds. If one heartbeat is missing, the fabric component status
appears as 'Unhealthy'. If more than five heartbeats fail to reach GigaVUE-FM, GigaVUE-FM
tries to reach the GigaVUE V Series Node or Proxy and if that fails as well then GigaVUE-FM
unregisters the GigaVUE V Series Node or Proxy and it will be removed from GigaVUE-FM.

If you are using Azure GUI to create the virtual machine for GigaVUE V Series Node then
data NIC must be attached to GigaVUE V Series Node after creating the virtual machine.
Refer to Create GigaVUE V Series Node with Management and Data NIC Attached using
Azure GUI for more detailed information.
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Upgrade GigaVUE Fabric Components in
GigaVUE-FM for Azure

This chapter describes how to upgrade GigaVUE V Series Proxy and GigaVUE V Series Node.
For more detailed information about UCT-V Controller, GigaVUE V Series Proxy and Node

Version refer GigaVUE-FM Version Compatibility Matrix.

Refer to the following topic for more information:

e Prerequisite
e Upgrade UCT-V Controller
» Upgrade GigaVUE V Series Node and GigaVUE V Series Proxy
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Prerequisite

Before you upgrade the GigaVUE V Series Proxy and GigaVUE V Series Node, you must
upgrade GigaVUE-FM to software version 5.13.01 or above.
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Upgrade UCT-V Controller

NoTe: UCT-V Controllers cannot be upgraded. Only a new version that is compatible
with the UCT-V's version can be added or removed in the Azure Fabric Launch
Configuration page.

To change the UCT-V Controller version follow the steps given below:

To change UCT-V Controller version between different major versions

NOTE: You can only add UCT-V Controllers which has different major versions. For
example, you can only add UCT-V Controller version 1.8-x if your existing version is 1.7-
X.

a. In the Azure Fabric Launch Configuration page, under Controller Versions, click Add.

b. From the Image drop-down list, select a UCT-V Controller image that matches with the
version number of UCT-Vs installed in the instances.

c. From the Size drop-down list, select a size for the UCT-V Controller. The default size is
Standard_Bls.

d. In Number of Instances, specify the number of UCT-V Controllers to launch. The
mMinimum number you can specify is 1.

Controller Version(s) Add

Image Select image...
Size Standard_B1s

Number of Instances 1

Image

Size Standard_B1s =
Number of Instances 1
Management Subnet
IP Address Type Private Public
Subnet mgmt

Additional Subnets

Subnet 1 trafficl

Security Groups —— . &

Tags

You cannot change the IP Address Type and the Additional Subnets details, provided at the
time of UCT-V Controller configuration.

After installing the new version of UCT-V Controller, follow the steps given below:

1. Install UCT-V with the version same as the UCT-V Controller.
2. Delete the UCT-V Controller with older version.
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To change UCT-V Controller version with in the same major version:

NoTE: This is only applicable, if you wish to change your UCT-V Controller version
from one minor version to another with in the same major version. For example, from
1.8-2 to 1.8-3.

a. From the Image drop-down list, select a UCT-V Controller image with in the same
major version.

b. Specify the Number of Instances. The minimum number you can specify is 1.
c. Select the Subnet from the drop-down.

E e You cannot modify the rest of the fields.

e After installing the new version of UCT-V Controller, install the UCT-V with the same
version.
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Upgrade GigaVUE V Series Node and GigaVUE V Series Proxy

GigaVUE-FM lets you upgrade GigaVUE V Series Proxy and GigaVUE V Series Node at a time.

There are multiple ways to upgrade the GigaVUE V Series Proxy and Node. You can:
» Launch and replace the complete set of nodes and proxys at a time.

For example, if you have 1 GigaVUE V Series Proxy and 10 GigaVUE V Series Nodes in
your VNet, you can upgrade all of them at once. First, the new version of GigaVUE V
Series controller is launched. Next, the new version of GigaVUE V Series nodes are
launched. Then, the old version of V Series controller and nodes are deleted from the
VNet.

NOTES:

o When the new version of node and proxy is launched, the old version still exists in
the VNet until they are deleted. Make sure the instance type determined during the
configuration can accommodate the total number of new and old instances present
in the VNet. If the instance type cannot support so many instances, you can choose
to upgrade in multiple batches.

o Ifthereis an error while upgrading the complete set of proxys and nodes present in
the VNet, the new version of the fabric is immediately deleted and the old version of
the fabric is retained as before.

o If you have deployed your nodes using Public IP address while creating the
monitoring domain, then select the same number of Public IP addressess defined in
your Max Instances when upgrading your nodes. Refer to Create Monitoring
Domain for more detailed information.

o Do not configure floating IPv4 for an IPv6-only management /data subnet. Floating
IPv4 is not applicable for IPve-only subnet.

» Launch and replace the nodes and proxy in multiple batches.
For example, if there are 18 GigaVUE V Series Nodes to be upgraded, you can specify

how many you want to upgrade per batch.
To upgrade the GigaVUE V Series Proxy and GigaVUE V Series Node:

1. Go to Inventory > VIRTUAL > Azure, and then click Monitoring Domain. The
Monitoring Domain page appears.

2. On the Monitoring Domain page, select the connection name check box and click
Actions
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Lal New Actions ~ Refresh Inventory
e = B > Edit Monit D
%. v ™ Monitoring Domain Connection Name Management IP Type Version 1t Monitoring bomain
o md Edit Fabric
Delete Monitoring Domain
= v Auto_Vnet_Edhaya Manua
Delete Fabric
Gigamon-G-vTapControlle.. S04 8 G-vTap Controller 1.8-2
Upgrade Fabric
Gigamon-VSeriesProxy-2 081219216 V Series Proxy 2317 ) Ok
Gigamon-VSeriesNode-2 10442 1008 V Series Node 22172 ) Ok

3. Select Upgrade Fabric from the drop-down list. The Fabric Nodes Upgrade page is
displayed.
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Fabric Nodes Upgrade

V Series Proxy
Upgrade
Current Version 2.3.0
Image { ’ 4104 -
Change Size O
Batch Size 1

V Series Node
Upgrade
Current Version 2.3.0
Image 9 9 04 -
Change Size O
Batch Size 1
Public IPs -

Upgrade Cancel

4. To upgrade the GigaVUE V Series Node/Proxy, select the Upgrade checkbox.

5. From the Image drop-down list, select the latest version of the GigaVUE V
SeriesProxy/Nodes.

6. Select the Change Size checkbox to change the flavor of the node/proxy, only if
required.

7. To upgrade the GigaVUE V Series Node/Proxy, specify the batch size in the Batch Size
box.

For example, if there are 7 GigaVUE V Series Nodes, you can specify 7 as the batch size
and upgrade all of them at once. Alternatively, you can specify 3 as the batch size, and
launch and replace 3V Series nodes in each batch. In the last batch, the remaining 1V
Series node is launched.

8. From the Public IPs drop-down list, select the IP addressess equal to the Max Instances
defined when creating a monitoring domain.
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NoTE: This is only applicable for nodes deployed using Public IP, when creating
a monitoring domain.

9. Click Upgrade.

The upgrade process takes a while depending on the number of GigaVUE V Series
Proxys and Nodes upgrading in your Azure environment. First, the new version of the
GigaVUE V Series Proxy is launched. Next, the new version of GigaVUE V Series Nodes
is launched. Then, the older version of both is deleted from the project. The monitoring
session is deployed automatically.

To view the detailed upgrade status click Upgrade in progress or Upgrade successful, the
V Series Node Upgrade Status dialog box appears.

Fabric Nodes Upgrade Status

Monitoring Domain: md

Start Time
End Time
Status Fabric upgrade completed

successfully

Proxies Nodes

Total 1 1
Upgraded 1 1
Upgrading 0 0
Remaining 0 0
Failures 0 0

Clear Close

e Click Clear to delete the monitoring domain upgrade status history of successfully
upgraded nodes.
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Configure Secure Tunnel

You can configure secure tunnels for:

e Precrypted Traffic
e Mirrored Traffic

Precrypted Traffic

You can send the precrypted traffic through a secure tunnel. When secure tunnels for
Precryption is enabled, packets are framed and sent to the TLS socket. The packets are sent

in PCAPNg format.

When you enable the secure tunnel option for regular and precrypted packets, two TLS
secure tunnel sessions are created.

It is recommended always to enable secure tunnels for precrypted traffic to securely transfer
the sensitive information.

Mirrored Traffic

You can enable the Secure Tunnel for mirrored traffic. By default, Secure Tunnel is disabled.

Refer to the following sections for Secure Tunnel Configuration:
« Configure Secure Tunnel from UCT-V to GigaVUE V Series Node in UCT-V
« Configure Secure Tunnel between GigaVUE V Series Nodes

Prerequisites
« Port 11443 should be enabled in security group settings. Refer to Network Security
Groups for more detailed information on Network Firewall / Security Group.
=«  While creating Secure Tunnel, you must provide the following details:
SSH key pair
CA certificate

Notes

« Protocol versions IPv4 and IPv6 are supported.

« Ifyou wish to use IPv6 tunnels, your GigaVUE-FM and the fabric components version
must be 6.6.00 or above.
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« For UCT-V with a version lower than 6.6.00, if the secure tunnel is enabled in the
monitoring session, secure mirror traffic will be transmitted over IPv4, regardless of

IPv6 preference.

Configure Secure Tunnel from UCT-V to GigaVUE
V Series Node

To configure a secure tunnel in UCT-V, you must configure one end of the tunnel to the UCT-
V and the other end to GigaVUE V Series Node. You must configure the CA certificates in
UCT-V and the private keys and SSL certificates in GigaVUE V Series Node. Refer to the
following steps for configuration:

1. Upload a Custom Authority You must upload a Custom Certificate to UCT-V Controller to establish
Certificate (CA) a connection with the GigaVUE V Series Node.

To upload the CA using GigaVUE-FM, follow the steps
given below:

1. Go to Inventory > Resources > Security > CA List.

2. Click New to add a new Custom Authority. The Add Custom
Authority page appears.

3. Enter or select the following information.

Field Action

Alias Alias name of the CA.

File Upload | Choose the certificate from the desired location.

4. Click Save.

For more information, refer to the section Adding
Certificate Authority

2. Upload an SSL Key You must add an SSL key to the GigaVUE V Series Node. To add an SSL
Key, follow the steps in the section SSL Decrypt.

3 Enable the secure tunnel You should enable the secure tunnel feature to establish a connection

between the UCT-V and GigaVUE V Series Node. To enable the secure

tunnel, follow these steps:

1. Inthe Edit Monitoring Session page, click Options. The Apply
template page appears.

2. Enable the Secure Tunnel button. You can enable secure tunnel
for both mirrored and precrypted traffic.

NoTe: When GigaVUE V Series Node is upgraded or deployed to 6.5,
all the existing monitoring sessions will be redeployed, and
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Refer to

individual TLS TEPs are created for each UCT-V.

4., Select the SSL Key while You must select the added SSL Key in the GigaVUE V Series Node
creating a monitoring while creating a monitoring domain configuring the fabric
domain and configuring the components in GigaVUE-FM. To select the SSL key, follow the steps in
fabric componentsin the section Configure GigaVUE Fabric Components in GigaVUE-FM
GigaVUE-FM.

If the existing monitoring domain does not have a SSL key, you can
add it by following the given steps:

1. Select the monitoring domain for which you want to add the SSL
key.

2. Click the Actions drop down list and select Edit SSL
Configuration. An Edit SSL Configuration window appears.

3. Select the CA in the UCT-V Agent Tunnel CA drop down list.
4. Select the SSL key in the V Series Node SSL key drop down list.

5. Click save.
5. Select the CA certificate while | You should select the added Certificate Authority (CA) in UCT-V
creating the monitoring Controller. To select the CA certificate, follow the steps in the section

domain configuring the fabric | Configure GigaVUE Fabric Components in GigaVUE-FM
components in GigaVUE-FM.

Configure Secure Tunnel between GigaVUE V
Series Nodes

You can create secure tunnel:

« Between two GigaVUE V Series Nodes.
«» From one GigaVUE V Series Node to multiple GigaVUE V Series Nodes.

You must have the following details before you start configuring secure tunnels between
two GigaVUE V Series Nodes:

» [P address of the tunnel destination endpoint (Second GigaVUE V Series Node).
« SSH key pair (pem file).

To configure secure tunnel between two GigaVUE V Series Nodes, refer to the following
steps:
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Task

Refer to

1. | Upload | You must upload a Custom Certificate to UCT-V Controller to establish a connection between the
a GigaVUE V Series Node.
Certific
ate To upload the CA using GigaVUE-FM follow the steps given below:
Author
ity (CA) 1. Go to Inventory > Resources > Security > CA List.
Certific 2. Click Add, to add a new Certificate Authority. The Add Certificate Authority page
ate appears.
3. Enter or select the following information.
Field Action
Alias Alias name of the CA.
File Upload Choose the certificate from the desired location.
4. Click Save.
5. Click Deploy All
For more information, refer to the section Adding Certificate Authority
2. | Upload | You must add an SSL key to GigaVUE V Series Node. To add SSL Key, follow the steps in the
an SSL | section Upload SSL Keys.
Key
3 | Create | You should enable the secure tunnel feature to establish a connection between the UCT-V and
a the first GigaVUE V Series Node. To enable the secure tunnel feature follow these steps:
Secure 11, Inthe Edit Monitoring Session page, click Options. The Apply template page appears.
E)l;::veel 2. Enable the Secure Tunnel button. You can enable secure tunnel for both mirrored and
precrypted traffic.
en
UCT-V
and
the
first
GigaV
UEV
Series
Node
4. | Select | Select the added SSL Key while creating a Monitoring Domain and configuring the fabric
the components in GigaVUE-FM in the first GigaVUE V Series Node .
added | you must select the added SSL Key for the first GigaVUE V Series Node.
L . . . . . .
5 To select the SSL key, follow the steps in the section Configure GigaVUE Fabric Components in
Key .
} GigaVUE-FM
while
creatin
ga
Monito
ring
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Task

Domai
n.

Refer to

5. | Select
the
added
CA
certific
ate
while
creatin
g the
Monito
ring
Domai
n

You should select the added Certificate Authority (CA) in UCT-V Controller. To select the CA

certificate, follow the steps in the section Configure GigaVUE Fabric Components in GigaVUE-FM

6 | Create
an
Egress
tunnel
from
the
first
GigaV
UE V
Series
Node
with
tunnel
type as
TLS-
PCAP
NG in
the
Monito
ring
Sessio
n

You must create a tunnel for traffic to flow out from the first GigaVUE V Series Node with tunnel
type as TLS-PCAPNG in the Monitoring Session. Refer to Create Ingress and Egress Tunnels for

more detailed information on how to create tunnels.

To create the egress tunnel, follow these steps:

1. After creating a new monitoring session, or click Actions > Edit on an existing monitoring

session, the GigaVUE-FM canvas appears.

2. Inthe canvas, select New > New Tunnel, drag and drop a new tunnel template to the
workspace. The Add Tunnel Spec quick view appears.

3. Onthe New Tunnel quick view, enter or select the required information as described in the

following table:

Field Action

Alias

The name of the tunnel endpoint.

Description

The description of the tunnel endpoint.

Configure Secure Tunnel
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Task

Refer to

Field Action

Type

Select TLS-PCAPNG for creating egress secure tunnel

Traffic
Direction

Choose Out (Encapsulation) for creating an egress tunnel from the V Series
node to the destination. Select or enter the following values:

o MTU- The default value is 1500 for Azure.

NoOTE: Increasing the MTU value will impact the performance and may even
result in packet loss. By default, Azure VNet will attempt to fragment jumbo
frames even if sending and receiving VMs are configured with a higher MTU.

o Time to Live - Enter the value of the time interval till which the session
needs to be available. The value ranges from 1to 255. The default value is
64.

DSCP - Enter the Differentiated Services Code Point (DSCP) value.
Flow Label - Enter the Flow Label value.

Source L4 Port- Enter the Souce L4 Port value

Destination L4 Port - Enter the Destination L4 Port value.

Flow Label

Cipher- Only SHA 256 is supported.

TLS Version - Select TLS Version1.3.

Selective Acknowledgments - Choose Enable to turn on the
TCP selective acknowledgments.

O O O 0O O 0O 0o O

o SYN Retries - Enter the value for number of times the SYN has to be
tried. The value ranges from 1to 6.

o Delay Acknowledgments - Choose Enable to turn on delayed
acknowledgments.

Remote
Tunnel IP

Enter the interface IP address of the second GigaVUE V Series Node.
(Destination IP).

4. Click Save.

7. | Select
the
added
SSL
Key
while
creatin
ga
Monito
ring
Domai
nand
config
uring

You must select the added SSL Key in second GigaVUE V Series Node. To select the SSL key,
follow the steps in the section Configure GigaVUE Fabric Components in GigaVUE-FM

Configure Secure Tunnel
Configure Secure Tunnel between GigaVUE V Series Nodes
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Task

Refer to

the
fabric
compo
nents
in
GigaV
UE-FM
in
second
GigaV
UE V
Series
Node
8 | Create | You must create a ingress tunnel for traffic to flow in from GigaVUE V Series Node with tunnel
an type as TLS-PCAPNG while creating the monitoring session. Refer to Create a Monitoring Session
ingress | to know about monitoring session.
tunnel
for the To create the ingress tunnel, follow these steps:
second
Gigav |1 After creating a new monitoring session, or click Actions > Edit on an existing monitoring
UE session, the GigaVUE-FM canvas appears.
V Serie | 2. Inthe canvas, select New > New Tunnel, drag and drop a new tunnel template to the
s Node workspace. The Add Tunnel Spec quick view appears.
with 3. Onthe New Tunnel quick view, enter or select the required information as described in the
tunnel following table:
type as
TLS- Field Action
NG in Alias The name of the tunnel endpoint.
the . Description The description of the tunnel endpoint.
Monito
ring Type Select TLS-PCAPNG for creating egress secure tunnel.
ieSSIO NoTE: If you are enabling Secure tunnel in Monitoring Session with traffic
acquisition method as UCT-V, you must not create TLS-PCAPNG Tunnel
with direction IN, Destination L4 port 11443, and GigaVUE V Series Node
version 6.5 and above.
Traffic Choose In (Decapsulation) for creating an ingress tunnel that receives traffic
Direction from V Series node 1. Select or enter the values as described in Step 6.
IP Version The version of the Internet Protocol. IPv4 and IPv6 are supported.
Remote Enter the interface IP address of the first GigaVUE Cloud Suite V Series Node
Tunnel IP (Destination IP).
4. Click Save

Configure Secure Tunnel
Configure Secure Tunnel between GigaVUE V Series Nodes
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Viewing Status of Secure Tunnel

GigavUE-FM allows you to view the status of secure tunnel connection in UCT-C. You can
verify whether the tunnel is connected to the tool or V Series node through the status.

To verify the status of secure tunnel, go to UCT-C > Monitoring Damain. In the monitoring
domain page, Tunnel status column shows the status of the tunnel. The green color
represents that the tunnel is connected and the red represents that the tunnel is not
connected.

For configuring secure tunnel, refer to Configure Secure Tunnel section.

Create Prefiltering Policy
Template

GigaVUE-FM allows you to create a prefiltering policy template with a single rule or multiple
rules. You can configure a rule with a single filter or multiple filters. Each monitoring session
can have a maximum of 16 rules.

To create a prefiltering policy template, do the following steps:
1. Go to Resources > Prefiltering, and then click UCT-V.

2. Click New.

3. Enter the name of the template in the Template Name field.
4. Enter the name of a rule in the Rule Name field.

5. Click any one of the following options:

« Pass — Passes the traffic.
« Drop — Drops the traffic.

NoOTE: In the absence of a prefilter rule, traffic is implicitly allowed. However, once
rules are defined, they include an implicit drop rule. Should the traffic not conform to
any of the specified rules, it will be dropped.

6. Click any one of the following options as per the requirement:

Create Prefiltering Policy Template 165
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« Bi-Directional —- Allows the traffic in both directions of the flow. A single Bi-direction

rule should consist of 1 Ingress and 1 Egress rule.
« Ingress — Filters the traffic that flows in.
« Egress — Filters the traffic that flows out.

7. Select the value of the priority based on which the rules must be prioritized for filtering.

Select the value as 1to pass or drop a rule in top priority. Similarly, you can select the value as
2,3, 4 to 8, where 8 can be used for setting a rule with the least priority. Drop rules are added

based on the priority and, then pass rules are added.

8. Select the Filter Type from the following options:

« L3
« L4

9. Select the Filter Name from the following options:

»  IP4Src
»  ip4Dst
«  ip6Src
« ip6Dst

« Proto - It iscommon for both ipv4 and ipv6.

10. Select the Filter Relation from any one of the following options:

«» Not Equal to
« Equalto

11. Enter the value for the given filter.

12. Click Save.

NoTE: Click + to add more rules or filters. Click - to remove a rule or a filter.

To enable prefiltering, refer to Monitoring Session Options.

Create Prefiltering Policy Template
Viewing Status of Secure Tunnel
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Configure Monitoring Session

This chapter describes how to setup ingress and egress tunnel, maps, applications in a
monitoring session to receive and send traffic to the GigaVUE Cloud Suite V Series node. It
also describes how to filter, manipulate, and send the traffic from the V Series node to
monitoring tools.

Refer to the following sections for details:

¢ Create a Monitoring Session

* Interface Mapping

e Create Ingress and Egress Tunnels

¢ Create a New Map

» Add Applications to Monitoring Session

e Deploy Monitoring Session

¢ View Monitoring Session Statistics

¢ View Health Status on the Monitoring Session Page
¢ Visualize the Network Topology

Configure Monitoring Session 167
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Create a Monitoring Session

You must create a monitoring domain before creating a monitoring session. Refer to Create
Monitoring Domain for more detailed information on how to create a monitoring domain.

A monitoring session defines how traffic should be processed and send to the tunnel
endpoints.

GCigaVUE-FM automatically collects inventory data on all target instances available in your
cloud environment. You can design your monitoring session to include or exclude the
instances that you want to monitor. You can also choose to monitor egress, ingress, or all
traffic.

When a new target instance is added to your cloud environment, GigaVUE-FM automatically
detects and adds the instance to your monitoring session. Similarly, when an instance is
removed, it updates the monitoring sessions.

For the connections without UCT-Vs, there are no targets that are automatically selected.
You can use Customer Orchestrated Source in the monitoring session to accept a tunnel
from anywhere.

You can create multiple monitoring sessions per monitoring domain.

To create a new monitoring session:
1. Go to Traffic > Virtual > Orchestrated Flows and select your cloud platform. The
Monitoring Sessions page appears.
2. Click New to open the Create a New Monitoring Session page.

New Monitoring Session Cancel Next

A monitoring session defines how traffic should be processed and send to the tunnel endpoints. You can specify prefiltering and precryption on UCT-Vs or
traffic thresholds by applying the pre-defined templates to your monitoring session.

Alias
Monitoring Domain Monitoring Domain v

Connections Select Connections v

Traffic Distribute
® Traffic distribute is only supported on V Series version 6.5.00 and
later.

Configure Monitoring Session 168
Create a Monitoring Session



GigaVUE Cloud Suite for Azure - Deployment Guide

3. Enter the appropriate information for the monitoring session as described in the
following table.

Field Description

Alias The name of the monitoring session.

Monitoring The name of the monitoring domain that you want to select.

Domain

Connection The connection(s) that are to be included as part of the monitoring domain. You can

select the required connections that need to be part of the monitoring domain.

Traffic Enabling the "Traffic Distribute" option identifies duplicate packets across different
Distribute GigaVUE V Series Nodes when traffic from various targets is routed to these instances
for monitoring.

4. Click Create. The Edit Monitoring Session Canvas page appears.
The Monitoring Session page Actions button also has the following options:

Button Description

Edit Opens the Edit page for the selected monitoring
session.

NOTE: In case of an error while editing a monitoring session,
undeploy and deploy the monitoring session again.

Delete Deletes the selected monitoring session.

Clone Duplicates the selected monitoring session.

Deploy Deploys the selected monitoring session.

Undeploy Undeploys the selected monitoring session.

Apply Threshold You can use this button to apply the threshold template created

for monitoring cloud traffic health. Refer to Monitor Cloud
Health for more detailed information on cloud traffic health, how
to create threshold templates, and how to apply threshold

templates.
Apply Policy You can use this button to enable precyption, prefiltering, or
Secure Tunnel. Refer to Monitoring Session Options for more
details.
Configure Monitoring Session 169
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Edit Monitoring Session

In the edit monitoring session canvas page, you can add and configure applications, tunnel
endpoints, raw endpoints, and maps.

Refer to the following topics for detailed information:

e Create Ingress and Egress Tunnels

¢ Add Applications to Monitoring Session

¢ Create a New Map

The Edit Monitoring Session page has the following buttons:

Button Description

Options

You can enable or disable Prefiltering, Precryption, Secure
Tunnel, User Defined Applications, here. You can also
create prefiltering and threshold template and apply it to
the monitoring session. Refer to Monitoring Session
Options for more detailed information.

Show Targets

Use to refresh the subnets and monitored instances details
that appear in the Instances dialog box.

Dashboard

The dashboard displays the statistics for all the
applications, end points and the maps available in the
monitoring session.

Ok / Cancel

Ok: Use to save the configurations in the
monitoring session when the monitoring
session is in undeployed state.

Cancel: After the monitoring session is
deployed, if you have made any changes and
wish to remove them, use this option.

Interface mapping

Use to change the interfaces mapped to an individual
GigaVUE V Series Node. Refer to Interface Mapping topic
for more details.

Deploy

Deploys the selected monitoring session. Refer to Deploy
Monitoring Session topic for more details.

Configure Monitoring Session

Create a Monitoring Session
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Monitoring Session Options

Prefiltering, Precyption, Secure tunnel, User-defined applications, and Thresholds can be
enabled for the monitoring session from the Options page.

To navigate to Options page, follow the steps given below:

1. Go to Traffic > Virtual > Orchestrated Flows > Select your cloud platform.
2. Select a monitoring session from the list view, click Actions > Edit. The Edit Monitoring

Session page appears.
3. In the Edit Monitoring Session page, click Options. The Options page appears.

You can perform the following actions in the Options page:

» Enable Prefiltering

e Enable Precryption and Secure Tunnels
* Enable User Defined Applications

e Create Threshold

Enable Prefiltering

To enable Prefiltering, follow the steps given below:

1. In the Monitoring Session Options page, Click Mirroring tab.

2. Enable the Mirroring toggle button.
3. Enable the Secure Tunnel button if you wish to use Secure Tunnels. For more
information about Secure Tunnel, refer to Secure Tunnels.

4. You can select an existing Prefiltering template from the Template drop-down menu,
or you can create a new template and apply it.
5. Click Save to apply the template to the monitoring session.

You can save the newly created template by using the Save as Template button.

Enable Precryption and Secure Tunnels

To enable Precryption, follow the steps given below:

1. In the Monitoring Session Options page, Click Precryption tab.
2. Enable the Precryption toggle button. Refer to Precryption™ topic for more details on

Precryption.
3. Enable the Secure Tunnel button if you wish to use Secure Tunnels. For more
information about Secure Tunnel, refer to Secure Tunnels.

Configure Monitoring Session 171
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Enable User Defined Applications

To enable user defined application, follow the steps given below:
1. In the Monitoring Session Options page, Click User-Defined Apps tab.
2. Enable the User-defined Applications toggle button.

Create Threshold

To create threshold, follow the steps given below:

1. In the Monitoring Session Options page, Click Threshold tab.

2. Refer toTraffic Health Monitoring topic for more detailed information on how to create
threshold template and apply the templates to the monitoring session.
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Interface Mapping

You can change the interface of individual GigaVUE V Series Nodes deployed in a

monitoring session. After deploying the monitoring session, if you wish to change the
interfaces mapped to an individual GigaVUE V Series Node, you can use the Interface
Mapping button to map the interface to the respective GigaVUE V Series Nodes. To perform
interface mapping:

1.

Go to Traffic > Virtual > Orchestrated Flows and select your cloud platform. The
Monitoring Sessions page appears.

Select a Monitoring session from the list view and click Actions > Edit. The Edit
Monitoring session page appears.

In the Edit Monitoring session canvas page, click on the Interface Mapping button.

The Select nodes to deploy the Monitoring Session dialog box appears. Select the
GigaVUE V Series Nodes for which you wish to map the interface.

After selecting the GigaVUE V Series Node, select the interfaces for each of the REPs
and the TEPs deployed in the monitoring session from the drop-down menu for the
selected individual GigaVUE V Series Nodes. Then, click Deploy.

Configure Monitoring Session
Interface Mapping
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Create Ingress and Egress Tunnels

Traffic from the GigaVUE V Series Node is distributed to tunnel endpoints in a monitoring
session. A tunnel endpoint can be created using a standard VXLAN, UDP, and TLS-

PCAPNG tunnel.

NoTe: GigaVUE-FM allows you to configure Ingress Tunnels in the Monitoring
Session, when the Traffic Acquisition Method is UCT-V.

To create a new tunnel endpoint:

1. After creating a new monitoring session, or click Actions > Edit on an existing
monitoring session, the GigaVUE-FM canvas appears.

2. In the canvas, select New > New Tunnel, drag and drop a new tunnel template to the

Configure Monitoring Session 174
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workspace. The Add Tunnel Spec quick view appears.
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3. On the New Tunnel quick view, enter or select the required information as described in
the following table.

Field Description

Alias The name of the tunnel endpoint.

NoTE: Do not enter spaces in the alias name.

Description The description of the tunnel endpoint.

Type VXLAN, UDP, and TLS-PCAPNG are the only supported tunnel types for Azure.

Traffic Direction

The direction of the traffic flowing through the GigaVUE V Series Node.

GigaVUE V Series Node.

In Choose In (Decapsulation) for creating an Ingress tunnel, traffic from the source to the

IP Version

The version of the Internet Protocol. Select IPv4 or IPv6.

Remote Tunnel IP

For Ingress tunnel, Remote Tunnel IP is the IP address of
the tunnel source.

VXLAN Network
Identifier

Unique value which is used to identify the VXLAN. The
value ranges from 1to 16777215.

Source L4 Port

Port from which the connection will be established to the
target. For Example, if A is the source and B is the
destination, this port value belongs to A.

Destination L4 Port

Port to which the connection will be established from the
source. For Example, if A is the source and B is the
destination, this port value belongs to B.

the destination endpoint.

Out Choose Out (Encapsulation) for creating an Egress tunnel from the V Series node to

Remote Tunnel IP

For Egress tunnel, Remote Tunnel IP is the IP address of
the tunnel destination endpoint.

MTU

The Maximum Transmission Unit (MTU) is the maximum
size of each packet that the tunnel endpoint can carry.
The default value is 1500 for Azure.

NoOTE: Increasing the MTU value will impact the
performance and may even result in packet loss. By
default, Azure VNet will attempt to fragment jumbo
frames even if sending and receiving VMs are
configured with a higher MTU.

Time to Live

Configure Monitoring Session
Create Ingress and Egress Tunnels

Enter the value of the time interval for which the session
needs to be available. The value ranges from 1to 255. The
default value is 64.
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Field Description

DSCP Differentiated Services Code Point (DSCP) are the values,
which network devices use to identify traffic to be
handled with higher or lower priority. The values ranges
from O to 63 with O being the highest priority and 63 as
the lowest priority.

Flow Label Unique value which is used to identify packets that
belong to the same flow. A flow is a sequence of packets
that need to be treated as a single entity that may
require special handling. Accepted value is between O
and 1048575

VXLAN Network Unigue value which is used to identify the VXLAN. The
Identifier value ranges from 1to 16777215.
Source L4 Port Port from which the connection will be established to the

target. For Example, if A is the source and B is the
destination, this port value belongs to A.

Destination L4 Port Port to which the connection will be established from the
source. For Example, if A is the source and B is the
destination, this port value belongs to B.

TLS-PCAPNG

Traffic Direction
The direction of the traffic flowing through the GigaVUE V Series Node.
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Field Description

In

IP Version

The version of the Internet Protocol. Select IPv4 or IPv6.

Remote Tunnel IP

For Ingress tunnel, Remote Tunnel IP is the IP address of
the tunnel source.

MTU

The Maximum Transmission Unit (MTU) is the maximum
size of each packet that the tunnel endpoint can carry.
The default value is 1500 for Azure.

NoOTE: Increasing the MTU value will impact the
performance and may even result in packet loss. By
default, Azure VNet will attempt to fragment jumbo
frames even if sending and receiving VMs are
configured with a higher MTU.

Source L4 Port

Port from which the connection will be established to the
target. For Example, if A is the source and B is the
destination, this port value belongs to A.

Destination L4 Port

Port to which the connection will be established from the
source. For Example, if A is the source and B is the
destination, this port value belongs to B.

Key Alias Select the Key Alias from the drop-down.
Cipher Only SHA 256 is supported.

TLS Version Only TLS Version1.3.

Selective Enable to receive the acknowledgments.

Acknowledgments

Sync Retries

Enter the value for number of times the sync has to be
tried. The value ranges from 1 to 6.

Delay
Acknowledgments

Enable to receive the acknowledgments when there is a
delay.

Out

Remote Tunnel IP

For Ingress tunnel, Remote Tunnel IP is the IP address of
the tunnel source.

Configure Physical
Tunnel

Configure the Physical Tunnel from your GigaVUE V
Series monitoring session for an Ingress Tunnel. Save
your changes before moving towards the Physical
Tunnels configuration page.

MTU

Configure Monitoring Session
Create Ingress and Egress Tunnels

The Maximum Transmission Unit (MTU) is the maximum
size of each packet that the tunnel endpoint can carry.
The default value is 1500 for Azure.

NoOTE: Increasing the MTU value will impact the
performance and may even result in packet loss. By
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Field Description

default, Azure VNet will attempt to fragment jumbo
frames even if sending and receiving VMs are
configured with a higher MTU.

Time to Live

Enter the value of the time interval for which the session
needs to be available. The value ranges from 1to 255. The
default value is 64.

DSCP

Differentiated Services Code Point (DSCP) are the values,
which network devices use to identify traffic to be
handled with higher or lower priority. The values ranges
from O to 63 with O being the highest priority and 63 as
the lowest priority.

Flow Label

Unique value which is used to identify packets that
belong to the same flow. A flow is a sequence of packets
that need to be treated as a single entity that may
require special handling. Accepted value is between O
and 1048575

Source L4 Port

Port from which the connection will be established to the
target. For Example, if A is the source and B is the
destination, this port value belongs to A.

Destination L4 Port

Port to which the connection will be established from the
source. For Example, if A is the source and B is the
destination, this port value belongs to B.

Cipher Only SHA 256 is supported.
TLS Version Only TLS Version1.3.
Selective Enable to receive the acknowledgments.

Acknowledgments

Sync Retries

Enter the value for number of times the sync has to be
tried. The value ranges from 1to 6.

Delay Enable to receive the acknowledgments when there is a
Acknowledgments delay.
UDP:
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Field Description

Out L4 Destination IP Enter the IP address of the tool port or when using
Address Application Metadata Exporter (AMX), enter the IP
address of the AMX application. Refer to Application
Metadata Exporter for more detailed information on
what AMX application is and how to configure it.

Source L4 Port Port from which the connection will be established to the
target. For Example, if A is the source and B is the
destination, this port value belongs to A.

Destination L4 Port Port to which the connection will be established from the
source. For Example, if A is the source and B is the
destination, this port value belongs to B.

4. Click Save.
To delete a tunnel, select the required tunnel and click Delete.

To apply threshold template to Tunnel End Points, select the required tunnel end point on
the canvas and click Details. The quick view appears, click on the Threshold tab. For more
details on how to create or apply threshold template, refer to Monitor Cloud Health.

Tunnel End Points configured can also be used to send or receive traffic from GigaVUE HC
Series and GigaVUE TA Series. Provide the IP address of the GigaVUE HC Series and GigaVUE
TA Series as the Source or the Destination IP address as required when configuring Tunnel
End Points.

After configuring the tunnels and deploying the monitoring session, you can view the
names of egress tunnels configured for a monitoring session, on the Monitoring Session
details page. The Egress Tunnel column displays the name of the egress tunnel configured
for a particular monitoring session. When multiple egress tunnels are configured for a
monitoring session, then the Egress Tunnel column displays the number of egress tunnels
configured in that monitoring session. Hover over the number of egress tunnels to display
the names of the egress tunnels used in that particular monitoring session.

Create Raw Endpoint

Raw End Point (REP) is used to pass traffic from an interface. REP is used to ingress data
from a physical interface attached to GigaVUE V Series Nodes. You can optionally use this
end point to send traffic to the applications deployed in the monitoring session.

To add Raw Endpoint to the monitoring session:
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1. Drag and drop New RAW from NEW to the graphical workspace.
2. Click the New RAW icon and select Details. The RAW quick view page appears.

3. Enter the alias and description. In the Alias field, enter a name for the Raw End Point
and click Save.

|l EditMonitoring Session X Raw Save

v NEW
< Alias raw-1

.E E Description Description (optional)
Newhap | NewTummel

v MAP LIBRARY Q

No maps available. RAW.

v APPLICATIONS Q

ccccc

Peapng

v TUNNELS Q

H @ =

8 m =

FM Instance: GigaVVUE-FM

4. To deploy the monitoring session after adding the Raw Endpoint click the Deploy
button on the edit monitoring session page.

5. The Select nodes to deploy the Monitoring Session dialog box appears. Select the V
Series Nodes for which you wish to deploy the monitoring session.

6. After selecting the V Series Node, select the interfaces for each of the REPs and the
TEPs deployed in the monitoring session from the drop-down menu for the selected
individual V Series Nodes. Then, click Deploy.
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Create a New Map

You must have the flow map license to deploy a map in the monitoring session.

For new users, the free trial bundle will expire after 30 days, and the GigaVUE-FM prompts
you to buy a new license. For licensing information, refer to GigaVUE Licensing Guide.

A map is used to filter the traffic flowing through the GigaVUE V Series Nodes. It is a
collection of one or more rules (R). The traffic passing through a map can match one or more
rules defined in the map.

Keep in mind the following when creating a map:

Parameter Description

Rules A rule (R) contains specific filtering criteria that the packets must
match. The filtering criteria lets you determine the targets and
the (egress or ingress) direction of tapping the network traffic.

Priority Priority determines the order in which the rules are executed.
The priority value can range from 1to 5, with 1 being the highest
and 5 is the lowest priority.

Pass The traffic from the virtual machine will be passed to the
destination.
Drop The traffic from the virtual machine is dropped when passing

through the map.

Traffic Filter Maps A set of maps that are used to match traffic and perform various
actions on the matched traffic.

Inclusion Map An inclusion map determines the instances to be included for
monitoring. This map is used only for target selection.
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Exclusion Map

An exclusion map determines the instances to be excluded from
monitoring. This map is used only for target selection.

Automatic Target Selection (ATS)

A built-in feature that automatically selects the cloud instances
based on the rules defined in the traffic filter maps, inclusion
maps, and exclusion maps in the monitoring session.

The below formula describes how ATS works:

Selected Targets = Traffic Filter Maps N Inclusion Maps -
Exclusion Maps

Below are the filter rule types that work in ATS:

« mac Source

« mac Destination

o ipV4 Source

« ipv4 Destination

« ipv6 Source

« ipv6 Destination

« VM Name Destination

« VM Name Source

« VM Tag Destination - Not applicable to Nutanix.

« VM Tag Source - Not applicable to Nutanix.

« VM Category Source - Applicable only to Nutanix

« VM Category Destination - Applicable only to Nutanix.

« Host Name -Applicable only to Nutanix and VMware.
The traffic direction is as follow:

« Forany rule type as Source - the traffic direction is egress.
« For Destination rule type - the traffic direction is ingress.

o« For Hostname - As it doesn't have Source or Destination rule
type, the traffic direction is Ingress and Egress.

NoTE: If no ATS rule filters listed above are used, all VMs and
VNICS are selected as targets. When any ATS rule results in a
null set, no target is selected and V Series Node does not
receive traffic from any VM or vNIC.

Group

A group is a collection of maps that are pre-defined and saved in
the map library for reuse.

To create a new map:

Configure Monitoring Session
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1. After creating a new monitoring session, or click Actions > Edit on an existing
monitoring session, the GigaVUE-FM canvas appears.

2. In the canvas, select New > New Map, drag and drop a new map template to sthe

workspace. The New Map quick view appears.

Monitoring Session X Map Save Add to Library

Rulesets Thresholds
v New Q

*
Q v
New Tunnel @

Description
. Descriptio

@ New Raw Endpoint

> Map Library
> Applications

> Tunnels <

3. On the New Map quick view, click on General tab and enter the required information
as described in the following table:

Field Description
Name

Name of the new map

Description Description of the map

Pass and Drop rule selection with Automatic Target Selection (ATS) differ with
the Map type as follows:

o Traffic Map—Only Pass rules for ATS
° |nclusion Map—Only Pass rules for ATS
o Exclusion Map—Only Drop rules for ATS
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4. Click on Rule Sets tab. Through the map, packets can be dropped or passed based on
the highest to lowest rule priority. You can add 5 rule sets on a map. Use the + and -
buttons to add or remove a rule set in the map. Each rule set can have only 25 rules per
map and each rule can have a maximum of 4 conditions. To add ATS rules for an
Inclusion/Exclusion map, you must select at least one rule condition. Refer to Example-
Create a New Map using Inclusion and Exclusion Maps for more detailed information
on how to configure Inclusion and Exclusion maps using ATS.

a. To create a new rule set:
i. Click Actions > New Rule Set.

ii. Enter a Priority value from 1to 5 for the rule with 1 being the highest and 5 is
the lowest priority.

iii. Enter the Application Endpoint in the Application EndPoint ID field.
iv. Select a required condition from the drop-down list.
V. Select the rule to Pass or Drop through the map.
b. To create a new rule:
i. Click Actions > New Rule.

ii. Select a required condition from the drop-down list. Click " and select Add
Condition to add more conditions.

iii. Select the rule to Pass or Drop through the map.
5. Click Save.

NoTE: If a packet is fragmented then all the fragments will be destined to the same
application end point. You can find the stats of mapped fragmented traffic in
GigaVUE-FM. Refer to "Map Statistics" section in GigaVUE Fabric Management Guide
for detailed information.

To edit a map, select the map and click Details, or click Delete to delete the map.

To apply threshold template to maps, select the required map on the canvas and click
Details. The quick view appears, click on the Threshold tab.

Rules and Notes:

e Directional rules do not work on single NIC VMs that are running a Windows UCT-V.

You can also perform the following action in the Monitoring session canvas.

e Click a map and select Details to edit the map
e Click a map and select Delete to delete the map.

» Click the Show Targets button to refresh the subnets and monitored instances details
that appear in the Instances dialog box.
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* Click ¥ to expand the Targets dialog box. To view details about a GigaVUE V Series
Node, click the arrow next to the VM.

In the Instances window, click A to filter the list of instances.
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Example- Create a New Map using Inclusion and Exclusion Maps

Consider a monitoring session with 5 cloud instances. Namely target-1-1, target-1-2, target-1-
3, target-2-1, target-2-2.
1. Drag and drop a new map template to the workspace. The New map quick view
appears.

2. In the General tab, enter the name as Map 1 and enter the description. In the Rule sets
tab, enter the priority and Application Endpoint ID.

3. Select the condition as VM Name and enter the target. This includes the instances
target-1-1, target-1-2, target-1-3, target-2-1, and target-2-2.

4. Click on the Expand icon at the bottom of the Monitoring session canvas. The Inclusion
Maps and Exclusion Maps section appears.

5. Drag and drop a new map template to the Inclusion Maps region. The New Map quick
view appears. Enter the Name and Description of the map.

a. In the General tab, enter the name as Inclusionmapl and enter the description. In
the Rule Sets, enter the priority and Application Endpoint ID.

b. Select the condition as VM Name and enter the VM Name as target-1. Then the
instance with VM name target-1-1, target-1-2, and target-1-3 will be included.

6. Drag and drop a new map template to the Exclusion Maps region. The New Map quick
view appears. Enter the details as mentioned in the above section.

a. In the General tab, enter the name as Exclusionmapl and enter the description. In
the Rule Sets tab, enter the priority and Application Endpoint ID.

b. Select the condition as VM Name and enter the VM Name as target-1-3. Then the
instance target-1-3 will be excluded.

Based on this configuration, the Automatic Target Selection will select the instances
target-1-1 and target-1-2 as target.
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Map Library

To reuse a map,

1.

5.

In the Monitoring Session page, Click Actions > Edit. The Edit Monitoring Session page
opens.

Click the map you wish to save as a template. Click Details. The Application quick view
appears.

Click Add to Library. Save the map using one of the following ways:

Select an existing group from the Select Group list or create a New Group with a
name.

Enter a description in the Description field, and click Save.

The Map is saved to the Map Library in the Edit Monitoring Session Canvas page. This map
can be used from any of the monitoring session. To reuse the map, drag and drop the saved
map from the Map Library.
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Add Applications to Monitoring Session

GigaVUE Cloud Suite with GigaVUE V Series Node supports the following GigaSMART
applications in the GigaVUE-FM canvas:

» Application Visualization

» Application Filtering Intelligence
* Application Metadata Intelligence
e Slicing

¢ Masking

¢ De-duplication

e |oad Balancing

» PCAPNg Application

» Header Stripping

» Application Metadata Exporter

e SSL Decrypt

For more detailed information on how to configure these application, refer to GigaVUE
V Series Applications Guide.
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Deploy Monitoring Session

To deploy the monitoring session:

1. Drag and drop the following items to the canvas as required:
e Ingress tunnel (as a source) from the NEW section
* Maps from the MAP LIBRARY section

* Inclusion and Exclusion maps from the Map Library to their respective section at the
bottom of the workspace.

* GigaSMART apps from the APPLICATIONS section
» Egress tunnels from the TUNNELS section

2. After placing the required items in the canvas, hover your mouse on the map, click the
red dot, and drag the arrow over to another item (map, application, or tunnel).

NOTE: You can drag multiple arrows from a single map and connect them to
different maps.

Monitoring Session Deploy oK
v NEW > MONITORING SESSION INFO
.E [ ]  TARGETS =
New Map New Tunnel v Conn .
v MAP LIBRARY Q

- Tunnel2
'E Tuggel1 E]
Map1 { < ﬁ/, .‘—) Conn
v APPLICATIONS Q

:

(m]
@ @ 10.10.30.0/24 to_10.110.50.0/24 to
10.110.40.0/24600:1f14:fa4:4bee::/64 -
Slicing Masking v ~
~ TUNNELS Q
< v >
R ] [ o4 = Expand
~ - 3+
Tunnell Tunnel2 -

3. (Not applicable for Tunnel traffic acquisition method) Click Show Targets to view
details about the subnets and monitored instances. The instances and the subnets
that are being monitored are highlighted in orange.
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4. Click Deploy to deploy the monitoring session. The status is displayed as Success in
the Monitoring Sessions page. The session is successfully deployed on all the V Series

nodes. Click on the status link in the Status column on the Monitoring Session page to
view the Monitoring Session Deployment Report. When you click on the Status link, the

Deployment Report is displayed. If the monitoring session is not deployed properly,

then one of the following errors is displayed in the Status column.

e Partial Success—The session is not deployed on one or more instances due to V
Series node failure.

¢ Failure—The session is not deployed on any of the V Series nodes.

The Monitoring Session Deployment Report displays the errors that appeared during

deployment.

The Monitoring Session page also has the following options under the Actions button:

Button Description

Undeploy Undeploys the selected monitoring session.

Clone Duplicates the selected monitoring session.

Edit Opens the Edit page for the selected

monitoring session.

NOTE: |In case of an error while editing a monitoring
session, undeploy and deploy the monitoring session
again..

Delete Deletes the selected monitoring session.

Configure Monitoring Session
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View Monitoring Session Statistics

The Monitoring Session Statistics page lets you analyze the incoming and outgoing traffic on

an hourly, daily, weekly, and monthly basis.

On the Monitoring Sessions page, click the name of the monitoring session, and then click
View. A split window appears displaying the Statistics, Connections, V Series Nodes,
Source Health and Http2 Logging of the monitoring session as shown:

Monitoring Sessions

New w Actions v Filter

CONNECTION STATUS
Failed
Connected
100%
T T
01187023 10262023
Usage @ Allowance e

NODE HEALTH DEPLOYMENT..  THRESHOLDS.. TRAFFICDISTR..  PREFILTERING PRECRYPT &
1 of 1 are Healtr Success No No No No
OofOareHealtt ) NotDeployec ~ No No No No

V Series Nodes Source Health Http2 Logging Actions v +

Day v | Outgoing +1 more v

NN\

Lt = Platform: Al ¥ Menitoring Domains: Al
OVERVIEW V-SERIES ALARMS By Severity
1/2 2
VSERIES NODES MONITORING SESSIONS e
100% Minor
1/3 1 o
CONNECTIONS v SERIES ALARMS info
MONITORINGS..  STATUS MONITORING .. PLATFORM CONNECTIONS TUNNELS
Ms-test Healthy md-new OpenStack Conn tun-out
tes_ms_1 Healthy md-new OpenStack Conn
.
Go to page: of 1 2 monitoring sessions total
X Ms-test: md-new Connections
Select Chart Options ) ALV Series Nodes v
CANVAS ELEMENT HEALTH e
164 &
B2 masking @) {5
@ urin
3
@ whon 20T 1008

2023-10°26 1808 20231026 2208

202

20231027 0208 20231027 0608 023-10-27 10:08
Time - GMT+0530 (Indiia Standard Time)

To know more about the statistics of the session, click Statistics.

You can view the statistics by applying different filters as per the requirements of analysing
the data. GigaVUE-FM allows you to perform the following actions on the Monitoring Session

Statistics page:

= You can view the Statistics in full screen. To view in full screen, click the Actions drop-
down list at the right corner of the window, and select Full Screen. Statistics appear in

full screen.

» You can view the incoming and outgoing traffic on an hourly, daily, weekly, and
monthly basis. You can select the options from the drop-down list box.

« You can filter the traffic and view the statistics based on factors such as Incoming,
Outgoing, Ratio (Out/In), Incoming Packets, Outgoing Packets, Ratio (Out/In)
Packets. You can select the options from the drop-down list box.

Configure Monitoring Session
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= You can also view the statistics of the monitoring session deployed in the individual V
Series Nodes. To view the statistics of the individual V Series Node, select the name of
the V Series Node from the drop-down list for which you want to view the statistics

from the V Series node drop-down menu on the top left corner of the Monitoring
Session Statistics page.

* You can view the statistics of the elements involved in the monitoring session. To view the

statistics, click on the Select Chart Options page and select the elements associated with
the session.

» Directly on the graph, you can click on Incoming(Mbps), Outgoing (Mbps), or Ratio
(Out/In) (Mbps) to view the statistics individually.
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View Health Status on the Monitoring Session
Page

You can view the health status of the monitoring session and the components deployed, in
the monitoring session page. Refer to Monitor Cloud Health for more detailed information
on how to configure cloud health and view health status.

To view the health status on the Monitoring Session page:

1. Go to Traffic > Virtual > Orchestrated Flows > Select your cloud platform.

2. The Monitoring Session page appears. The list view in the Monitoring Domain page
displays the details of the Monitoring Session.

The following columns in the monitoring session page are used to convey the health status:
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Status

This column displays the health status (both traffic and configuration) of the entire
monitoring session. The status is marked healthy only if both the traffic and configuration
health status is healthy, even if either of them is unhealthy, then the health status is moved

to unhealthy.

Configure Monitoring Session 195
View Health Status on the Monitoring Session Page



GigaVUE Cloud Suite for Azure - Deployment Guide

Node Health

This column displays the configuration and traffic health status of the monitoring session
deployed in V Series Nodes. This column provides information on the number of GigaVUE V
Series Nodes that have healthy traffic flow and monitoring session successfully deployed to
the total number of V Series Nodes that have monitoring session deployed.

NoTE: Node Health only displays the health status, so if the V Series Node is down it
will not be reflected in the monitoring session page.
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Targets Source Health

1. On the Monitoring Session page, click the name of the monitoring session and click
View.

2. Select the Connections tab.

This column displays the configuration health status of the monitoring session deployed in
targets. This column provides information on the number of monitoring sessions
successfully deployed on a particular target to the total number of monitoring session
deployed on that particular target.

You can view the health status of the individual targets and also the error message
associated with them, by clicking on the Target Source Health column.
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Visualize the Network Topology

You can have multiple connections in GigaVUE-FM. Each connection can have multiple
monitoring sessions configured within them. You can select the connection and the
monitoring session to view the selected subnets and instances in the topology view.

To view the topology diagram in GigaVUE-FM:

On the Monitoring Session page, select Topology tab. The Topology page appears.
Select a monitoring domain from the Select monitoring domain... list.
Select a connection from the Select monitoring session...list.

A WN

Select a monitoring session from the Select connection... list. The topology view of the
monitored subnets and instances in the selected session are displayed.

Filter Default View OK

X - ~ | Filter by: O Fabric (J Monitored

& Connection
& Subnet
Hinstance

0 5 @
a

m
o I

= =) -

}
;

5. (Optional) Hover over or click the subnet or VM Group icons to view the subnets or
instances present within the group.

In the topology page, you can also do the following:
e Use the Filter button to filter the instances based on the VM name, VM IP, Subnet ID, or
Subnet IP, and view the topology based on the search results.

» Use the Default View button to view the topology diagram based on the source
interfaces of the monitoring instances.

e Use the arrows at the right-bottom corner to move the topology page up, down, left, or
right. Click the Fit-to-Width icon to fit the topology diagram according to the width of
the page.

e Use + or - icons to zoom in and zoom out the topology view.
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Configure Precryption in UCT-V

GigaVUE-FM allows you to enable or disable the Precryption feature for a monitoring

session.

To enable or disable the Precryption feature in UCT-V, refer to Create monitoring session.
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Rules and Notes

» To avoid packet fragmentation, you should change the option Precryption-path-mtu in
UCT-V configuration file (/fetc/uctv/uctv.conf) within the range 1400-9000 based on the
platform path MTU.

e Protocol version IPv4 and IPv6 are supported.

» If you wish to use IPv6 tunnels, your GigaVUE-FM and the fabric components version
must be 6.6.00 or above.

To create a new monitoring session with Precryption, follow these steps:

1.

2.

® N o0 ok

In GigaVUE-FM, on the left navigation pane, select Traffic > Virtual > Orchestrated
Flows and select your cloud platform. The Monitoring Sessions page appears.

Click New to open the Create a New Monitoring Session page.

Enter the appropriate information for the monitoring session as described in the
following table:

Field Description

Alias The name of the monitoring session.

Monitoring The name of the monitoring domain that you want to select.

Domain

Connection The connection(s) that are to be included as part of the monitoring domain. You can

select the required connections that need to be part of the monitoring domain.

Traffic Enabling the "Traffic Distribute" option identifies duplicate packets across different
Distribute GigaVUE V Series Nodes when traffic from various targets is routed to these instances
for monitoring.

Click Next. The Edit Monitoring Session page appears with the new canvas.
Click Options button. The Monitoring Session Options appears.

Click Precryption tab.

Enable Precryption.

Click Save. The Edit Monitoring Session page appears. You can proceed to create
map, tunnels, and adding applications.

NOTE: It is recommended to enable the secure tunnel feature whenever the
Precryption feature is enabled. Secure tunnel helps to securely transfer the cloud
captured packets or precrypted data to GigaVUE V Series Node. For more
information, refer to Secure Tunnel .
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Validate Precryption connection

To validate the Precryption connection, follow the steps:

= To confirm it is active, navigate to the Monitoring Session dashboard and check the
Precryption option, which should show yes.

» Click Status, to view the rules configured.
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Migrate Application Intelligence
Session to Monitoring Session

Starting from Software version 6.5.00, Application Intelligence solution can be configured
from Monitoring Session Page. After upgrading to 6.5.00, you cannot create a new
Application Intelligence Session or edit an existing Application Intelligence Session for
virtual environment from the Application Intelligence page. The following operations can
only be performed using the existing Application Intelligence Session:

e View Details
e Delete
e Forced Delete

It is highly recommmended to migrate the existing sessions to Monitoring Session for full
functionality. GigaVUE-FM will migrate all your virtual Application Intelligence sessions and
their connections seamlessly. All sessions will be rolled back to their original states if the
migration fails.

E Points to Note:

* You must have fm_admin role in GigaVUE-FM to perform this migration. Refer to
Configure Role-Based Access and Set Permissions for more detailed information
how to create Users and assign Roles to the user.

» If any of the existing Application Intelligence Session is in PENDING or
SUSPENDED, then the migration will not be triggered. Resolve the issue and start
the migration process.

» |f any of the existing Application Intelligence Session is in FAILED state due to
incorrect configuration, then the migration will not be triggered. Resolve the issue
and start the migration process.

» If an existing Monitoring Session has a same name as the Application Intelligence
Session, then the migration will not be triggered. Change the existing Monitoring
Session name to continue with the migration process.

» If any of the existing Application Intelligence Session has Application Filtering
configured with Advanced Rules as Drop Rule and No Rule Match Pass All in the
5th rule set, you cannot continue with the migration. In the Monitoring Session
either only Pass All or Advanced Rules as Drop is supported in the fifth Rule Set.
Please delete this session and start the migration.
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E » When migrating the Application Intelligence Session, in rare scenarios, the
migration process might fail after the pre-validation. In such cases, all the
Application Intelligence Session roll back to the Application Intelligence page.
Contact Technical Support for migrating the Application Intelligence Session in
these scenarios.

To migrate your existing Application Intelligence Session to Monitoring Session Page, follow
the steps given below:

1. On the left navigation pane, select Traffic > Solutions >Application Intelligence. You
cannot create a new Application Intelligence Session from this page.

2. When you have an existing virtual Application Intelligence Session in the above page,
the Migrate Virtual Application Intelligence dialog box appears.

W

Review the message and click Migrate.

4. The Confirm Migration dialog box appears. The list Application Intelligence Session
that will be migrated appears here.

5. Review the message and click Migrate.

6. GigaVUE-FM checks for the requirements and then migrates the Application
Intelligence Sessions to the Monitoring Session Page.

7. Click on the Go to Monitoring Session Page button to view the Application
Intelligence Session that are migrated to the monitoring session page.

All the virtual Application Intelligence Sessions in the Application Intelligence page is
migrated to the Monitoring Session Page.
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Post Migration Notes for Application Intelligence

After migrating Application Intelligence session to Monitoring Session page, you must

consider the following things:

1. If you wish to enable Secure tunnels after migrating the Application Intelligence

Session, follow the steps given below.

a. Enable Secure Tunnels in the Options page. Refer to Monitoring Session Options
topic more detailed information on how to enable secure tunnel for a monitoring

Session.

b. Go to Traffic > Virtual > Orchestrated Flows and select your cloud platform. The

Monitoring Sessions page appears. Select the Monitoring Session for which you
enabled Secure Tunnels. Click Actions > Undeploy. The monitoring session is

undeployed.

c. Select the Monitoring Session for which you enabled Secure Tunnels. Click Actions

> Edit. The Edit Monitoring Session Canvas page appears.
d. Add the Application Intelligence applications.
Modify the Number of Flows as per the below table:

Cloud
Platform

Instance Size

Maximum
Number of
Flows

(Considers
Secure Tunnels
Configuration
also)

200k

VMware Large (8 vCPU and 16 GB RAM)

AWS Large (c5n.2xlarge) 300k
Medium (t3a.xlarge) 100k

Azure Large (Standard_D8s_V4) 500k
Medium (Standard_D4s_v4) 100k

Nutanix Large (8 vCPU and 16 GB RAM) 200k

50k.

NoTE: Medium Form Factor is supported for VMware ESXi only when secure tunnels option is
disabled. The maximum Number of Flows for VMware ESXi when using a medium Form Factor is

f. Click Deploy.
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2. When GigaVUE-FM version is 6.5.00, and the GigaVUE V Series Node version is below
6.5.00, after migrating theApplication Intelligence Session to the Monitoring Session
and redeploying the monitoring session, a momentary loss in the statistical data of the
Application Visualization application will be seen while redeploying the monitoring
session.

3. After migrating the Application Intelligence Session to monitoring session, if you wish
to make any configuration changes, then the GigaVUE V Series Node version must be
greater than or equal to 6.3.00.
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Monitor Cloud Health

GigaVUE-FM allows you to monitor the traffic and configuration health status of the
monitoring session and its individual components. This section provides detailed
information on how to view the traffic and configuration health status of the monitoring
session and its individual components. Refer to the following topics for more detailed
information on configuration health, traffic health and how to view the health status:

e Configuration Health Monitoring
e Traffic Health Monitoring
* View Health Status
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Configuration Health Monitoring

The configuration health status provides us detailed information about the configuration
and deployment status of the deployed monitoring session.

This feature is supported for the following fabric components and features on the respective
cloud platforms:

For V Series Nodes:

« AWS

e Azure

* OpenStack
¢ VMware

¢ Nutanix

For UCT-Vs:

o AWS
e Azure
¢ OpenStack

For VPC Mirroring:
¢ AWS

For OVS Mirroring and VLAN Trunk Port:

¢ OpenStack

To view the configuration health status, refer to the View Health Status section.
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Traffic Health Monitoring

GigaVUE-FM allows you to monitor the traffic health status of the entire monitoring session
and also the individual V Series Nodes for which the monitoring session is configured. Traffic
health monitoring focuses on identifying any discrepancies (packet drop or overflow etc) in
the traffic flow. When any such discrepancies are identified, GigaVUE-FM propagates the
health status to corresponding monitoring session. GigaVUE-FM monitors the traffic health
status in near real-time. GigaVUE V Series Node monitors the traffic, when the traffic limit
goes beyond the upper or lower threshold values that is configured, it notifies GigaVUE-FM,
based on which traffic health is computed.

NoTE: When GigaVUE-FM and GigaVUE V Series Nodes are deployed in different
cloud platforms, then the GigaVUE-FM public IP address must be added to the Data
Notification Interface as the Target Address in the Event Notifications page. Refer to
section in the GigaVUE Administration Guide for configuration details.

This feature is supported for GigaVUE V Series Nodes on the respective cloud platforms:

For V Series Nodes:

o AWS

e Azure

* OpenStack

¢ VMware

e Third Party Orchestration

The following section gives step-by-step instructions on creating, applying, and editing
threshold templates across a monitoring session or an application, and viewing the traffic
health status. Refer to the following section for more detailed information:

e Supported Resources and Metrics
¢ Create Threshold Template

Apply Threshold Template
e Edit Threshold Template
Clear Thresholds

Keep in mind the following points when configuring a threshold template:

» By default Threshold Template is not configured to any monitoring session. If you wish to
monitor the traffic health status, then create and apply threshold template to the
monitoring session.

e Editing or redeploying the monitoring session will reapply all the threshold policies
associated with that monitoring session.
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¢ Deleting or undeploying the monitoring session will clear all the threshold policies
associated with that monitoring session.
o After applying threshold template to a particular application, you need not deploy the

monitoring session again.
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Supported Resources and Metrics

The following table lists the resources and the respective metrics supported for traffic health

monitoring

Resource

Metrics

Threshold types

Trigger
Condition

Tunnel End Point

Tx Packets
Rx Packets
Tx Bytes

Rx Bytes

Tx Dropped
Rx Dropped
Tx Errors
Rx Errors

1. Difference

2. Derivative

1. Over
2. Under

RawEnd Point

Tx Packets
Rx Packets
Tx Bytes

Rx Bytes

Tx Dropped
Rx Dropped
Tx Errors

Rx Errors

1. Difference

2. Derivative

1. Over
2. Under

Map

WN =20 N0 0 h 6N 203006 o

Tx Packets
Rx Packets

Packets
Dropped

Difference

2. Derivative

1. Over
2. Under

Slicing

p—

Tx Packets
Rx Packets

Packets
Dropped

Difference
2. Derivative

1. Over
2. Under

Masking

1. Tx Packets

Rx Packets

Packets
Dropped

Difference

2. Derivative

1. Over
2. Under

Dedup

1. Tx Packets

Rx Packets

Packets
Dropped

Difference
2. Derivative

1. Over
2. Under
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HeaderStripping 1. Tx Packets Difference . Over
Rx Packets Derivative Under
Packets
Dropped

TunnelEncapsulation 1. Tx Packets Difference 1. Over
Rx Packets Derivative Under
Packets
Dropped

LoadBalancing 1. Tx Packets Difference . Over
Rx Packets Derivative Under
Packets
Dropped

SSLDecryption 1. Tx Packets Difference 1. Over
Rx Packets Derivative Under
Packets
Dropped

Application Metadata 1. Tx Packets Difference . Over
Rx Packets Derivative Under
Packets
Dropped

AMI Exporter 1. Tx Packets Difference 1. Over
Rx Packets Derivative Under
Packets
Dropped

Geneve 1. Tx Packets Difference . Over
Rx Packets Derivative Under
Packets
Dropped

5G-SBI 1. Tx Packets Difference 1. Over
Rx Packets Derivative Under
Packets
Dropped
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Create Threshold Template

To create threshold templates:

1. There are two ways to navigate to the Threshold Template page, they are:

a. Go to Traffic > Virtual > Orchestrated Flows and select your cloud platform. Then,
click on the Threshold Template tab in the top navigation bar.

b. Go to Traffic > Virtual > Orchestrated Flows and select your cloud platform. Select
a monitoring session, click Actions > Edit. In the Edit Monitoring Session page,
click Options > Threshold.

2. The Threshold Template page appears. Click Create to open the New Threshold
Template page.

3. Enter the appropriate information for the threshold template as described in the
following table.

Field Description

Threshold Template The name of the threshold template.

Name

Thresholds

Monitored Objects Select the resource for which you wish to apply the threshold template. Eg:
TEP, REP, Maps, Applications like Slicing, Dedup etc

Time Interval Frequency at which the traffic flow needs to be monitored.

Metric Metrics that needs to be monitored. For example: Tx Packets, Rx Packets.

Type Difference: The difference between the stats counter at the start and end

time of an interval, for a given metric.

Derivative: Average value of the statistics counter in a time interval, for a
given metric.

Condition Over: Checks if the statistics counter value is greater than the
'Set Trigger Value'.

Under: Checks if the statistics counter value is lower than the
'Set Trigger Value'.

Set Trigger Value Value at which a traffic health event is raised, if statistics counter goes below
or above this value, based on the condition configured.

Clear Trigger Value Value at which a traffic health event is cleared, if statistics counter goes
below or above this value, based on the condition configured.

4. Click Save. The newly created threshold template is saved, and it appears on the
Threshold Template page.
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Apply Threshold Template

You can apply your threshold template across the entire monitoring session and also to a
particular application.

Apply Threshold Template to Monitoring Session

To apply the threshold template across a monitoring session, follow the steps given below:
1. In GigaVUE-FM, on the left navigation pane, select Traffic > Virtual > Orchestrated
Flows and select your cloud platform. The Monitoring Session page appears.
2. Select the monitoring session and click Actions > Apply Thresholds.

3. The Apply Thresholds page appears. To apply a threshold template across a
monitoring session, select the template you wish to apply across the monitoring
session from the Threshold Template drop-down menu.

4. Click Done.
Apply Threshold Template to Applications

To apply the threshold template to a particular application in the monitoring session follow
the steps given below:

NoTE: Applying threshold template across monitoring session will not over write the
threshold value applied specifically for an application. When a threshold value is
applied to a particular application, it over writes the existing threshold value for that
particular application.

1. On the Monitoring Session page. Click Actions > Edit. The Edit Monitoring Session
page with canvas page appears.

2. Click on the application for which you wish to apply or change a threshold template
and click Details. The Application quick view opens.

3. Click on the Thresholds tab. Select the template you wish to apply from the Threshold
Template drop-down menu or enter the threshold values manually.

4. Click Save.

NoTE: Threshold Template is not supported for pcapng and sbipoe applications. The
Threshold configuration for these applications will not be applied.
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Edit Threshold Template

To edit a particular threshold template follow the steps given below:

1. On the Threshold Template page, Click Edit. The Edit Threshold Template page
appear.

2. The existing threshold templates will be listed here. Edit the templates you wish to
modify.
3. Click Save.

NoTE: Editing a threshold template does not automatically apply the template to
monitoring session. You must apply the edited template to monitoring session for
the changes to take effect.

Clear Thresholds

You can clear the thresholds across the entire monitoring session and also to a particular
application.

Clear Thresholds for Applications

To clear the thresholds of a particular application in the monitoring session follow the steps
given below:

1. On the Monitoring Session page. Click Actions > Edit. The Edit Monitoring Session
page with canvas page appears.

2. Click on the application for which you wish to clear the thresholds and click Details.
The Application quick view opens.

3. Click on the Thresholds tab. Click Clear All and then Click Save.

Clear Thresholds across the Monitoring Session

To clear the applied thresholds across a monitoring session follow the steps given below:
1. In GigaVUE-FM, on the left navigation pane, select Traffic > Virtual > Orchestrated
Flows and select your cloud platform. The Monitoring Sessions page appears.
2. Select the monitoring session and click Actions > Apply Thresholds.
3. The Apply Thresholds page appears. Click Clear.

NoTE: Clearing thresholds at monitoring session level does not clear the thresholds
that were applied specifically at the application level. To clear thresholds for a
particular application refer to Clear Thresholds for Applications
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View Health Status

You can view the health status of the monitoring session on the Monitoring Session details
page. The health status of the monitoring session is healthy only if both the configuration
health and traffic health are healthy.

View Health Status of an Application

To view the health status of an application across an entire monitoring session:

1. After creating a Monitoring Session, go to Traffic > Virtual > Orchestrated Flows and
select your cloud platform. Select a monitoring session, click Actions > Edit. The Edit
Monitoring Session Page appears.

2. Click on the application for which you wish to see the health status and select Details.
The quick view page appears.

3. Click on the HEALTH STATUS tab.

This displays the configuration health and traffic health of the application and also the
thresholds applied to that particular application.

NOTE: The secure tunnel status is refreshed for every 5 minutes, and the GigaVUE-FM
does not display UCT-V secure tunnel status that is older than 7 minutes. If the secure
tunnel in the UCT-V is removed, it takes up to 7 minutes to reset the status on the
GigaVUE-FM.

View Health Status for Individual GigaVUE V Series Nodes

You can also view the health status of the view the health status of an individual GigaVUE V
Series Node. To view the configuration health status and traffic health status of the V Series
Nodes:

1. On the Monitoring Session page, click the name of the monitoring session and click
View.

2. Select the Statistics tab.

3. Select the GigaVUE V Series Node from the All V Series Nodes drop-down menu.

View Application Health Status for Individual V Series Nodes

To view the application configuration and traffic health status of the GigaVUE V Series
Nodes:

1. On the Monitoring Session page, click the name of the monitoring session and click
View.

2. Select the Statistics tab.
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3. Select the GigaVUE V Series Node from the All V Series Nodes drop-down menu.

4. The list view displays the list of applications for the selected GigaVUE V Series Node
and the health status of each application.

You can also view the cloud health Status in the Monitoring Session Page, refer to View
Health Status on the Monitoring Session Page topic for more detailed information on how to
view cloud health status in the Monitoring Session page.
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Administer GigaVUE Cloud Suite
for Azure

You can perform the following administrative tasks:

¢ Set Up Email Notifications
e Configure Proxy Server

e Configure Azure Settings
¢ Role Based Access Control
» About Events

» About Audit Logs
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Set Up Email Notifications

Notifications are triggered by a range of events such as Azure license expiry, VM instance
terminated, and so on. You can setup the email notification for a particular event or a
number of events and the recipient or recipients to whom the email should be sent.

Gigamon strongly recommends you enable email notifications so there is immediate

visibility of the events affecting node health. The following are the events for which you can
setup the email notifications:

Azure License Expire

Fabric Node Down

Fabric Node Reboot Failed

Fabric Node Rebooted

Fabric Node Replacement Launch Failed
Fabric Node Replacement Launched
Fabric Node Restart Failed

Fabric Node Restarted

Fabric Node Unreachable

Fabric Node Up
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Configure Email Notifications

To configure the automatic email notifications:

1. On left navigation pane, select System > Event Notifications > Email Servers. The
Email Servers page appears.

2. Inthe Email Servers page, click Configure. The Configure Email Server wizard
appears. For field information, refer to"Email Servers" section in the GigaVUE
Administration Guide.

Configure Email Server Save | Cancel

Enable SMTP Authentication (]

Email Host 10.10.1.125
Username Username
Password Password
From Email no-reply@gigavue-fm
Port 25
3. Click Save.
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Configure Proxy Serve

r

Sometimes, the VNet in which the GigaVUE-FM is launched may not have access to the
Internet. Without Internet access, GigaVUE-FM cannot connect to the Azure APl endpoints.

For GigaVUE-FM to connect to Azure, a proxy server must be configured.

To create a proxy server:

1. Go to Inventory > VIRTUAL > Azure, and then click Settings > Proxy Server
Configuration. The Proxy Server Configuration page appears.

2. In the Proxy Server Configuration page, click Add. The Configure Proxy Server page

appears.

Configure Proxy Server

Alias Alias

Host IP Address

Port 0 - 65535

Username Username

Password Password
O NTLM

3. Select or enter the appropriate information as described in the following table.

Field Description

Alias The name of the proxy server.

Host The host name or the IP address of the proxy server.

Port The port number used by the proxy server for connecting to the Internet.

Username (Optional) The username of the proxy server.

Password The password of the proxy server.

NTLM (Optional) The type of the proxy server used to connect to the VNet.

Domain The domain name of the client accessing the proxy server.

Workstation (Optional) The name of the workstation or the computer accessing the
proxy server.

4. Click Save. The new proxy server configuration is added to the Proxy Server

Cancel

Configuration page. The proxy server is also listed in the Azure Connection page in

GigaVUE-FM.
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NoTE: If you change any of the fields in the Proxy Server Configuration page after the
initial connection is established between the GigaVUE-FM and Azure, then you must
also edit the connection and select the proxy server again and save (in the Azure
Connection Page). Otherwise, GigaVUE-FM will not use the new configuration that
was saved and may be disconnected from the Azure platform.
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Configure Azure Settings

This section provides information on how to configure the maximum number of
connections, refresh intervals for instance and non-instance inventory, and maximum batch
size for monitoring session updates.

Go to Inventory > VIRTUAL > Azure, and then click Settings > Advanced Settings to edit
the Azure settings.

Refer to the following table for more information about the settings:

Settings Description

Refresh interval for VM Specifies the frequency for updating the state of Virtual Machines target

target selection inventory | selection in Azure.

(secs)

Refresh interval for fabric | Specifies the frequency for updating the state of fabric deployment information
deployment inventory such as subnets, security groups, images, and VNets.

(secs)

Number of UCT-Vs per Specifies the maximum number of instances that can be assigned to the
GigaVUE V Series Node GigaVUE V Series node.

Refresh interval for UCT-V | Specifies the frequency for discovering the UCT-Vs available in the VNet.
inventory (secs)

Traffic distribution tunnel | Specifies the start range value of the tunnel ID.
range start

Traffic distribution tunnel | Specifies the closing range value of the tunnel ID.

range end
Reboot threshold limit for | Specifies the number of times GigaVUE-FM tries to reach UCT-V Controller,
UCT-V Controller down when the UCT-V Controller moves to down state. GigaVUE-FM retries every 60
seconds.
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Role Based Access Control

The Role Based Access Control (RBAC) feature controls the access privileges of users and
restricts users from either modifying or viewing unauthorized data. Access privileges in
GigaVUE Cloud Suite works on the same principles of access privileges in GigaVUE-FM in

which the access rights of a user depends on the following:

» User role: A user role defines permission for users to perform any task or operation

» User group: A user group consists of a set of roles and set of tags associated with that
group. When a user is created they can be associated with one or more groups.

To access the resources and to perform a specific operation in GigaVUE Cloud Suite you
must be a user with fm_super_admin role or a user with write access to the following

resource category depending on the task you need to perform.

Resource Category Cloud Configuration Task

Physical Device Infrastructure
Management: This includes the
following cloud infrastructure
resources:

e Cloud Connections

o Cloud Proxy Server

e Cloud Fabric Deployment

e Cloud Configurations

e Sys Dump

e Syslog

e Cloud licenses

e Cloud Inventory

e Configure GigaVUE Cloud Components
« Create Monitoring Domain and Launch Visibility Fabric

« Configure Proxy Server

Traffic Control Management: This
includes the following traffic
control resources:

e Monitoring session

e Threshold Template

« Stats

« Map library

e Tunnel library

e Tools library

o Inclusion/exclusion Maps

« Create, Clone, and Deploy Monitoring Session
e Create and Apply Threshold Template

« Add Applications to Monitoring Session

o Create Maps

« View Statistics

e« Create Tunnel End Points

NoTE: Cloud APIs are also RBAC enabled.
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Refer to the GigaVUE Administration Guide for detailed information about Roles, Tags, User
Groups.
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About Events

The Events page displays all the events occurring in the virtual fabric component, VM
Domain, and VM manager. An event is an incident that occur at a specific point in time.
Examples of events include:

e Cloud provider License Expiry
¢ UCT-V Inventory Update Completed
¢ Cloud provider Connection Status Changed

An Alarm is a response to one or more related events. If an event is considered of high
severity, then GigaVUE-FM raises an alarm. An example of alarm could be your cloud
provider license expiry.

The alarms and events broadly fall into the following categories: Critical, Major, Minor, or info.

Navigate to Dashboard > SYSTEM > Events. The Event page appears.

@ Events Manage Events Q g 1;3 ®
[t Filter Export v
%) Source Time Event Type Severity Affected Entity T... Affected Entity Alias Device IP Host Name Scope Description Tags @

™M 2022-08-100..  Licenses Expir..  Info Floating License M 4 Floating
= M 2022-08-090..  Licenses Expir..  Info Floating License FM 4 Floating

M 2022-08-080..  Licenses Expir..  Info Floating License FM 4 Floating

M 2022-08-070..  Licenses Expir..  Info Floating License FM 4 Floating

M 2022-08-060..  Licenses Expir..  Info Floating License FM 4 Floating

™M 2022-08-051..  FM Applicatio.. Info fm application ... fmhal fmService CMS service ...

™M 2022-08-041..  FM Applicatio.. Info fm application ... fmhal fmService CMS service f...

M 2022-08-041..  AlamDelete..  Critical VSeries Node ve-obe-pod2.u.. Alarm Node Down. P.

The following table describes the parameters recording for each alarm or event. You can also
use filters to narrow down the results.
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Controls/ Description

Parameters

Source The source from where the events are generated. The criteria can be as follows:
= FM - indicates the event was flagged by the GigaVUE-FM fabric manager.

= |P address - is the address of the GigaVUE HC Series node that detected the
event. For a node to be able to send notifications to the GigaVUE-FM fabric
manager, the SNMP_TRAP must be configured with the GigaVUE-FM fabric
manager’s |IP address specified as a host. Refer to the GigaVUE
Administration Guide for instructions on adding a destination for SNMP traps.

= VMM - indicates the event was flagged by the Virtual Machine Manager.

= FM Health - indicates the event was flagged due to the health status change
of GigaVUE-FM.

Time The timestamp when the event occurred.

IMPORTANT:Timestamps are shown in the time zone of the client browser's
computer and not the time zone of the node reporting the event. The timestamp is
based on the correctly configured clock on the GigaVUE-FM server and converted
fromn UTC to the client computer's configured time zone.

Event Type The type of event that generated the events. The type of events can be CPU
utilization high, cluster updated, device discovery failed, fan tray changed, netflow
statistics, and so on.

Severity The severity is one of Critical, Major, Minor, or Info.

Info is informational messages. For example, when power status change
notification is displayed, then the message is displayed as Info.

Affected Entity Type The resource type associated with the event. For example, when low disk space
notification is generated, 'Chassis' is displayed as the affected entity type.

Affected Entity The resource ID of the affected entity type. For example, when low disk space
notification is generated, the IP address of the node with the low disk space is
displayed as the affected entity.

Alias Event Alias

Device IP The IP address of the device.

Host Name The host name of the device.

Scope The category to which the events belong. Events can belong to the following

category: Domain, Node, Card, Port, Stack, Cluster, Chassis, GigaVUE-FM, GigaVUE-
VM, and so on. For example, if there is a notification generated for port utilization
low threshold, the scope is displayed as Physical Node.

To filter the alarms and event:

1. Click Filter. The Filter quick view is displayed.

2. Select the filtering criteria, then click Apply Filter. The results are displayed in the
Events page.
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About Audit Logs

Audit logs track the changes and activities that occur in the virtual nodes due to user
actions. The logs can be filtered to view specific information.

Navigate to Dashboard > SYSTEM > Audit Logs. The All Audit Logs page appears.

All Audit Logs

Filter : none

Time User

admin
admin

admin

qqqqq

Go to page: 1 v of 16 > Total Records: 106

s~~~

The Audit Logs have the following parameters:

Parameters Description

Time

Provides the timestamp on the log entries.

User

Provides the logged user information.

Operation Type

Provides specific entries that are logged by the system such as:
« Login and Log out based on users.

= Create/Delete/Edit tasks, GS operations, maps, virtual ports, and

so on.

Source Provides details on whether the user was in GigaVUE-FM or on the
node when the event occurred.

Status Success or Failure of the event.

Description

In the case of a failure, provides a brief update on the reason for the
failure.

Filter Manage
Operation Type Entity Type Source Device IP Hostname Status Description Tags @
User SUCCESS -
User SUCCESS
User SUCCESS

NoTE: Ensure that the GigaVUE-FM time is set correctly to ensure accuracy of the
trending data that is captured.

Filtering the audit logs allows you to display specific type of logs. You can filter based on any

of the following:
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* When: display logs that occurred within a specified time range.

» Who: display logs related a specific user or users.

» What: display logs for one or more operations, such as Create, Read, Update, and so on.
« Where: display logs for GigaVUE-FM or devices.

» Result: display logs for success or failure.

To filter the audit logs, do the following:

1. Click Filter. The quick view for Audit Log Filters displays.
2. Specify any or all of the following:
« Start Date and End Date to display logs within a specific time range.

» Who limits the scope of what displays on the Audit Logs page to a specific user or
users.

« What narrows the logs to the types of operation that the log is related to. You can
select multiple operations. Select All Operations to apply all operation types as part
of the filter criteria.

« Where narrows the logs to particular of system that the log is related to, either
GigaVUE-FM or device. Select All Systems apply both GigaVUE-FM and device to
the filter criteria.

» Result narrows the logs related to failures or successes. Select All Results to apply
both success and failure to the filter criteria.

3. Click OK to apply the selected filters to the Audit Logs page.
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GigaVUE-FM Version
Compatibility Matrix

The following tables list the different versions of GigaVUE Cloud Suite Cloud solution
components available with different versions of GigaVUE-FM.

NoTE: GigaVUE-FM version 6.6 supports the latest fabric components version as well
as (n-2) versions. It is always recommended to use the latest version of fabric
components with GigaVUE-FM, for better compatibility.

GigaVUE-FM Version Compatibility

E The following fabric components are renamed as follows:

e G-VTAP Agents - UCT-V
¢ Next Generation G-vTAP Agents - Next Generation UCT-V
e G-VvTAP Controller - UCT-V Controller

GigaVUE-FM UCT-V Version UCT-V GigaVUE GigaVUE
Controller V Series Proxy V Series
Version Nodes
6.6.00 v6.6.00 v6.6.00 v6.6.00 v6.6.00
6.5.00 v6.5.00 v6.5.00 v6.5.00 v6.5.00
6.4.00 v6.4.00 v6.4.00 v6.4.00 v6.4.00

GigaVUE-FM G-vTAP G-vTAP Controller GigaVUE GigaVUE
Agent Version V Series V Series
Version Proxy Nodes
6.3.00 v6.3.00 v6.3.00 v6.3.00 v6.3.00
6.2.00 v6.2.00 v6.2.00 v6.2.00 v6.2.00
6.1.00 v6.1.00 v6.1.00 v6.1.00 v6.1.00
6.0.00 V1.8-7 v1.8-7 v2.7.0 v2.7.0
5.16.00 v1.8-5 v1.8-5 v2.6.0 v2.6.0
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GigaVUE-FM G-vTAP G-vTAP Controller GigaVUE GigaVUE
Agent Version V Series V Series
Version Proxy Nodes
515.00 v1.8-5 v1.8-5 v2.5.0 v2.5.0
514.00 V1.8-4 V1.8-4 v2.4.0 Vv2.4.0
513.01 v1.8-3 v1.8-3 Vv2.3.3 Vv2.3.3
513.00 V1.8-2 V1.8-2 v2.3.0 v2.3.0
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Additional Sources of Information

This appendix provides additional sources of information. Refer to the following sections for
details:

« Documentation

= Documentation Feedback

« Contact Technical Support

« Contact Sales

« The VUE Community

Documentation

This table lists all the guides provided for GigaVUE Cloud Suite software and hardware. The
first row provides an All-Documents Zip file that contains all the guides in the set for the
release.

NoTE: In the online documentation, view What's New to access quick links to topics
for each of the new features in this Release; view Documentation Downloads to
download all PDFs.

Table 1: Documentation Set for Gigamon Products

GigaVUE Cloud Suite 6.6 Hardware and Software Guides

DID YOu KNOoW? [f you keep all PDFs for a release in common folder, you can easily search across the doc set
by opening one of the files in Acrobat and choosing Edit > Advanced Search from the menu. This opens an
interface that allows you to select a directory and search across all PDFs in a folder.

Hardware

how to unpack, assemble, rack-mount, connect, and initially configure ports the respective GigaVUE Cloud
Suite devices; reference information and specifications for the respective GigaVUE Cloud Suite devices

GigaVUE-HC1 Hardware Installation Guide

GigaVUE-HC3 Hardware Installation Guide

GigaVUE-HCI1-Plus Hardware Installation Guide

GigaVUE-HCT Hardware Installation Guide

GigaVUE-TA25 Hardware Installation Guide

GigaVUE-TA25E Hardware Installation Guide

GigaVUE-TA100 Hardware Installation Guide
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GigaVUE Cloud Suite 6.6 Hardware and Software Guides

GigaVUE-TA200 Hardware Installation Guide

GigaVUE-TA200E Hardware Installation Guide

GigaVUE-TA400 Hardware Installation Guide

GigaVUE-OS Installation Guide for DELL S4112F-ON

G-TAP A Series 2 Installation Guide

GigaVUE M Series Hardware Installation Guide

GigaVUE-FM Hardware Appliances Guide

Software Installation and Upgrade Guides

GigaVUE-FM Installation, Migration, and Upgrade Guide

GigaVUE-OS Upgrade Guide

GigaVUE V Series Migration Guide

Fabric Management and Administration Guides

GigaVUE Administration Guide
covers both GigaVUE-OS and GigaVUE-FM

GigaVUE Fabric Management Guide

how to install, deploy, and operate GigaVUE-FM; how to configure GigaSMART operations; covers both
GigaVUE-FM and GigaVUE-OS features

Cloud Guides

how to configure the GigaVUE Cloud Suite components and set up traffic monitoring sessions for the cloud
platforms

GigaVUE V Series Applications Guide

GigaVUE V Series Quick Start Guide

GigaVUE Cloud Suite Deployment Guide - AWS

GigaVUE Cloud Suite Deployment Guide - Azure

GigaVUE Cloud Suite Deployment Guide - OpenStack

GigaVUE Cloud Suite Deployment Guide - Nutanix

GigaVUE Cloud Suite Deployment Guide - VMware (ESXi)

GigaVUE Cloud Suite Deployment Guide - VMware (NSX-T)

GigaVUE Cloud Suite Deployment Guide - Third Party Orchestration

Universal Cloud Tap - Container Deployment Guide
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GigaVUE Cloud Suite 6.6 Hardware and Software Guides

Gigamon Containerized Broker Deployment Guide

GigaVUE Cloud Suite for Nutanix Guide—GigaVUE-VM Guide

GigaVUE Cloud Suite Deployment Guide - AWS Secret Regions

GigaVUE Cloud Suite Deployment Guide - Azure Secret Regions

Reference Guides

GigaVUE-OS CLI Reference Guide
library of GigaVUE-OS CLI (Command Line Interface) commmands used to configure and operate GigaVUE

HC Series and GigaVUE TA Series devices

GigaVUE-OS Security Hardening Guide

GigaVUE Firewall and Security Guide

GigaVUE Licensing Guide

GigaVUE-OS Cabling Quick Reference Guide
guidelines for the different types of cables used to connect Gigamon devices

GigaVUE-OS Compatibility and Interoperability Matrix
compatibility information and interoperability requirements for Gigamon devices

GigaVUE-FM REST API Reference in GigaVUE-FM User's Guide
samples uses of the GigaVUE-FM Application Program Interfaces (APIs)

Release Notes

GigaVUE-OS, GigaVUE-FM, GigaVUE-VM, G-TAP A Series, and GigaVUE Cloud Suite Release Notes
new features, resolved issues, and known issues in this release ;
important notes regarding installing and upgrading to this release

NoTE: Release Notes are not included in the online documentation.

NoTE: Registered Customers can log in to My Gigamon to download the Software and Release Notes
from the Software and Docs page on to My Gigamon. Refer to How to Download Software and Release

Notes from My Gigamon.

In-Product Help

GigaVUE-FM Online Help
how to install, deploy, and operate GigaVUE-FM.
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How to Download Software and Release Notes from My Gigamon

Registered Customers can download software and corresponding Release Notes documents
from the Software & Release Notes page on to My Gigamon. Use the My Gigamon Software
& Docs page to download:

¢ Gigamon Software installation and upgrade images,
» Release Notes for Gigamon Software, or
» Older versions of PDFs (pre-v5.7).

To download release-specific software, release notes, or older PDFs:

1. Log in to My Gigamon.
2. Click on the Software & Release Notes link.

3. Use the Product and Release filters to find documentation for the current release. For
example, select Product: "GigaVUE-FM" and Release: "6.6," enter "pdf" in the search box,
and then click GO to view all PDF documentation for GigaVUE-FM 6.6.xx.

NoTE: My Gigamon is available to registered customers only. Newer documentation
PDFs, with the exception of release notes, are all available through the publicly
available online documentation.

Documentation Feedback

We are continuously improving our documentation to make it more accessible while
mMaintaining accuracy and ease of use. Your feedback helps us to improve. To provide
feedback and report issues in our documentation, send an email to:
documentationfeedback@gigamon.com

Please provide the following information in the email to help us identify and resolve the
issue. Copy and paste this form into your email, complete it as able, and send. We will
respond as soon as possible.

Documentation Feedback Form

Your Name

About You Your Role

Your Company
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Online doc link

(URL for where the issue is)

For Online Topics

Topic Heading

(if it's a long topic, please provide the heading of the
section where the issue is)

Document Title

(shown on the cover page or in page header )

Product Version

(shown on the cover page)

For PDF Topics Document Version

(shown on the cover page)

Chapter Heading

(shown in footer)

PDF page #

(shown in footer)

Describe the issue

Describe the error or issue in the documentation.

(If it helps, attach an image to show the issue.)

How can we improve

the content?
How can we

improve? Be as specific as

possible.

Any other
comments?

Contact Technical Support

For information about Technical Support: Go to Settings > Support > Contact Support

in GigaVUE-FM.

You can also refer to https://www.gigamon.com/support-and-services/contact-support for
Technical Support hours and contact information.

Email Technical Support at support@gigamon.com.
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Contact Sales

Use the following information to contact Gigamon channel partner or Gigamon sales
representatives:

Telephone: +1.408.831.4025
Sales: inside.sales@gigamon.com

Partners: www.gigamon.com/partners.html

Premium Support

Email Gigamon at inside.sales@gigamon.com for information on purchasing 24x7 Premium
Support. Premium Support entitles you to round-the-clock phone support with a dedicated
Support Engineer every day of the week.

The VUE Community

The VUE Community is a technical site where Gigamon users, partners, security and
network professionals and Gigamon employees come together to share knowledge and
expertise, ask questions, build their network and learn about best practices for Gigamon
products.

Visit the VUE Community site to:

» Find knowledge base articles and documentation
« Ask and answer guestions and learn best practices from other members.

» Join special-interest groups to have focused collaboration around a technology, use-
case, vertical market or beta release

» Take online learning lessons and tutorials to broaden your knowledge of Gigamon
products.

« Open support tickets (Customers only)
«» Download the latest product updates and documentation (Customers only)

The VUE Community is a great way to get answers fast, learn from experts and collaborate
directly with other members around your areas of interest.

Register today at community.gigamon.com

Questions? Contact our Community team at community@gigamon.com.
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Glossary

D
decrypt list
need to decrypt (formerly blacklist)
decryptlist
need to decrypt - CLI Command (formerly blacklist)
drop list
selective forwarding - drop (formerly blacklist)
F

forward list

selective forwarding - forward (formerly whitelist)

L
leader

leader in clustering node relationship (formerly master)
M

member node

follower in clustering node relationship (formerly slave or non-master)

N

no-decrypt list

no need to decrypt (formerly whitelist)
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nodecryptlist

no need to decrypt- CLI Command (formerly whitelist)

P

primary source

root timing; transmits sync info to clocks in its network segment (formerly grandmaster)

R

receiver

follower in a bidirectional clock relationship (formerly slave)

S

source

leader in a bidirectional clock relationship (formerly master)
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